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About this Manual
Welcome to the Acer s10 handheld Manual. This Manual is designed to help you get 
up and running quickly on your new Acer s10. It describes all you need to know about 
how to use your Acer s10 as well as the applications and PC-end utilities that come 
with it. 

This Manual shows you how to:

• Identify all the parts of your Acer s10
• View and enter data 
• Use your Acer s10 with your computer
• Use the applications and PC-end utilities that came with your Acer s10
• Personalize your Acer s10 with your own preference settings

After you become familiar with the basic functionality of your Acer s10, you can use 
the rest of this Manual as a reference for less common tasks, for maintaining your 
handheld and also as a source of information if you have problems operating it.
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First things first
We would like to thank you for making Acer s10 your choice for your handheld needs. 
Your new sleek Acer s10 is packed with user-friendly applications and utilities 
designed to make organizing work-related information and synchronizing it with 
your personal activities a time-efficient task. We hope you enjoy using your Acer s10 
as much as we enjoyed creating it for you. 

Your guides
To help you use your Acer s10, we have designed a set of guides:

• First off, the Just for Starters poster helps you get started with setting up 
your Acer s10.

• This online Acer s10 handheld Manual introduces you to the many ways 
your Acer s10 can help you organize and manage both business and personal 
information so as to make your everyday activities a more productive and 
satisfying experience. This Manual provides clear and comprehensive 
information about your Acer s10, so read it thoroughly.

• The handy Acer s10 handheld Quick guide useful for taking a quick 
reference glance on your handheld’s basic functionalities. Keep it in your 
desktop or in your backpack for easy access.

• A Graffiti® pocket reference card to remind you of the standard writing 
strokes of this powerful writing software.

For more information about our products, services, and support information, please 
visit our web site at http://www.acer.com/.

Package contents
Your Acer s10 comes packed in a carton box. Carefully unpack the box and remove the 
contents.  If any of the following items are missing or damaged, contact your dealer 
immediately:

• Acer s10 handheld • Just for Starters 

• Cover • Acer s10 handheld Quick guide

• Stylus • Graffiti pocket reference

• Cradle • Warranty Agreement

• AC adapter • Accessories Catalogue

• Earphone • Plug adapter (optional)

• Acer s10 handheld Installation CD

http://www.acer.com
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Maintaining your Acer s10
This section provides information on the following:

• Proper care and usage of your Acer s10
• Resetting your Acer s10

Proper care and usage of your Acer s10
Your Acer s10 handheld’s rugged and tough construction is designed to provide you 
with years of reliable and trouble-free service. Observing the following general 
maintenance procedures will help ensure this:

1 Take care not to scratch the screen of your Acer s10. Keep the screen clean. When 
working with your Acer s10, use the supplied stylus or plastic-tipped pens intended for 
use with touch-sensitive screens. Never use an actual pen or pencil or other sharp 
object on the screen surface. 

2 Your Acer s10 is not waterproof and should not be exposed to rain or moisture. Under 
extreme conditions, water may enter the circuitry through the front panel buttons. In 
general, treat your Acer s10 as you would a pocket calculator or other small electronic 
device.

3 Take care not to drop your Acer s10 or subject it to any strong impact. Do not place 
your Acer s10 in your back pocket; if you sit on it, you may damage it. 

4 Protect your Acer s10 from temperature extremes. For example, do not leave your 
Acer s10 on the dashboard of a car on a hot day or on a day when temperatures are 
below the freezing point. Also, keep it away from heaters and other sources of heat. 

5 Do not use or store your Acer s10 in any location that is extremely dusty, damp or wet. 

6 Use a soft, damp cloth to clean your Acer s10. If the surface of the screen becomes 
soiled, clean it with a soft cloth moistened with diluted window-cleaning solution.

Resetting your Acer s10
You may have to perform a reset if your Acer s10 no longer responds to the buttons 
on the screen.

Performing a soft reset
A soft reset allows your Acer s10 to get a fresh start, similar to rebooting a computer. 
All records and entries are retained after a soft reset.

To perform a soft reset, use the reset tip tool that is threaded into the head of your 
stylus, or use an unfolded paper clip (or similar object without a sharp tip). 
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To perform a soft reset: 
1 Turn the head of your stylus counterclockwise to reveal the reset tip tool threaded 

into it.

2 Using the reset tip tool, lightly press the reset button inside the hole on the rear panel 
of your Acer s10.

Performing a hard reset
A hard reset will erase all records and entries stored in your Acer s10. Never perform a 
hard reset unless a soft reset does not correct your problem. When you perform your 
next HotSync operation, you can restore any data that you previously synchronized to 
your computer. To perform a hard reset, do the following:

1 Hold down the power button on the front panel of your Acer s10.

2 While holding down the power button, use the reset tip tool to gently press and 
release the reset button.

3 When the Palm logo appears, release the power button.

4 A message will appear on the Acer s10 screen warning that all data stored on it is 
about to be erased, do one of the following:
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• Complete the hard reset by pressing the upper half of the scroll button on 
the front panel of your Acer s10. The Digitizer screen will appear.

• Press any other button to perform a soft reset.

NOTE: When you perform a hard reset, the current date and time are retained. Formats, 
preferences, and other settings are restored to their factory default settings.

Battery considerations
Please note the following considerations for the battery in your Acer s10.

• Under normal conditions, your Acer s10 battery should remain charged by 
placing it in the cradle for just a few minutes each day. You can conserve 
battery life by minimizing the use of the backlight feature and changing the 
the Auto-off setting that automatically turns off the handheld after a period 
of inactivity. For more information on the Auto-off setting, refer to "Setting 
the Auto-off interval time" on page 278.

• If the battery becomes low in the course of normal use, an alert appears on 
the Acer s10 screen indicating low battery status. If this alert appears, 
perform a HotSync operation to back up your data; then leave your handheld 
in the cradle to recharge the unit. This will prevent accidental data loss. 

• If the battery drains to the point where your Acer s10 does not operate , it 
stores your data safely for about a week. In this case, there is enough residual 
energy in the battery to store the data, but not enough to turn on your 
handheld. If your Acer s10 does not turn on when you press the power 
button, you should recharge your unit immediately. 

• If your battery drains and you have the unit in an uncharged state for an 
extended period of time, you can lose all the data stored in it. 

• There are no serviceable parts inside your Acer s10 so do not attempt to open 
the unit. 

• If you ever dispose of your Acer s10, please dispose it without damaging the 
environment. Take your handheld to the nearest environmental recycling 
center.

Assigning security options
Your Acer s10 includes a security application that lets you set options to protect 
entries from unauthorized users in a variety of ways:

The security application lets you: 

• Mask or hide entries you have defined as private. 
– The Mask option displays a gray bar over private records.
– The Hide option completely hides private records. 

• Assign a password to viewing options to enhance security. 
– Assigning a password requires you to enter a password before private 

entries can be viewed. 
– Not assigning a password lets you view private entries when you Show 

Records from the Security dialog box. 



First  things f irst
Assigning security options

 ix

• Lock and turn off your Acer s10 so that a password must be entered before 
you can use the device again. 

• Hide records that you have defined as private, with or without a password. 
– Without a password, private records are hidden until you set the Security 

application to display them. 
– With a password, you must enter the password to view the private 

entries.
For more information on how to set these security features, refer to "Security" on 
page 41. 
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1 Getting started 
With your Acer s10, you’ll be able to successfully manage meetings and appointments, 
remember people’s names and personal details, and keep track of all the items on 
your To Do List, both at work and at home. You could also use it as a handy audio 
recorder, a three-in-one clock and an .mp3 player (talk about versatility!).

This chapter discusses your Acer s10’s basic functions, the physical and soft buttons, 
how to use HotSync® technology to synchronize (exchange and update) your 
handheld and PalmTM Desktop software. Once you familiarize yourself with these 
topics, you’ll easily be able to do the following:

• Enter all your schedule details in the Date Book and view them by the day, 
week, or month, and even set an alarm to remind you of an important event

• Keep all your contact names, addresses, phone numbers, and other details in 
the Address Book, so you can find them as soon as you need them

• Add your tasks to the To Do List, prioritize them so you don’t overlook them, 
and assign them a due date

• Ensure that you don’t lose any of this important information simply by 
synchronizing your data with the Palm Desktop software on your computer to 
create a backup copy

System requirements 
To install and operate Palm Desktop software on Windows, your computer system 
must meet the following requirements:

• IBM-compatible Pentium-class computer
• Windows 98, Windows Millennium Edition (Me), or Windows 2000

For Windows 95 or Windows NT, a Serial sync cable is required, sold 
separately.

• 32 MB RAM (64 MB recommended))
• 30 MB available hard disk space
• Monitor displaying VGA resolution or better 
• CD-ROM drive
• Mouse 
• One available USB or serial port



1 Getting started
Acer s10 tour

2   

Acer s10 tour

Front panel
Your Acer s10’s front panel consists of the following:

No. Component Description

1 Power button/
Backlight control/
LED indicator

As a power button, pressing turns your Acer s10 on (if it is 
off) and returns to the last screen that was displayed and 
off (if it is on). 
As a backlight control, activates the backlight to illuminate 
the screen in low-light conditions. 

2 Stylus holder Secures the stylus in your Acer s10. To use the stylus, 
remove it from its holder and hold it the same way you 
hold a pen or pencil. 

3 LCD screen Displays the applications and data stored in your Acer s10. 
It is touch-sensitive and responds to the stylus or your 
finger.

4 Graffiti writing area Write letters and numbers in this area using the Graffiti 
alphabet.

5 Scroll button Press up or down to display the text and other information 
that extends beyond the area of the LCD screen. 

6 Internal speaker Outputs sounds from your Acer s10.
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Using the backlight
If lighting conditions make it difficult for you to see the information on your Acer s10, 
use the backlight to illuminate your screen.

To activate the backlight:
• Press the power button and hold it down for about two seconds. Release the 

button when the backlight turns on. 

TIP: You can assign the full-screen pen stroke to activate the backlight. Refer to "ShortCuts 
preferences" on page 294. 

7 Versatile connector Connects your Acer s10 to the cradle, which in turn 
connects to the back of your computer and through the AC 
adapter to the wall current. This allows you to 
recharge your Acer s10 and perform HotSync operation. 
Also connects peripheral hardware devices, such as a 
keyboard, to your Acer s10. 

8 Application buttons Activates the basic applications that correspond to the 
icons marked on the buttons: (from left) Date Book, 
Address Book, To Do List, and Memo Pad. 

NOTE: Refer to "ShortCuts preferences" on page 294 
for instructions on how to reassign these buttons to 
other applications on your Acer s10.

If your Acer s10 is turned off, pressing any application 
button turns on the device and opens the corresponding 
application.

No. Component Description
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Rear panel
Your Acer s10’s rear panel consists of the following: 

No. Label Description

1 Infrared (IR) 
port

Uses infrared technology to transmit and receive data from 
other IR-enabled Palm OS handhelds and devices. You can also 
use it to perform IR HotSync operation.

2 Memory Stick 
slot

Accepts a Memory Stick, allowing you to add more memory, 
install add-on applications or use audio or text files stored in it 
for use with internal applications. You can also use it to back up 
data from your Acer s10. 

3 Earphone jack Connects to audio line-out devices (earphones/headphones) 

4 Microphone Inputs audio into your Acer s10. 

5 Recorder Hot 
Button

Activates the Recording mode in Recorder.
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Elements of the Acer s10 interface
Your Acer s10 interface consists of the following elements:

6 Accessory slot Holds your Acer s10’s miscelleanous accessories. 

7 Reset button Press to perform a soft or hard reset on your Acer s10. Under 
normal conditions, you should not have to use this button. Refer 
to "Resetting your Acer s10" on page vi for more 
information.

No. Label Description

No. Component Description

1 Applications Activates the Applications Launcher screen displaying icons for 
applications stored in both your Acer s10’s internal memory 
and in a resident Memory Stick. 

2 Contrast 
control 

Displays the onscreen contrast control screen. You can adjust 
the control for the clearest screen display according to the 
lighting conditions or temperature of the environment where 
you use your Acer s10. 

3 Service 
Launcher 

Activates the Personal Service screen, displaying icons for 
applications included under the Service category of 
Applications Launcher.

4 Find Activates the Find function enabling you search text in all 
available records starting with the records of the open 
application. 

5 123 Activates the numeric keyboard when the dot is tapped; note 
that the cursor must be in an input field for this option to work.
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Using the onscreen contrast control
The onscreen contrast control further adjusts your screen illumination by changing the 
amount of contrast on the screen. 

To adjust the contrast:

1 To display the Adjust Contrast screen, Tap the Contrast icon  on the upper-left 
corner of the Graffiti writing area 

2 Do one of the following:

• To change the contrast in small increments, tap to the left or right of the 
slider.

• To change the contrast in larger increments, drag the slider to the left or 
right.

TIP: You can also use the up and down scroll buttons on the front panel of your Acer s10 to 
adjust the contrast setting. 

3 Tap Done. 

6 Division mark Divides the Graffiti writing area into the text area for letters 
and character strokes (left side) and the number area for 
number strokes (right side). 

7 abc Activates the alphabetic keyboard when the dot is tapped; note 
that the cursor must be in an input field for this option to work. 

8 Menu Activates the menu bar of an open application. (Not all 
applications have a menu bar.)

No. Component Description
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Command interface
Your Acer s10 command interface consists of easy-to-understand elements that will 
help you perform your tasks in the most efficient manner.

Menu bar

Toolbar

Check box

Command button

Pick list

Scroll bar

Next/previous arrows

Element Description

Menu bar Contains a set of menu commands specific to the application. 

NOTE: Not all applications have a menu bar.

Toolbar Let you tap icons to initiate a command instead of tapping a 
command in the menu bar or writing a Graffiti ShortCut. The icons 
displayed in the toolbar vary within each application. 

Command buttons Initiate a command when tapped. Command buttons appear in 
dialog boxes and at the bottom of application screens.

Check box Indicates the status of the corresponding option. A check mark in a 
check box indicates that the option is active. If a check box is empty, 
tapping it inserts a check mark. If a check box is checked, tapping it 
removes the check mark.
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Preparing to use your Acer s10
Before you begin using your Acer s10, perform first the following easy installation 
tasks: 

• Connect the cradle to your Acer s10 and then to your computer
• Charge your Acer s10
• Install the Palm Desktop software 
• Set up your Acer s10

Connecting the cradle 
The cradle that comes with your Acer s10 enables you to synchronize the information 
on your handheld with those in your Palm Desktop files using HotSync technology. 

NOTE: The cradle that comes with your Acer s10 fits a USB connector. If your computer does 
not have a USB port, or if you are using Windows 95 or Windows NT, you should secure a 
Serial sync cable. 

To connect the cradle: 
1 Plug the cradle’s USB connector into a USB port on your computer.

2 Connect the AC adapter cord to the power socket at the back of the cradle. 

3 Plug the AC adapter into any AC current outlet.

Pick list Displays a list of choices. Tap the black inverted triangle next to the 
pick list name to display a list of choices, and then tap an item in the 
list to select it.

Scroll bar Lets you move through long records. Tap and hold down the scroll 
bar slider to scroll through pages; tap the slider arrow at either end 
to move one line at a time. To scroll to the previous page, tap the 
scroll bar just above the slider; to scroll to the next page, tap the 
scroll bar just below the slider. 

Next/previous arrows Tap to display the previous and next page of information.

Element Description
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Charging your Acer s10
Your Acer s10 contains a Lithium-ion battery that is recharged each time you place 
your handheld in the cradle. 

To charge your Acer s10:
There are two ways to charge your Acer s10: 

• Charging with the cradle 
Connect the AC adapter connector to the power socket at the back of the 
cradle, then plug the other end of the AC adapter into any AC current outlet. 

Insert your Acer s10 into the cradle. The bottom edge of your Acer s10 should 
align smoothly with the cradle when it is inserted properly.
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• Charging directly from the power supply
Connect the AC adapter connector to the versatile connector of your 
Acer s10, then plug the other end of the AC adapter cord to an AC 
current outlet.

LED status during charging: 
• Charging: LED indicator flashes green
• Charging complete: LED indicator steady green

For the initial charging, charge your Acer s10 for three hours before you use it. After 
that, you can charge it for a few minutes each day to recharge the battery to full 
capacity. 

If the battery becomes low in the course of normal use, an alert appears on the 
Acer s10 screen indicating low battery status. If this alert appears, perform a HotSync
operation to back up your data; then leave your Acer s10 in the cradle to recharge the 
unit. 

If your Acer s10 shuts down (i.e., battery is completely drain out) you have about a 
week to recharge the battery before you lose all data on your handheld’s internal 
memory. 

Palm Desktop software
Palm Desktop software includes the same basic applications as your Acer s10: 
Date Book, Address Book, To Do List, Memo Pad and Expense. You can use the 
HotSync feature of this software to back up and exchange data between your 
Acer s10 and your computer.

It’s a good idea to back up your data in case something happens to the data on your 
Acer s10. Changes you make on your Acer s10 or on your Palm Desktop software 
appear in both places after you synchronize.

With Palm Desktop software, you can do the following:

• Work with your Acer s10 applications on your computer.
• Install new applications on your Acer s10.
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• Back up the data stored on your Acer s10 with HotSync technology and 
synchronize it with the data on your Palm Desktop software. Synchronization 
is a one-step procedure that ensures your data is always safe and up-to-date.

• Import and export data, so you can easily transfer data from other desktop 
applications into any of your main applications.

• Print your Date Book, Address Book, To Do List, and Memo Pad information 
on any printer.

Installing Palm Desktop software
The main complementing function of the Palm Desktop software to your Acer s10 is 
its role in performing a HotSync operation so that information in your handheld and 
your computer remains synchronized with each other. This will also allow you to 
create backup data in case something happens to your Acer s10.

The following instructions tells you how to install the Palm Desktop software. After 
installation, refer to the Palm Desktop online Help for information on how to use the 
software.

Pre-installation instructions: 
• Connect the cradle to your computer. Refer to "Connecting the cradle" on 

page 8 for instructions.
• Do not copy the Palm Desktop software files to your computer’s hard disk. 

You must use the Acer s10 handheld Installation CD to place the files in their 
proper locations and to decompress the files. 

To install Palm Desktop software:
1 Exit any open programs, including those that run at startup such as Microsoft® Office, 

and disable any virus-scanning software.

2 Insert the Acer s10 handheld Installation CD into the computer’s CD-ROM drive. 

3 On the menu screen, click Install Palm Desktop to display the Setup window.
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4 On the Setup window, click Next.

5 Select a Setup type depending on your choice of PIM (personal information manager) 
for file synchronization then click Next. Options include: 

• Palm Desktop 
• Palm Desktop and Microsoft Outlook 

6 Click Next.
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7 On the Choose Destination Location window, select a folder where Setup will install 
the program files. 

Default directory is C:\Palm. Use the Browse button to select a different location. 

8 Click Next to start the installation procedures. 

9 A prompt window to set up Mail appears. 

Click Yes to set up Mail now. Setup proceeds to configure your computer for Mail. 

Click No to set up Mail later. 

NOTE: If you choose to configure Mail later, you can access the Mail Setup by clicking 
Start>Programs >Palm Desktop>Mail Setup. Refer to "Setting up the Mail application on your 
computer" on page 229 for more information. 
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10 Click Finish to complete the Palm Desktop installation. 

Using your Acer s10 with another personal information 
manager 
If you prefer to use another personal information manager (PIM), such as Microsoft 
Outlook, you can use it instead of the Palm Desktop software. All you need to do is 
install the HotSync Manager and the connection software for your PIM, called a 
conduit, that lets you synchronize the data between your Acer s10 and your PIM. 

Included in the Acer s10 handheld Installation CD is the Intellisync Lite conduit for 
Microsoft Outlook; however, you must install it in addition to the Palm Desktop 
software. For information on the availability of conduit software for the PIM you use, 
contact the vendor of your PIM. 

Setting up your Acer s10
After your Acer s10 has been charged initially for three hours, you can now set it up 
for use. Refer to the instructions below. 

To set up your Acer s10:
1 Press the power button on the front panel of your Acer s10.
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2 Follow the onscreen instructions to set up your Acer s10. 

Synchronizing data
After setting up your Acer s10 and completing the installation of Palm Desktop 
software, perform the first HotSync operation to synchronize—exchange and 
update—data between your Acer s10 and the PIM you installed in your computer. 

Performing the first HotSync operation
You must perform your first HotSync operation with a local, direct connection or with 
infrared communication, rather than using a modem. 

To perform the first HotSync operation:
1 Insert your Acer s10 into the cradle.

2 If the HotSync Manager is not running (i.e., the HotSync Manager icon  is not 
visible in the bottom right corner of the Windows system tray), start it: 

• On Windows desktop, click Start, and then choose Programs. 
• Navigate to the Palm Desktop program group and choose HotSync Manager. 

Alternatively, you can start the Palm Desktop software which automatically 
opens the HotSync Manager.

3 Press the HotSync button on the cradle.

NOTE: If you are using an optional Serial sync cable instead of a cradle, click the HotSync 
Manager icon in the Windows system tray and select Local Serial from the menu.
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4 On your computer screen, select a user ID or create a new user ID by clicking on the 
New button, then click OK. 

The HotSync Progress message window appears on your computer screen to indicate 
that synchronization begins.

5 Wait for a message on your Acer s10 screen indicating that the process is complete.

6 When the HotSync process is complete, you can remove your Acer s10 from the cradle 
by gently tilting the handheld forward and then pulling it up to remove.

Tapping versus clicking 
Just as you use a mouse pointer to click elements on your computer’s screen, you use 
the stylus to tap elements on your Acer s10’s touch-sensitive screen. Tapping is the 
basic action used to execute tasks on your Acer s10.

The first time you start your Acer s10, setup instructions appear on the screen. These 
instructions include a calibration screen. Calibration aligns the internal circuitry of 
your Acer s10 with its touch-sensitive screen so that when you tap an element on the 
screen, your handheld can detect exactly which task you want to perform. 

IMPORTANT: Always use the point of the stylus for tapping or making strokes on your Acer 
s10 screen. Do not use a pen, pencil, or any other sharp object to write on the screen. 
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With your Acer s10 turned on, you can tap the touch-sensitive screen to perform many 
operations, such as the following:

• Open applications
• Choose menu commands
• Initiate a global Find operation
• Select options in dialog boxes
• Open the onscreen keyboards

Just as you drag the mouse to select text or move objects on your computer, you can 
drag the stylus to select text. In addition, you can use the stylus to drag the slider of 
any scroll bar.

Calibrating your Acer s10 screen
The first time you start your Acer s10, setup instructions appear onscreen. These 
instructions include a calibration screen, or Digitizer. Calibration aligns the internal 
circuitry of your Acer s10 with its touch-sensitive screen so your handheld can detect 
the task you want to perform when you tap an element on the screen.

To calibrate the Acer s10 screen:

1 Tap the Applications icon , and then tap the Prefs icon .

2 In the pick list in the upper right corner of the screen, tap Digitizer.

3 Follow the oncreen instructions, tapping the screen where indicated.

Opening applications
You can use the Applications Launcher to open any application installed on your 
Acer s10. You can also open the four main applications—Date Book, Address Book, To 
Do List, and Memo Pad—with the application buttons on the front panel of your 
Acer s10.

TIP: When you press an application button on the front panel of your Acer s10, the 
application assigned to that button is immediately launched.

In addition to providing a way for you to open applications, the Applications Launcher 
displays the current time, battery level, and application category. 
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To open an application:

1 Tap the Applications icon . The Applications Launcher main screen appears. 

2 Tap the icon of the application you want to open. 

If you have many applications installed on your Acer s10, tap the scroll bar to see all 
the available applications.

TIP: You can find an application quickly by writing the Graffiti character for the first letter 
of its name. The Application Launcher scrolls to the first application with a name that begins 
with that letter.

NOTE: You can also use applications stored in a Memory Stick. Refer to "7 Using expansion 
features" on page 217.

Using menus and menu commands 
Menus on your Acer s10 are easy to use, and work the same way in all applications. 
Menu bars and manual commands differ based on the application and the area of the 
application in which you’re working. For example, in the Memo Pad, the Memo List 
screen and the Memo screen display different menus. 

Menu commands for each application are described in the corresponding application’s 
chapter. 

Most menu commands have an equivalent Graffiti command stroke, which is similar to 
keyboard shortcuts used to execute commands on computers. To use Graffiti menu 
commands, menus must be closed. 

To display a menu bar:
Do one of the following: 

• Open an application (such as the Date Book); then tap the Menu icon . 
Select the desired command from the menu. 
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• Tap the inverted application title tab at the top of any application screen 
(The Calculator does not have an inverted tab.); then tap the desired 
command. 

NOTE: Not all applications have a menu bar.

Using Graffiti to execute commands
An alternative to the menu bar in executing commands is the use of the Graffiti 
Command stroke (diagonal line from the lower left to upper right). You could either 
display a command toolbar or use a Graffiti command letter. 

Graffiti command toolbar
The Graffiti command toolbar displays context-sensitive command icons for the 
current screen. For example, if text is selected the menu icons displayed may include 
Undo, Cut, Copy and Paste. 

To use the Graffiti command toolbar:
1 In the Graffiti text area of your device’s screen, draw the Graffiti Command stroke to 

display the Command toolbar. The Command toolbar is displayed for approximately 4 
seconds.

2 Tap an icon that represents the command you want. 

Command

Tap here.
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Graffiti command letter
Most menu commands have an equivalent Graffiti command letter, which is similar to 
a keyboard shortcut used to execute a command (for example, pressing CTRL+S will 
save an open document). The command letters appear on the right side of the 
command names. 

To use a Graffiti command letter: 
1 In the Graffiti text area of your device’s screen, draw the Graffiti Command stroke to 

enter Command mode. The Command toolbar will be displayed.

2 Draw the command letter. Note that if you wait more than three seconds to draw the 
command letter, you’ll have to redraw the Graffiti command stroke to redisplay the 
Command toolbar.

Displaying online tips
Many of the dialog boxes that appear on your Acer s10 contain a Tips icon  
(the lowercase I in the upper right corner of the dialog box). Tips anticipate questions 
you may have and provide shortcuts for using the dialog box or other useful 
information. 

To display an online tip:

1 Tap the Tips icon . 

2 Tap Done after reading the tip. 

Command lettersMenu commands

Tips icon
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Entering data
You can enter data into your Acer s10 in several ways:

• Using Graffiti
• Using the onscreen keyboard
• Using an external keyboard
• Importing data in Palm Desktop software and then synchronizing it with your 

Acer s10
• Beaming data from another Palm OS handheld that is close by and has an 

infrared port
For more information on these topics, refer to "2 Entering data in your Acer s10" on 
page 23.
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2 Entering data in your 
Acer s10
You can enter data into your Acer s10 in several ways:

• Using Graffiti
• Using the onscreen keyboard
• Using an external keyboard
• Importing data in Palm Desktop software and then synchronizing it with your 

Acer s10
• Beaming data from another Palm OS handheld that is close by and has an 

infrared port

Entering data using Graffiti 
You can use Graffiti writing commands to create letters, numbers, punctuation, and 
symbols. The Graffiti writing strokes include all letters, numbers, and symbols found 
on a standard keyboard. 

Writing Graffiti characters
The similarity of Graffiti strokes with the uppercase letters of the standard English 
alphabet makes learning Graffiti writing an easy task. With only a few minutes of 
practice, you’ll be able to enter accurate text and numbers using Graffiti writing 
strokes. 

General guidelines in Graffiti writing 
• To achieve 100% accuracy, practice drawing characters exactly as they appear 

in the tables later in this chapter.
• The heavy dot on each shape indicates where to start the stroke. Some 

characters have similar shapes, but different starting and ending points. 
Always start the stroke at the heavy dot. (Do not draw the heavy dot; it is 
there only as a guideline.) 

• Most characters require only a single stroke. When you lift the stylus from the 
Graffiti writing area, Acer s10 recognizes and displays the text character 
immediately. 

• The Graffiti writing area is divided into two parts, one for writing letters and 
one for writing numbers. The small marks at the top and bottom of the 
Graffiti writing area indicate these two areas. To have your Acer s10 
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recognize characters and numbers, you must begin character strokes on the 
left side, and number strokes on the right side of the Graffiti writing area.

The Graffiti alphabet
Draw Graffiti letters using the following strokes.

Letter Strokes Letter Strokes

A N

B O

C P

D Q

E R

F S

G T

H U

I V

J W

K X

Write letters and symbols here. Write numbers here.

Division marks
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To write Graffiti letters:
1 Tap the screen where you want to write letters, for example, on a line next to a time 

in the Date Book. 

Illustration suggestion (Delete this suggestion when completed): Show cur-
sor on a line next to a time in Date Book, or any other application used on your
device.

NOTE: A blinking cursor must appear onscreen above the Graffiti writing before you can 
begin writing text. 

2 Refer to the Graffiti alphabet table to find the stroke shape for the letter you want to 
write. For example, the stroke shown below creates the letter n. 

You use the same shape to create both the uppercase and lowercase version of a 
letter.

3 Position the stylus in the left hand side of the Graffiti writing area. 

4 Start your stroke at the heavy dot, and draw the stroke shape as it appears in the 
tables.

5 Lift the stylus from the screen at the end of the stroke shape.

Acer s10 recognizes your stroke immediately and displays the letter at the insertion 
point onscreen. As soon as you lift the stylus from the screen, you can begin the stroke 
for the next character you want to write.

Graffiti writing automatically capitalizes the first letter of a new record or sentence. 
To write additional capital letters, you must first write the Caps Shift stroke to shift to 

L Y

M Z

Space Backspace

Carriage
Return

Period Tap twice.

Start stroke at 
heavy dot.

Lift stylus here.
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Caps Lock mode— just as you press the Shift key on a keyboard—and then write the 
desired character stroke.

NOTE: When Caps Shift is active, an Up arrow appears in the lower right corner of 
your Acer s10 screen.

To write capital letters:
1 Choose from the following options:

• To enter a single capital letter, write the Caps Shift stroke. Then write the 
character stroke. 

• To enter all capital letters (Caps Lock), write the Caps Lock stroke, as shown 
below. All subsequent letters are capitalized. 

2 To return to lowercase or release the Caps Lock, draw the Caps Shift stroke again.

The Graffiti numbers
Draw Graffiti numbers using the following strokes.

To write Graffiti numbers:
1 Tap the screen where you want to write numbers. 

Caps Shift

Caps Shift

Caps Lock

Caps Lock

Number Strokes Number Strokes

0 5

1 6

2 7

3 8

4 9
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Illustration suggestion (Delete this suggestion when completed): Show
cursor on a line next to a time in Date Book, or any other application used
on your device.

NOTE: A blinking cursor must appear onscreen above the Graffiti writing before you can 
begin writing numbers. 

2 Refer to the Graffiti number table to find the stroke shape for the number you want 
to write. For example, the stroke shown below creates the number 3.

3 Position the stylus in the right hand side of the Graffiti writing area. 

4 Start your stroke at the heavy dot, and draw the stroke shape as it appears in the 
tables.

5 Lift the stylus from the screen at the end of the stroke shape.

Acer s10 recognizes your stroke immediately and displays the number at the insertion 
point onscreen. As soon as you lift the stylus from the screen, you can begin the stroke 
for the next character you want to write.

The Graffiti punctuation marks
You can create any punctuation symbol available from a standard keyboard using 
Graffiti writing. 

All punctuation marks begin with a single tap on the Graffiti writing area. This tap 
activates the Punctuation Shift, indicated by a dot displayed above the writing area. 
The next stroke you make with the stylus creates a punctuation mark. When 
Punctuation Shift is active, you can write a symbol stroke on either side of the Graffiti 
writing area (the letter or number side). 

Create punctuation marks using the following strokes:

Lift stylus here.

Start stroke at 
heavy dot.

Punctuation 
mark

Stroke Punctuation 
mark

Stroke

Period
.

Dash
—

Comma
,

Left Paren
(

Punctuation Shift



2 Entering data in your Acer s10
Entering data using Graffiti

28   

Additional Graffiti punctuation marks include the following:

The Graffiti symbols and extended characters
To write symbols and extended characters, you start by activating Symbol Shift. When Symbol Shift is active, a slanted shift symbol appears in the lower right corner of the screen. The next stroke you make creates the symbol or extended character.

Draw symbols or extended characters using the following strokes:

The Graffiti accented characters
To draw accented characters, you first draw the stroke for the letter, and then draw 
the accent stroke. Graffiti writing then adds the accent to the letter.

For example, the following illustration shows the strokes required to draw an 
accented e.

Apostrophe
'

Right Paren
)

Question
?

Slash
/

Exclamation
!

Dollar
$

Symbol
Shift

@     #     %     ^      &    *     <     >      –     +      =      | 

\      {      }     [       ]     ~     `         ;     :      "      tab

Symbol Shift

•                           , , ,, , .,

+ ± X : = =c Y

? !

ƒ ∅



2 Entering data in your Acer s10
Entering data using Graffiti

 29

Using these accent strokes, you can write the following accented letters:

à   á   â   ã   ä   å   è   é   ê   ì   í   î   ï   ò   ó   ô   õ   ö   ù   ú   û   ü   ÿ   D   ñ

The Graffiti non-English characters
You can write the following characters in the lowercase alphabet mode without 
special punctuation or shifting. You must write these non-English characters in the 
left side of the Graffiti writing area.

Graffiti navigation strokes
Graffiti writing includes additional strokes for navigating within text or fields in your 
applications. 

Using Graffiti ShortCuts
Graffiti ShortCuts let you quickly and easily enter commonly used words or phrases. 
ShortCuts are similar to the Glossary or Autotext features of some word processors. 

Command Stroke

Move cursor right

Move cursor left

Previous field
(Address Book only)

Next Field
(Address Book only)

Open Address 
Record

(Address Book only)

= e

a         a       a        a        a       a

c ae
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Graffiti writing comes with several predefined ShortCuts. You can also create your 
own for any words, letters, or numbers.

You can create ShortCuts of up to 45 character using the ShortCut preferences. For 
detailed instructions on how to create a ShortCut, refer to "ShortCuts preferences" on 
page 294. 

Predefined Graffiti ShortCuts
Acer s10 includes the following predefined Graffiti ShortCuts for common entries. 

To use a ShortCut:
Draw the ShortCut stroke followed by the ShortCut character(s). 

When you draw the ShortCut stroke, the ShortCut symbol appears at the insertion 
point.

To edit a ShortCut:

1 Tap the Applications icon , and then tap the Prefs icon .

2 Tap the pick list in the upper right corner of the Preferences screen, then select 
ShortCut. 

3 Tap the ShortCut you want to edit.

4 Tap Edit.

5 Make the changes you want.

6 Tap OK.

Entry ShortCut

Date stamp ds

Time stamp ts

Date/time stamp dts

Meeting me

Breakfast br

Lunch lu

Dinner di

ShortCut
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To delete a ShortCut:

1 Tap the Applications icon , and then tap the Prefs icon .

2 Tap the pick list in the upper right corner of the Preferences screen, then select 
ShortCut. 

1 Tap the ShortCut you want to delete.

2 Tap Delete. 

3 Tap Yes.

Graffiti tips
When using Graffiti, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes that nearly fill 
the Graffiti writing area are easily interpreted. 

• To delete characters, set the insertion point to the right of the character you 
want to delete, and draw the Backspace stroke (a line from right to left) in 
the Graffiti writing area.

• Write at natural speed. Writing too slowly can produce errors.
• Do not write at a slant. Vertical strokes should be parallel to the sides of the 

Graffiti writing area.
• When letters and numbers can be written using two different strokes, use the 

one that’s easiest for you. 
• Press firmly.

Using the onscreen keyboard
You can open the onscreen keyboard anytime you need to enter text or numbers on 
your Acer s10. 

NOTE: You can enter Graffiti characters while using the onscreen keyboard. 

To use the onscreen keyboard:
1 Open any application (such as the Address Book). 

2 Tap any record, or tap New.

3 Choose one of the following to display the alphabetic or numeric keyboard:

• Tap  on the Graffiti writing area to display the alphabetic keyboard. 

• Tap  on the Graffiti writing area to display the numeric keyboard. 
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TIP: To select either keyboard, tap the Menu icon and then tap Edit. Tap Keyboard, and 
then select an option. 

4 Tap the desired characters or numbers.

5 Tap Done to enter the text or numbers.

Using an external keyboard 
You can connect an external keyboard to the versatile connector of your Acer s10 so 
you can type data directly into your handheld. External keyboards are very useful for 
typing large amounts of data quickly and accurately while you are away from your 
computer. Refer to the documentation that came with your external keyboard.

You can also key in information on your computer keyboard while using Palm Desktop 
software or any supported personal information manager (PIM) installed that is 
compatible with your Acer s10. You can then perform a HotSync operation to 
synchronize the information on your computer to that in your Acer s10. All basic 

Tap here for
alphabetic 
keyboard.

Tap here for
numeric 
keyboard.

Backspace

Carriage returnCaps Lock

Caps Shift

Tap here to display
alphabetic keyboard

Tap here to display
numeric keyboard.

Tap here to display
international keyboard.

InternationalNumeric

Alphabetic
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applications on your Acer s10 are also available in your Palm Desktop software and in 
most PIMs so you need not learn different applications. 

Refer to page 253 for more information on HotSync procedures.

Importing data
If you have data stored in computer applications such as spreadsheets and databases, 
or if you want to import data from another device, you can transfer the data to your 
Acer s10 without having to key it in manually. Save the data in one of the file formats 
listed below, import it into the Palm Desktop software, and then perform a HotSync 
operation to transfer the data to your Acer s10. Refer to page 253 for more 
information on HotSync procedures.

Palm Desktop software can import data from any of the following applications when 
you export the data in the appropriate file format. 

• Comma delimited (.csv, .txt): Address Book and Memo Pad only
• Tab delimited (.tab, .tsv, .txt): Address Book and Memo Pad only
• CSV (Lotus Organizer 2.x/97 Mapping): Address Book only
• vCal (.vcs): Date Book only
• vCard (.vcf): Address Book only
• Date Book archive (.dba)
• Address Book archive (.aba)
• To Do List archive (.tda)
• Memo Pad archive (.mpa)

NOTE: Archive formats can only be used with Palm Desktop software. Use the archive file 
formats to share information with other people who use devices based on the Palm 
Computing® platform or to create a copy of your important Palm Desktop information.

To import data:
1 Open the Palm Desktop software.

2 Click the application into which you want to import data.

3 If you are importing records that contain a field with category names, do the 
following:

a. Select All in the Category box.

b. Make sure that the same categories that appear in the imported file also exist in 
the application. If the categories do not exist, create them now; otherwise, the 
records will be imported into the Unfiled category.

4 Choose File > Import. 

5 Select the file you want to import. 

6 Click Open. 

7 To import data into the correct Palm Desktop fields, drag fields in the left-hand 
column so that they are opposite the corresponding imported field on the right.

To exclude a field from being imported, deselect the field’s check box. 
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8 Click OK. 

The imported data is highlighted in the application.

9 To add the imported data to your Acer s10, perform a HotSync operation.

NOTE: See the Palm Desktop online Help for more information on importing and exporting 
data.

Beaming data
Your Acer s10 is equipped with an IR (infrared) port that you can use to beam 
information to another Palm OS handheld that is close by and also has an IR port. The 
IR port is located on the top part of your Acer s10, indicated by the Infrared icon 

, behind the small dark shield. Refer to "10 Beaming information" on page 249 
for more information on this feature. 
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3 Managing your 
applications
This chapter explains how to switch between applications on your Acer s10, how to 
customized application settings to fit your work methods, and how to categorize 
applications into related groups. 

For information working with applications stored on an expansion card, refer to "7 
Using expansion features" on page 217.

Using the Applications Launcher
By default, Applications Launcher displays all the available applications installed on 
the internal memory of your Acer s10. You can choose to display only selected 
applications by arranging applications into categories. 

To open the Applications Launcher:

• Tap the Applications icon . The Applications Launcher main screen appears.

Your Acer s10 is equipped with a variety of applications. All applications installed on 
your Acer s10’s internal memory appear in the Applications Launcher. 

In addition to providing a way for you to open applications, the Applications Launcher 
displays the current time, battery level, and application category. 
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To open an application
Choose from the following options:

• Tap the Applications icon , and then tap the icon of the application you 
want to open. If you have many applications installed on your Acer s10, tap 
the scroll bar to see all the available applications. 

• Press an application button on the front panel to display the selected 
application immediately. 

Switching between applications 

Choose from the following options:

• Tap the Applications icon  and then tap the icon of the application you 
want to switch to. 

• Press an application button on the front panel of your Acer s10. 
Acer s10 automatically saves your work in the current application and displays it when 
you return to that application.

Categorizing applications
The category feature enables you to manage the number of application icons that 
appear in the Applications Launcher’s screen. You can assign an application to a 
category and then display a single category or all your applications.

NOTE: When you have a Memory Stick properly seated in the Memory Stick slot, the last 
item in the category pick list is Expansion Card. You cannot otherwise categorize applications 
stored in the expansion card. 

To categorize an application: 

1 Tap the Menu icon . 

2 From the App menu, tap Category. 

3 Tap the pick list next to each application to select a category.

Illustration suggestion (Delete this suggestion when completed): Category
screen

4 Tap Done.

To create a new category:
1 On the Category screen, tap Edit Categories from the pick list. 

2 Tap New. The New category screen appears.

Illustration suggestion (Delete this suggestion when completed): New Cat-
egory screen
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3 Enter the category name. 

4 Tap Done.

To display applications by category: 
• In Applications Launcher, do one of the following:

– Tap the Applications icon  repeatedly to cycle through all the 
categories.

– Tap the pick list in the upper right corner of the screen; then tap the 
category you want to display.

Changing the Applications Launcher display
By default, the Applications Launcher displays applications as icons. As an alternative, 
you can display applications in a list format. 

To change the view of applications: 

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

Illustration suggestion (Delete this suggestion when completed): Options
menu bar

2 Tap Options to display the menu drop-down window, then tap Preferences. 

3 Tap the View By pick list, then tap List. 

4 Tap OK. The Applications Launcher will now be shown in a List format. 

Illustration suggestion (Delete this suggestion when completed): Show
applications in List format.

In addition to displaying applications by icon or list, you can set an option to display 
the last-selected category of applications each time you open the Applications 
Launcher. 

To display the last selected category of applications:

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

2 Tap Options to display the menu drop-down window, then tap Preferences.

3 In the Preferences dialog box, tap Remember Last Category.

4 Tap OK. Each time you return to the Applications Launcher, the last category of 
applications you selected is displayed.

NOTE: If you do not select the Remember Last Category option, all applications are 
displayed when you select the Applications Launcher. 
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Setting preferences for applications
You can set preferences for individual applications in the Preferences dialog box. This 
will allow you to customized your applications to fit your work methods. 

NOTE: Not all applications have preference settings. 

To set preferences for an application: 

1 Open an application. 

2 Tap the Menu icon . 

3 From the Options menu, select Preferences.

4 Enter the desired preference settings. 

5 Tap OK.

Assigning applications to buttons
Buttons preferences let you assign different applications to the buttons on the front 
panel of your Acer s10, and to the HotSync button on the cradle. For example, if you 
find that you seldom use the To Do List and often use Expense, you can assign the To 
Do List button to start the Expense application.

You can also use the Buttons preferences to determine whether the full-screen pen 
stroke activates the Graffiti Help application or one of your Acer s10 controls. 

If you assign a different application to a button, you can still select the original 
application using the Applications Launcher. Changes made in the Buttons Preferences 
screen or HotSync Buttons dialog box take effect immediately. 

Refer to "ShortCuts preferences" on page 294 for instructions on how to change 
Button preferences. 

Installing and removing applications
To further customized your Acer s10 to your personal requirements, you have the 
option to install additional applications (called add-on applications) using the Install 
Tool during a HotSync® operation. 

In the event that you need to more memory or decide that you no longer need a 
particular application, you could also remove applications stored in your Acer s10’s 
RAM memory. 

NOTE: Applications stored in your Acer s10’s Flash Memory cannot be removed. 

To install add-on applications on your Acer s10
1 From your computer desktop, copy or download the applications you want to install 

into the Add-on folder in your Palm Desktop directory.
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NOTE: If the application is compressed, for example, as a .zip file, decompress the 
application into the Add-on folder before continuing.

2 Double-click the Palm Desktop icon on your computer desktop to display the Palm 
Desktop window. 

3 Click Instal to display the Install Tool Dialog box.

TIP: You can also select the Install Tool dialog box by selecting Install Tool from the Palm 
Desktop program group or by double-clicking any file with a .prc, .pdb, .pqa, .pnc, or .src file 
extension.

4 In the User drop-down list, select the user name that corresponds to your Acer s10. 

5 Click Add. 

6 In the file list of the Add-on folder, select the application that you want to install on 
your Acer s10 or on a resident Memory Stick. 

7 Click Open. The file appears in the Palm Install Tool dialog box. 
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NOTE: Review the list of applications you selected in the Install Tool dialog box. If you do 
not want to install an application, select it, then click Remove. This will remove the selected 
application from the list of application(s) to be installed; it does not remove the application 
from your computer. 

8 Click Done. A message appears to indicate that the application or applications will be 
installed the next time you perform a HotSync operation. 

9 Perform a HotSync operation to install the applications. See "11 Exchanging and 
updating data using HotSync operations" on page 253.

To remove an add-on application

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

2 Tap App to display the App dialog box. 

3 Tap Delete to display the Delete dialog box. 

4 Tap the Delete From pick list and select either Handheld or Card. 

NOTE: To delete application from a Memory Stick, the card must be properly inserted in the 
Memory Stick slot.

5 Tap the application you want to remove.

6 Tap Delete.

7 Tap Yes.

8 Tap Done.

Removing the Palm Desktop software
If you no longer want to use Palm Desktop software, you can remove it from your 
computer. 

To remove the Palm Desktop software in Windows: 
1 Click the Windows Start button, choose Settings > Control Panel.

2 Open the Add/Remove Programs icon. 
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3 On the Install/Uninstall tab, select Palm Desktop Software. 

4 Click Add/Remove. 

NOTE: You must retain the HotSync Manager on the Acer s10 handheld Installation CD to 
synchronize data with another PIM. 

Security
Your Acer s10 comes with a security application to prevent unauthorized access to your 
private records. Refer to page 63 for procedures on how to make records private. 

You can mask or hide private records. When you mask private records, a gray 
placeholder appears where the record would normally be displayed; when you hide 
records, they are not visible anywhere in the list.

To mask a private record: 
1 From within any private record, do one of the following to display the Change 

Security dialog box:

• In Applications Launcher, tap the Security icon.
• From within an application, tap the inverted application title tab at the top 

of the screen; then tap Security in the Options menu. 
• From within any application, drag your pen diagonally across the writing area 

of the Graffiti screen from lower left to upper right to bring up the 
Command Bar. Tap the padlock icon. 

2 Tap the Current Privacy pick list. 

3 Tap Mask Records. 

4 Tap OK.

To mask all private records:
1 In Applications Launcher, tap the Security icon.

2 From the Current Privacy pick list, tap Mask Records. 

Open one of the basic applications and view a record. Records marked as private are 
masked with a gray bar. 
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To hide a private record: 
1 From within any private record, do one of the following to display the Change 

Security dialog box:

• In Applications Launcher, tap the Security icon.
• From within an application, tap the inverted application title tab at the top 

of the screen; then tap Security in the Options menu. 
• From within any application, drag your pen diagonally across the writing area 

of the Graffiti screen from lower left to upper right to bring up the 
Command Bar. Tap the padlock icon. 

2 Tap the Current Privacy pick list. 

3 Tap Hide Records.

4 Tap OK.

To hide all private records:
1 In Applications Launcher, tap the Security icon.

2 From the Current Privacy pick list, tap Hide Records.

Illustration suggestion (Delete this suggestion when completed): Security
screen with Hide Record selected

3 Open one of the basic applications (except Expense and Mail). Records marked as 
private are not anymore displayed. 

NOTE: You can mask or hide records without assigning a password, or you can assign a 
password if you want records to remain masked or hidden until a password is entered. 

Assigning and editing passwords
You can assign a password to protect your private records and to lock your Acer s10.

Once you define a password, you can change or delete it at any time. You must enter 
the current password before you can change or delete it. 

If you’ve forgotten your password, you can delete it. Refer to "Recovering from a 
forgotten password" on page 43.

To assign, change, or delete a password:
1 In Applications Launcher, tap the Security icon. 

2 Tap the Password box. 

3 Enter a password—either the one you want to assign or your current password if you 
want to change or delete it—and tap OK.

Illustration suggestion (Delete this suggestion when completed): Show the
password dialog box.

4 Choose from the following options:
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• To assign a password, enter the password again to verify it, and tap OK. 
• To change your password, enter a new password and tap OK.
• To delete your password, enter your current password. Tap OK, and then tap 

Delete.

Locking your Acer s10 
You can turn off and lock your Acer s10 with a password to protect information. You 
must then enter the password when you turn on your device to gain access to the 
information on it. 

If you forget the password, you must perform a hard reset to resume using your 
Acer s10. Performing a hard reset deletes all the records in your Acer s10; however, 
you can restore all synchronized data at the next HotSync operation. Refer to 
"Performing a hard reset" on page vii for instructions. 

To lock your Acer s10 with a password:

1 Assign a password, as described in “Assigning and editing passwords” earlier in this 
section. 

A password is required before using the Turn Off & Lock option.

2 Tap Turn Off & Lock Device. The System Lockout dialog box appears. 

3 Tap Off & Lock. You device is turned off and is locked. 

To turn on and unlock your Acer s10:
1 Turn on your device. 

2 Enter your password at the prompt. 

3 Tap OK. 

Recovering from a forgotten password
If the Off & Lock option is not active, and you forget your password, you can delete 
the forgotten password from your Acer s10. Deleting a forgotten password also 
deletes all entries and files marked as Private.

IMPORTANT: If you synchronize your Acer s10 with your computer before deleting a 
forgotten password, Acer s10 restores private entries the next time you perform a HotSync 
operation, but does not restore the forgotten password. 

To delete a forgotten password:
1 From the Applications Launcher pick list, tap Security. 

2 From the Security dialog box, tap Forgotten Password.

3 Tap Yes to delete the forgotten password. 
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Displaying private records
Using the security application, you can also display private records that have been 
previously masked or hidden.

NOTE: If you have assigned a password to your device, you must enter it before 
private records are displayed. Refer to "Assigning security options" on page viii.

To unmask individual records:
1 Tap a masked record. 

If you do not have a password, a masked record becomes visible.

If you have a password, the Show Private Records dialog box appears. Go to step 2.

2 Enter your password. 

3 Tap OK. 

To display private records:
1 Do one of the following to display the Change Security dialog box:

• In Applications Launcher, tap the Security icon.
• From within an application, tap the inverted application title tab at the top 

of the screen; then tap Security in the Options menu. 
• From within any application, drag your pen diagonally across the writing area 

of the Graffiti screen from lower left to upper right to bring up the 
Command Bar. Tap the padlock icon.

2 From the Current Privacy pick list, tap Show Records. 

Illustration suggestion (Delete this suggestion when completed): Show
Change Security dialog box with Show Records option selected

If you do not have a password, masked and hidden records become visible. 

If you have a password, the Show Private Records dialog box appears. Go to step 3.

Illustration suggestion (Delete this suggestion when completed): Show Pri-
vate Records dialog box 

3 Enter your password. 

4 Tap OK. 
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4 Working with your 
basic applications
Your Acer s10 includes the following basic applications:

• Date Book
• Address Book
• To Do List
• Memo Pad
• Calculator
• Expense
• Mail

This chapter is organized into three sections, namely: 

• Overview of basic applications
• Common application tasks
• Application-specific tasks

Overview of basic applications 
This section will give you a brief description of each basic application and explains 
how to launch it. 

Date Book
Date Book lets you conveniently manage your schedules and appointments or any 
other activities associated with a time and date. 

You can do the following in Date Book:
• Schedule events.
• Display your schedule in different ways: by Day, Week, Month, or Agenda 

view. 
• Set an alarm to sound minutes, hours, or days before a scheduled 

appointment. 
• Attach notes to events to describe or clarify Date Book entries. 
• Rearrange or delete events from your schedule.

To launch Date Book:
• Press the Date Book application button on the front panel of your Acer s10. 
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Date Book will open to today’s schedule. 

TIP: Press the Date Book application button repeatedly to cycle through the Day, Week, 
Month and Agenda views. 

Address Book
Address Book lets you keep names, addresses, phone numbers, and other information 
about your personal and business contacts.

You can do the following in Address Book:
• Quickly enter, look up, or duplicate names, addresses, phone numbers, and 

other information.
• Enter up to five phone numbers (home, work, fax, car, and so on) or email 

addresses for each name.
• Define which phone number appears in the Address List for each Address 

Book entry. 
• Attach a note to each Address Book entry, in which you can enter additional 

information about the entry.

Date Book application button
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• Assign Address Book entries to categories so that you can organize and view 
them in logical groups.

• Create your own digital business card that you can beam to other Palm OS 
handhelds.

To launch Address Book:
• Press the Address Book application button on the front panel of your 

Acer s10. 

Address Book opens to display the list of all your records.

TIP: Press the Address Book button repeatedly to cycle through the categories in which you 
have entries.

Address Book application button
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To Do List
To Do List is a convenient place to create reminders and prioritize the things that you 
have to do.

You can do the following in To Do List: 
• Make a quick and convenient list of things to do.
• Assign a priority level to each task.
• Assign a due date for any or all of your To Do List items. 
• Assign To Do List items to categories so that you can organize and view them 

in logical groups. 
• Sort your To Do List items either by due date, priority level, or category.
• Attach notes to individual To Do List items for a description or clarification of 

the task. 

To launch To Do List:
• Press the To Do List application button on the front panel of your Acer s10. 

To Do List opens to display the category of items you last viewed.

TIP: Press the To Do List application button repeatedly to cycle through the categories in 
which you have items.

To Do List application button
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Memo Pad
Memo Pad provides a place to take notes that are not associated with records in the 
Date Book, Address Book, or To Do List.

You can do the following in Memo Pad: 
• Use Graffiti characters to store memos, lists or any other text message on your 

Acer s10. 
• Drag and drop memos into popular computer applications like Microsoft® 

Word when you synchronize using Palm Desktop software and HotSync® 
technology.

• Assign memos to categories so that you can organize and view them in 
logical groups.

• Write down phone numbers and other types of information. Later, you can 
copy and paste this information into other applications. 

To launch Memo Pad:
• Press the Memo Pad application button on the front panel of your Acer s10. 

Memo Pad opens to display the Memo list.

Memo Pad application button
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TIP: Press the Memo Pad application button repeatedly to cycle through the categories in 
which you have memos.

Calculator
Calculator allows you to perform general mathematical functions including addition, 
subtraction, multiplication, division, and square root operations.

You can do the following in Calculator: 
• Perform basic calculations.
• Store and retrieve values.
• Display the last series of calculations, which is useful for confirming a series of 

“chain” calculations. 

To launch Calculator:

• Tap the Calculator icon . 
The Calculator pad appears. 

Expense
Expense enables you to keep track of your expenses and then transfer that 
information to a spreadsheet on your computer.

You can do the following in Expense: 
• Record dates, types of expenses, amount spent, payment method, and other 

details associated with any money that you spend.
• Assign expense items to categories so that you can organize and view them in 

logical groups.
• Keep track of vendors (companies) and people involved with each particular 

expense.
• Log miles traveled for a particular date or expense category.
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• Sort your expenses by date or expense type.
• Transfer your expense information to a Microsoft Excel spreadsheet 

(version 5.0 or later) on your computer. 

NOTE: Microsoft Excel is not included in the Acer s10 handheld Installation CD. 

To launch Expense:

• Tap the Expense icon . 
The Expense screen appears.

Mail
You can send or receive email after you’ve performed a HotSync operation, either 
locally using the cradle, or remotely using a modem.

Mail synchronizes the emails in the Inbox of your desktop email application with the 
emails in the Inbox on your Acer s10. 

For more information on how to use Mail, refer to ‘9 Managing your desktop email’ 
on page 229. 

You can do the following in Mail:
• View, delete, file, and reply to incoming emails.
• Create outgoing email items and drafts of email items.
• Create simple or complex filters, which will let you to decide which type of 

email Acer s10 retrieves from your desktop email application.
• Use your Acer s10 in its cradle to send and retrieve email items from your 

desktop email application.
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To launch Mail on your Acer s10:

• Tap the Mail icon . 
The Mail list screen appears. 

For more information on how to use Mail, refer to "9 Managing your desktop email" 
on page 229.

Previously read
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Common applications tasks
The tasks described in this section use the term records to refer to an individual item 
in any of the basic applications, for example, a single Date Book event, Address Book 
entry, To Do List item, Memo Pad memo, or Expense item.

Creating records
You can use the following procedure to create a new record in Date Book, Address 
Book, To Do List, Memo Pad, and Expense.

To create a record:
1 Select the application in which you want to create a record.

2 Tap New. 

For the Date Book only, select start and end times for your appointment and tap OK.

3 Enter text for the record.

NOTE: Acer s10 automatically capitalizes the first letter of each field (except numeric and 
email fields). 

4 As an option, tap Details to select attributes for the record.

5 In the Address Book and Memo Pad only, tap Done.

Acer s10 saves the new record automatically.

Editing records
After you create a record, you can change, delete, or add new information at any 
time. Two indicators will tell when your screen is in edit mode: 

• a blinking cursor appears within the information, and 
• the information appears on a dotted gray line called an edit line.

You can enter text in any of the ways described in "2 Entering data in your Acer s10" 
on page 23. 

Cursor

Edit line
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Selecting text
Select the text you want to edit using one of the following techniques:

• Double-tap on a word in a field to select the word.
• Triple-tap on any word on a line to select the entire line.
• Drag across a line of text to select some or all of the information, or drag 

down to select text across multiple lines.

Using the Edit menu
The Edit menu is available from any screen where you enter or edit text. As a general 
rule, the Edit menu commands affect selected text. You can display the Edit menu in 
three ways: by tapping the Menu icon , by tapping the inverted application title tab 
at the top of the screen, and by writing a Graffiti shortcut. 

To use the Edit menu: 
1 Do one of the following to display the Edit menu: 

• Tap the Menu icon ; then tap the Edit menu to display the commands in 
the menu. 

• Tap the inverted application title tab at the top of the screen; then tap the 
Edit menu to display the commands in the menu. 

• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar. To select a command, either:

– tap the icon representing a command on the Command toolbar, or 
– draw the Graffiti shortcut in the text area of your screen

2 Choose from the following commands, depending on the application you’re using: 

Undo Reverses the action of the last edit command made. Undo 
also reverses deletions done by using the backspace.

Cut Removes a selection from its current location and temporarily 
stores it in your Acer s10’s memory. You can then paste the 
text into another area of the current application or into a 
different application.

Copy Copies a selection and temporarily stores it in your Acer s10’s 
memory. You can paste the selection into another area of the 
current application or into a different application

Paste Inserts a selection from your Acer s10’s memory into a 
selected point in a record. Paste produces no result if you 
have not used the Cut or Copy commands

Select All Selects all the text in the current record or screen.
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Deleting records
You can delete records in any of the basic applications. 

To delete a record in any of the basic applications:
1 Select the record you want to affect.

2 Do one of the following: 

• Tap the Menu icon , open the Record menu, and then tap the Delete 
command. 
The Delete command differs depending on the application you’re using: 

– Date Book: Delete Event
– Address Book: Delete Address
– To Do List: Delete Item 
– Memo Pad: Delete Memo
– Expense: Delete Item

• Tap the inverted application title tab at the top of the screen, open the 
Record menu, and then select the desired Delete command. 

• In the Details dialog box of the application, tap Delete, and then tap OK.
• In the text Graffiti area, drag a diagonal line from the lower left to upper 

right to display the Command toolbar; then tap the Delete icon or draw a 
Graffiti ’D’ in the text area.

• Delete the text of the record. 

NOTE: In the Date Book, deleting the text of a repeating event deletes all instances of the 
event. 

A confirmation dialog box appears. If your want to archive a copy of the deleted file 
on your PC, select the Save Archive option. If you choose the archive option, the 
record is transferred to the archive file on your PC the next time you perform a 
HotSync operation.

3 Tap OK. 

Keyboard Opens the onscreen keyboard. Tap Done to close the 
keyboard.

Graffiti Help Opens screens that shows all the Graffiti character strokes. 
Use this anytime you forget a stroke for a character or a 
ShortCut for a command. 

Delete icon
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Purging records
Over time, as you use Date Book, To Do List, and Expense, you’ll accumulate records 
that are no longer useful. For example, events that occurred months ago remain in 
the Date Book, and completed To Do List items and Expense items remain in the list.

Outdated records take up memory on your Acer s10, so it is a good idea to remove 
them by using Purge. If you think Date Book or To Do List records might prove useful 
later, you can purge them from your Acer s10 and save them in an archive file. 

Purging is also available in Mail. See "Deleting email items" on page 241 for more 
information.

Purging is not available in Address Book or Memo Pad; delete outdated records from 
these applications manually. 

To purge records:
1 Open the application from which you want to purge records. 

2 Choose from the following options:

• Tap the Menu icon , open the Record menu, and then tap Purge. 
• Tap the inverted application title tab at the top of the screen, open the 

Record menu, and select Purge. 
A confirmation dialog box appears.

3 Choose from the following options:

• Date Book: Select the Delete Events Older Than pick list and select an 
option—1 week, 2 weeks, 3 weeks or 1 month.

• Date Book or To Do List: Select Save Archive Copy on PC to save a copy of 
purged records in an archive file on your desktop. Selecting this option 
transfers purged records to an archive file the next time you perform a 
HotSync operation. Tap OK.

• Expense: Tap a category and tap Purge. Tap Yes to confirm the deletion, and 
then tap Done.

Categorizing records
You can categorize records in the Address Book, To Do List, Memo Pad, and Expense 
applications for easy retrieval. (The Date Book does not have categories.) 

NOTE: You can also categorize applications. Refer to "Categorizing applications" on page 
36 for more information.

When you create a record, it is automatically assigned to the currently displayed 
category. If the All category is displayed, the record is assigned to the Unfiled 
category. A record can remain unfiled or it can be assigned to a category at any time. 

System-defined categories
Each application has a default set of categories: 
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• Address Book: Business, Personal, and QuickList category 
In QuickList, you can store names, addresses, and phone numbers you might 
need during emergencies (hospitals, fire department, police stations, etc.). 

• To Do List: Business, Personal, and All category
• Memo Pad: Business, Personal, and All category
• Expense: New York, Paris, and All category

The New York and Paris category shows how you might sort your records 
according to different business trips. 

You can modify or delete the default categories. 

User-defined categories
In addition to the default categories, you have the option to create new categories. 
Each application can have up to 15 user-defined categories.

To move a record into a category:
1 Select the record you want to categorize.

2 Tap Details. (From the Address View screen, tap Edit first.)

3 In the Details dialog box, tap the Category pick list to display the list of available 
categories. 

4 Select the desired category. 

5 Tap OK. 

To display a category of records:
1 Open the application from which you want to categorize records. 

2 Tap the pick list in the upper right corner of the screen. 

NOTE: In the Date Book Agenda view, the pick list is in the upper right of the To Do List. 

3 Select a category you want to display. 

TIP: Pressing the Address Book, To Do List, or Memo Pad button on your Acer s10 toggles 
through the categories assigned to these applications.

The list screen will now display only the records associated with the selected category.

To create a new category:
1 Tap the pick list in the upper right corner of the screen. 

2 Tap Edit Categories. 

3 Tap New.
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4 Enter the name for the new category. 

5 Tap OK. 

6 Tap OK to exit the Edit Categories dialog box. 

To rename a category:
1 Tap the pick list in the upper right corner of the screen. 

2 Tap Edit Categories. 

3 Select the category you want to rename. 

4 Tap Rename.

5 Enter the new name for the category.

6 Tap OK.

7 Tap OK to exit the Edit Categories dialog box. 

TIP: You can move records from multiple categories into a single category by renaming all 
discrete categories with a single category name. For example, if you rename the Personal 
Category to Business, all records formerly associated with the Personal category will now 
appear under the Business category. 

Tap here. 

Tap here. 
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Finding records 
Acer s10 lets you find information in several ways: 

• All internal applications: Find locates a specified text, starting with the 
current application. 

NOTE: Find does not search through applications stored in a resident expansion card. 

• Date Book, To Do List, and Memo Pad: Use Phone Lookup to display the 
Address list screen and add the information from this list to a record.

• Address Book: Enter the first letters of a name in the Look Up line to 
immediately scroll to that name.

• Expense: Use Lookup to display the names in your Address Book that have 
data in the Company field. You can add these names to a list of attendees 
associated with an Expense record. For more information, see"Entering 
receipt details" on page 106.

• Mail: Use Lookup to access information in your Address Book.

Finding Address Book records
You can look up Address Book records in two ways: 

• Use the scroll button on the front panel of your device 
– In the Address list screen, the scroll button moves up or down an entire 

screen of records. Holding down the button will accelerate scrolling and 
display every third screen.

– In Address view screen, the scroll button moves to the previous or next 
address record. 

• Type the first few letters of a name in the Look Up line at the bottom of the 
Address screen. 

The list scrolls to the first entry that begins with that letter. If you write 
another letter, the list scrolls to the first entry that begins with those two 
letters. For example, writing a “b” scrolls to “Bennet’, and writing ‘br’ scrolls 
further to “Bristol”.

Look Up line
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Using the Find option
The Find option lets you locate text in any or all applications. For example, if the text 
“dog” appears in the Address Book and the Date Book, the Find option displays both 
occurrences in the Find dialog box. 

To use the Find option:

1 Tap the Find icon  to display the Find screen.

TIP: Select text in an application before tapping Find to automatically place the text in the 
Find dialog box. 

2 Enter the text you want to find. 

The Find option is not case sensitive; searching for "david" also finds "David". 

3 Tap OK. 

Find searches for the text in all records and all notes within all internal applications.

NOTE: Find does not search through applications stored in a resident expansion card.

Find will locate all matches that begin with the supplied text. It will not find words 
where the supplied text appears in the middle or at the end of a word. For example, 
searching for “break” will find “breakfast” but not “fastbreak”. 

As Acer s10 searches for the text, you can tap Stop to stop the search at any time. To 
continue the search after tapping Stop, tap Find More.

Using Phone Lookup 
The Phone Lookup option lets you add a telephone number from the Address list to 
an entry in another application. For example, you can add your dentist’s telephone 
number to your dental appointment date in the Date Book. 
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To use Phone Lookup:
1 Display the record in which you want to insert a phone number. The record can be in 

the Date Book, the To Do List, the Memo Pad, or Mail. 

2 Do one of the following: 

• Tap the Menu icon . Open the Options menu, and then tap Phone Lookup. 
• Tap the inverted application title tab at the top of the screen; then tap 

Options and tap Phone Lookup. 
• In the text Graffiti area, drag a diagonal line from the lower left to upper 

right to display the Command toolbar. In the text area, write an L, the 
shortcut for the Phone Lookup command. 

The Phone Lookup screen appears. 

3 Do one of the following: 

• Select a record. 
• Write the first few letters of the name you want to add. 

The List srolls to the first record in the list that starts with the letters you 
enter. When you see the name you’re looking for, tap it.

4 Tap Add.

TIP: You can also search based on selected text. Drag to highlight the text, then write the 
Graffiti Phone Lookup command stroke “L”. Acer s10 replaces the selected text and adds the 
name and its associated information. 

Adding names to an Expense record
In Expense, Lookup display the names in your Address Book that have data in the 
Company field. You can add these names to a list of attendees associated with an 
Expense record. 

To add names to an Expense record: 
1 Tap the Expense record to which you want to add names. 
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2 Tap Details to display the Receipt Details screen.

3 Tap Who. 

4 Tap Lookup. 

The Attendees Lookup screen displays all the names in your Address Book that have 
data in the Company field.

5 Select the name that you want to add. 

6 Tap Add. 

The name appears in the Attendees screen. 

7 Repeat steps 5 and 6 to add more names. 

8 Tap Done. 

9 Tap OK. 

Sorting records
You can sort lists of records in various ways, depending on the application. Sorting is 
available in applications that display lists—in the Address Book, To Do List, Memo Pad, 
and Expense. 

To sort records in the To Do List and Expense applications:
1 Open the application to display the list screen.

2 Tap Show.

3 Tap the Sort By pick list, and select an option.

4 Tap OK.

To sort records in Memo Pad:
1 Open the application to display the list screen.

2 Do one of the following:

• Tap the Menu icon . Open the Options menu, and then tap Preferences. 
• Tap the inverted application title tab at the top of the screen; then tap 

Preferences in the Options menu. 
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• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar. In the text area, write an R, the 
shortcut for the Preferences command. 

The Preferences dialog box appears. 

3 In the Preferences dialog box, tap the Sort by pick list and select an option—
Alphabetic or Manual.

4 Tap OK. 

To sort the Memo List manually:
• Tap and drag a memo to a new location in the list. 

TIP: To display the list of your memos on your computer as you arranged them manually on 
your Acer s10, open Memo Pad in the Palm Desktop software, click List By, and select Order 
on Handheld.

Making records private
In all the basic applications except the Expense and Mail applications, you can make 
individual records private. Private records remain visible and accessible until you select 
a security setting to Hide records. 

Private records can be either masked or hidden. Masked private record are covered 
with a gray bar and are are marked with a lock icon. Hidden private records 
completely disappear from the screen. 

Refer to "Security" on page 41 for procedures on how to mask and hide private 
records.

To make a record private:
1 In your application, display the entry you want to make private. 

2 Tap Details.

3 Tap the Private check box. 
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4 Tap OK. An alert box appears. 

5 Tap OK.

Attaching notes
You can attach notes to records in all the basic applications except the Memo Pad. A 
note can be up to several thousand characters long. 

To attach a note to a record:
1 Display the entry to which you want to add a note. 

2 Tap Details. 

NOTE: In Address Book only, tap Edit first to be able to display and tap Details.

3 Tap Note. 

4 Enter your note. 

5 Tap Done. A Note icon appears to the right of any item containing a note. 

To review or edit a note:
• Tap the Note icon.

To delete a note:
1 Tap the Note icon.

2 Tap Delete. 

3 Tap Yes. 
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Choosing fonts
You can change the font style in all basic applications except the Expense application. 
You can choose a different font style for each application.

To change the font style:
1 Open an application.

2 Do one of the following to display the Select Font screen: 

• Tap the Menu icon . Open the Options menu, and then tap Font.
• Tap the inverted application title tab at the top of the screen; then tap Font 

in the Options menu. 
• In the text Graffiti area, drag a diagonal line from the lower left to upper 

right to display the Command toolbar. In the text area, write an F, the 
shortcut for the Font command. 

3 Tap the font style you want. 

4 Tap OK.

Getting information on an application
You can get information on any application by displaying its About box. The About 
box displays the name and version number of the application. 

To display the About box:
1 Do one of the following: 

• Tap the Menu icon , then tap Options. 
• Tap the inverted application title tab at the top of the screen; and then tap 

Options. 
2 In the Options menu, tap About. 

The text following the About command differs based on your location. For example, if 
you’re in the Date Book, the command is About Date Book; if you are in the Address 
Book, the command is About Address Book. 
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Application-specific tasks
This section explains how-to-do instructions specific for each task of your basic 
applications. 

Using Date Book
Date Book lets you conveniently manage your schedules and appointments or any 
other activities associated with a time and date. 

Scheduling events
An entry in the Date Book is called an event. An event can refer to any activity that 
you associate with a particular day. 

You can schedule the following types of events in Date Book:

• Timed events, which have both times and dates
• Untimed events, for example, birthdays or anniversaries
• Repeating events, such as a weekly meeting held on the same day at the 

same time
• Continuous events, such as a vacation or three-day conference
• All day events, which reflect the default hours of a day as set by the user 

When you schedule an event, its description appears on the time line, and its duration 
is set to 1 hour by default. You can easily change the start time and duration for any 
event. 

Scheduling timed events
You can schedule timed events for the current date or for future dates. 

To schedule a timed event for the current date:
1 Tap the time line next to the time that corresponds to the start of the event. 

2 Enter a description of the event. Event description can be up to 255 characters in 
length.

3 Set the event’s duration:

Time bar shows 
default duration.

Tap a line next to desired 
time; then enter text.
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• If the event is 1-hour long, skip to the end of this procedure.
• If the event is longer or shorter than an hour, tap directly on the time to open 

the Set Time dialog box. Proceed to step 4.

TIP: You can open the Set Time dialog box (to select a start time) by making sure no event is 
selected, and then writing a number on the number side of the Graffiti writing area.

4 Set the duration of the event in either of the following ways:

• Tap the time columns in the Set Time dialog box to set the Start Time; then, 
tap on the End Time time columns to set the End Time.

• Tap All Day if the event lasts all day. The default hours of a standard business 
day are set by the user, and may be changed using the Preferences command 
in the Date Book application. See the section "Changing the displayed Start 
and End Times" on page 79. 

5 Tap OK.

Tap the time 
to display the 
Set Time 
dialog box.

Start Time 
highlighted

Tap to scroll to 
earlier hours.

Tap to scroll to 
later hours.

Tap to change 
hours.

Tap to change 
minutes. 
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To schedule a timed event for another date:
1 Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of the screen. If 
necessary, tap the Previous week or Next week scroll arrows to move to 
another 
week.

 
• Tap Go To at the bottom of the screen to open the Go to Date dialog box. 

Select a date by tapping a year, month, and day in the 
calendar.

2 After locating the desired date, follow the steps for scheduling an event for the 
current day.

Scheduling untimed events
You can schedule untimed events for any date. Untimed events appear at the top of 
the list of times marked with a diamond. 

To schedule an untimed event:
1 Select the event date you want, as described in the previous procedure, “To schedule 

a timed event for another date.” 

2 Tap New.

Previous/Next week 
scroll arrows 

Tap here. 
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3 In the Set Time dialog box, tap No Time, so that the start and end times are defined 
for the new event.

NOTE: You can tap OK instead but make sure nothing is entered for start or end time.

TIP: You can also create a new untimed event by making sure no event is selected and then 
writing letters in the Graffiti writing area. When you start writing, the untimed event appears 
at the top of the screen 

4 Enter a description of the event.

5 Tap a blank area on the screen to deselect the untimed event.

NOTE: If you create a timed event and later want to make it an untimed event, tap directly 
on the event time on the Date Book screen; then tap No Time and tap OK. 

Rescheduling events
You reschedule events using the Details option in the Date Book. You can also use the 
Details option to convert untimed events into timed events. 

To reschedule an event:
1 Tap the event you want to reschedule.

2 Tap Details.

New untimed event
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3 To change the time, tap the Time box , then select a new time. 

To change the date, tap the Date box, then select a new date

4 Tap OK.

Scheduling repeating or continuous events 
The Repeat function lets you schedule events that recur at regular intervals or extend 
over a period of consecutive days. 

Repeating events include a birthday or a weekly photography lesson that falls on the 
same day of the week and the same time of day. 

Continuous events might include a business trip or a vacation.

To schedule a repeating or continuous event:
1 Tap the event. (Be sure to tap the event and not the time next to the event.)

Typically, a continuous event is an untimed event.

2 Tap Details.

3 Tap the Repeat box to open the Change Repeat dialog box.

4 Tap Day, Week, Month, or Year to set how often the event repeats. 

For a continuous event, tap Day.

5 Enter a number that corresponds to how often you want the event to repeat on the 
Every line. For example, if you select Month and enter the number 3, the event 
repeats every third month.

6 To set an end date for the repeating or continuous event, tap the End On pick list and 
tap Choose Date. Use the date picker to select an end date.

7 Tap OK. The Repeat icon indicates that a repeating event appears to the far right on 
the event line.

Making changes to repeating or continuous events
When changes are made to a repeating or continuous event you have the option of 
applying the change to just the current event, the current event and all future 
occurrences of this event, or all occurrences of this event - past, present, and future.

To delete repeating events:
1 Select the event you want to delete.

2 Tap Details. The Event Details screen opens.

Tap the 
Repeat 
box.
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NOTE: You can also tap the Menu icon; select Record, and then tap Delete Event. This opens 
the Repeating Event screen.

3 Tap Delete. The Repeating Event screen opens asking for confirmation of the delete.:

4 Select one of the following options:

The event is removed from your Date Book and you are returned to the Day view 
where you started. These steps apply to all changes you make to repeating or 
continuous events.

About scheduling repeating or continuous events
Keep the following in mind when scheduling repeating or continuous events:

• If you change the start date of a repeating event, Acer s10 calculates the 
number of days you moved the event. It then automatically changes the end 
date to maintain the duration of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a repeating event, 
past occurrences (prior to the day on which you change the setting) are not 
changed, and Acer s10 creates a new repeating event.

• If you change the date of an occurrence of a repeating event (e.g., from 
January 14 to January 15) and apply the change to all occurrences, the new 
date becomes the start date of the repeating event. Acer s10 adjusts the end 
date to maintain the duration of the event.

• If you change other repeat settings (for example, time, alarm, private) of a 
repeating event and apply the change to all occurrences, Acer s10 creates a 
new event. The start date of this new event is the day on which the setting is 
changed. Past occurrences (prior to the day of the change) are not changed.

• If you apply a change to a single occurrence of a repeating event (e.g., time), 
that occurrence no longer shows the Repeat icon.

Adding Address Book information to an event
You can add a name, address, and telephone number to an event using the Phone 
Lookup option. For instructions, refer to "Using Phone Lookup" on page 60. 

Tap Delete.

Current Deletes a single occurrence of this event.

Future Deletes the current event and all future occurrences of this event.

All Deletes all past, current, and future occurrences of this event.
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Setting the alarm for an event
The Alarm setting lets you set an audible alarm for events in your Date Book, and 
display an onscreen reminder. For untimed events, only the reminder message 
appears.

You can set an alarm for minutes, hours, or days before an event. When you set an 
alarm, an Alarm icon appears to the far right of the event with the alarm. 

You can also set a silent alarm for untimed events that displays a reminder message 
onscreen before the day of the event. The alarm triggers at the specified period of 
minutes, hours, or days before midnight of the day on which the untimed event 
begins. 

For example, you set a 5-minute alarm for an untimed event that occurs on February 
4. The reminder message will appear at 11:55 p.m. on the night of February 3. The 
reminder remains onscreen until you turn on your Acer s10 and tap OK to turn off the 
reminder.

To set an alarm for an event:
1 Tap the event to which you want to assign an alarm.

2 Tap Details.

3 Tap the Alarm check box to select it.

4 The default setting, 5 Minutes, appears.

5 Set the alarm time:

• Select the 5 next to the Alarm check box and enter any number from 0 to 99 
(inclusive) as the number of time units.

• Tap the pick list to change the time unit; select Minutes, Hours, or Days.

6 Tap OK.

Once an alarm has gone off, you can tap the Snooze option to dismiss the alarm for a 
5-minute period. 

To dismiss the alarm using the Snooze option:
When the alarm dialog box appears, tap Snooze to delay the alarm for a preset 
five-minute period. 

Each time you tap Snooze, the alarm is dismissed for an additional 5-minute period. 

Tap here to 
select unit of time.

Enter number of 
time units here.
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Setting alarm options
You can use Preferences to set alarm options, including:

• For the alarm to go off automatically for each new event 
• Set a tone for the alarm
• Set the number of times the alarm sounds

To set alarm options:
1 To open the Preferences dialog box, do one of the following: 

• In Date Book, tap the Menu icon , open the Options menu, and then tap 
Preferences.

• Tap the inverted application title tab at the top of the Date Book screen to 
display the menu bar, select Options, then tap Preferences.

• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar. Draw an R, the Graffiti shortcut for 
the Preferences command. 

2 Select from the following options: 

Start/End Time Let you set the start and end time for the Date Book view. See 
"Changing the displayed Start and End Times" on page 79. 

Alarm Preset Let you set an alarm for each new event automatically. The silent 
alarm for untimed events is defined by minutes, days, or hours 
before midnight of the date of the event. 
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3 Tap OK.

Changing the Date Book view
The Date Book includes four views for displaying your appointments: 

• Day view
• Week view 
• Month view
• Agenda view

You also have the option to display the current time. 

To display the Date Book views: 
Do one of the following:

• Press the Date Book application button repeatedly to cycle through all the 
Date Book views. 

• Tap a view icon in the lower-left area of the Date Book screen.

To display the current time:
1 Tap and hold down the stylus on the date in the date bar to display the current time.

2 Release the stylus to re-display the the date. 

Working in Week view
Week view displays a calendar of your events for an entire week. This view lets you 
quickly review your appointments and available time slots. In addition, the graphical 
display helps you spot overlaps and conflicts in your schedule.

To work on the Week view:
1 Do one of the following to display the Week view:

• Tap the Week view icon. 
• Press the Date Book button until the Week view appears. 

Alarm Sound Tap the pick list to set the tone of the alarm. Options include 
Alarm, Alert, Bird, Concert, Phone, Sci-fi, and Wake Up.

Remind Me Tap the pick list to define how many times the alarm sounds—
once or twice; or three, five, or ten times.

Play Every Tap the pick list to define how often the alarm sounds—every 
minute; or every 5, 10, or 30 minutes.

Date Book view 
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2 Tap the left and right navigation controls to move forward or backward a week at a 
time, or tap on a specific day to display the details of an event. 

NOTE: The Week View also shows untimed events and events before and after the range of 
times displayed.

3 Tap an event to display a description of the event at the top of the screen.

Tips for using Week view
Keep the following points in mind when using Week view: 

• To reschedule an event while in Week view, tap and drag the event to a 
different time or day.

• Tap a blank time on any day to move to that day and have the time selected 
for a new event. 

• Tap any day or date that appears at the top of the Week view to move 
directly to that day without selecting an event.

Week view icon

Previous 
week

Next 
week

Bar indicates earlier event.

Bar indicates later event. 

Dot indicates untimed event.

Event details

Tap to show event details.
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• The Week view displays the time span defined by the Start Time and End 
Time in the Date Book Preferences settings. If you have an event before or 
after this time span, a bar appears at the top or bottom of that day's column. 
Use the onscreen scroll arrows to scroll to the event.

Spotting event conflicts
With the ability to define specific start and end times for any event, it is possible to 
schedule events that overlap (an event that starts before a previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping time bars 
and in the Day view as overlapping brackets to the left of the conflicting times.

Working in Month view
The Month View screen shows which days have events scheduled. Dots and lines in the 
Month view indicate events, repeating events, and untimed events.

To display the Month view:
Do one of the following:

• Tap the Month view icon.
• Press the Date Book button until the month view appears. 

You can control the dots and lines that appear in the Month View. See "Display 
options" on page 81 for more information.

Event 
conflicts

Previous/next month

Dots on right side indicate events.

Dashed line indicates continuous 

Dots below date indicate untimed 

Month View icon
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Tips for using Month view
Keep the following points in mind when using the Month view: 

• Tap a day in the Month view to display that day in the Day view.
• Tap the scroll arrows in the upper right corner to move forward or backward 

a month. 
• Tap Go To to open the date selector and select a different month.
• Use the scroll buttons on the front panel of your Acer s10 to move between 

months. Press the top button to display the previous month, the bottom 
button to display the next month. 

Working in Agenda view
The Agenda view lets you view appointments, untimed events, and To Do List items in 
a single screen. Although it is primarily a viewing option, you can also use the Agenda 
view to check off completed To Do List items. To go to a Day View of any event on the 
Agenda view screen, simply tap the desired event. 

To work on the Agenda View:
1 Do one of the following to display the Agenda view: 

• Tap the Agenda view icon.
• Press the Date Book button until the Agenda view appears. 

2 Tap the navigation bars to move forward or backward a day at a time or to display 
more events and To Do items.

Tips for using Agenda view
• Tap any appointment while in Agenda view to display the Day View of the 

appointment. 
• Check off completed To Do List items in the Agenda view, or click a 

description of an item to go directly into the To Do List application. 

Agenda view icon

Scroll the list 
for each view
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• You can change the category of To Do items shown. Tap the pick list and 
select the new category. For more information on To Do items, refer to 
"Using To Do List" on page 91.

Changing the displayed Start and End Times

To change the start and end time in the Date Book:
1 Do one of the following to display the Preferences dialog box: 

• In Date Book, tap the Menu icon , open the Options menu, and then tap 
Preferences.

• Tap the inverted application title tab at the top of the Date Book screen to 
display the menu bar, select Options, then tap Preferences.

• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar. Draw an R, the Graffiti shortcut for 
the Preferences command. 

The Start and End Time are used by the various Date Book screens. The Day view 
schedules events to start and end at these times when the All Day option is selected. 
The Week view displays the time span defined by the Start Time and End Time.

2 Tap Start Time and use the scroll arrows to select a new start time for the Date Book 
screens. 

3 Tap End Time and use the scroll arrows to select a new end time for the Date Book 
screens. 

NOTE: If the selected time slots for the Start and End time do not fit on one screen, you can 
tap the scroll arrows to scroll up and down.

4 Tap OK.

Date Book menus
Date Book menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Date Book has three menus: Record, Edit and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 
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Record menu

Edit menu 

Options menu 
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Display options In Day or Month view, you can change which events appear in 
the Date Book. In Day view, you can display time bars that 
highlight event conflicts. 

In Day view:

• Show Time Bars. Tap to display time bars showing 
the duration of an event and any event conflicts.

• Compress Day View. Tap to display start and end 
times for each event with the blank time slots on the 
bottom of the screen absent to minimize scrolling. 
Clear the option to display all time slots.

In Month view:

Select whether to display Timed, Untimed, or Daily Repeating 
events. You can activate any or all of these options. 

About Date Book Shows version information for Date Book.
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Using Address Book
Address Book lets you keep names, addresses, phone numbers, and other information 
about your personal and business contacts.

Creating an Address Book entry
A record in Address Book is called an entry. You can create entries on your Acer s10 or 
you can use your Palm Desktop software to create entries on your computer and then 
download them to your Acer s10 during your next HotSync operation.

Palm Desktop software also has data import capabilities that allow you load database 
files into the Address Book on your Acer s10. 

See "Importing data" on page 33 and the Palm Desktop online Help for more 
information.

To create a new Address Book entry:
1 Press the Address Book button on the front panel of your Acer s10 to display the 

Address List.

2 Tap New

3 Enter the last name of the person you want to add to your Address Book. 

NOTE: Acer s10 automatically capitalizes the first letter of each field (except numeric and 
email fields). 

4 Tap the First Name field to move to it. 

TIP: You can also use the Graffiti Next Field Stroke to move to the next field. 

5 Enter the individual’s first name in the First Name field.

6 If you want to be able to sort the Address Book by company name, enter the 
information you want in the Company field. 

7 Enter any other information that you want to include in the entry.

Tap New.

Cursor 
at Last 
name
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NOTE: As you enter letters in the Title, Company, City and State fields, text appears for the 
first logical match that exists in your Address Book. As you enter more letters, a closer match 
appears. As soon as the word appears, tap in the next field to accept the word. 

8 Tap the scroll arrows to move to the next page of information.

9 To attach a note to an entry, tap Note. Enter the information you want in the Graffiti 
writing area, and then tap Done.

10 When you have finished entering information, tap Done.

TIP: To create an entry that always appears at the top of the Address List, begin the Last 
name or Company field with a symbol, as in *If Found Call.* This entry can contain contact 
information in case you lose your Acer s10.

To view details of an address entry:
1 Tap the address entry in Address List view. The entry appears in Address view.

2 Tap Done when you have finished viewing the entry.

Tap Done.
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Selecting different types of phone numbers and addresses
You can select the types of phone numbers or email addresses that an Address Book 
entry displays. Any changes you make apply only to the current entry. 

To select other types of phone numbers in an entry:
1 Tap the entry that you want to change in the Address list. 

2 Tap Edit.

3 Tap the pick list next to the label you want to change.

4 Select a new label.

Duplicating an entry
You can duplicate existing entries, which can be helpful when you want to enter 
multiple people from a single organization. When you duplicate an entry, the word 
Copy appears next to the name in the First Name field. 

To duplicate an entry:
1 From the Address Book, tap a name you want to duplicate.

2 Do one of the following:

• Tap the Address Edit tab at the top of the screen; then tap Duplicate Record 
in the Record menu. 

• In the Graffiti text area of your device’s screen, drag a diagonal line from the 
lower left to upper right to display the Command toolbar; then write a T in 
the Graffiti text area to initiate the Duplicate Record command.

3 Edit the record as necessary. 

Editing Address Book entries
You can change the type of information that appears in the Address List screen, 
categorize an entry, and hide an entry for security reasons. You can also delete 
entries. 

Tap 
pick list.
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To edit an Address Book entry:
1 Tap the entry that you want to change in the Address list.

2 Tap Edit.

3 Tap Details.

4 In the Address Entry Details dialog box, select any of the following settings:

You can also use the Delete and Note buttons. 

• Delete. Tap to delete the entry.
• Note. Let you create a note. Tap the button, then enter information in the 

Graffiti writing area, and tap OK. 
5 Tap OK.

Changing the Address Book display
You can change how Address Book lists are sorted by using Preferences.

To change how lists are sorted:
1 To open the Preferences dialog box, do one of the following: 

• In Address Book, tap the Menu icon , open the Options menu, and then tap 
Preferences.

• Tap the inverted application title tab at the top of the Address Book screen to 
display the menu bar, select Options, then tap Preferences.

Show in List Let you select which type of phone or other information to 
appear in the Address List screen. Options include Work, Home, 
Fax, Other, E-mail, Main, Pager and Mobile. The Identifying 
letters W, H, F, O, M or P appear next to the record on which 
information is displayes. (There is no identifying letter when E-
mail is selected.)

Category Let you select a category to which you want to assign the entry.

Private Let you hide the entry when Security is turned on.
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• In the text Graffiti area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar. Draw an R, the Graffiti shortcut for 
the Preferences command.

The Preferences screen appears.

2 Choose an option to sort Address Book lists from the List By pick list:

3 Tap OK.

Address Book menus
Address Book menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Address Book has three menus: Record, Edit and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Last Name, First Name Address Book list is sorted alphabetically by an 
individual’s last name and then first name.

Company, Last Name Address Book list is sorted by the company name, and 
then an individual’s last name.
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Record menu
The Record menu differs depending on whether you’re displaying the menu bar from 
the Address list or from the Address View screen. 

Address list Address View 

Dial Initiates dialing of an infrared-equipped mobile phone by 
sending the telephone number through the IR port of your 
Acer s10 to the phone.



Working with your basic applications
Using Address Book

 89

Edit menu

Options menu
The Options menu differs depending on whether you’re displaying the menu bar from 
the Address list or from the Address View screen.

Address list 
Address View 
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Preferences

• Remember Last Category. Determines how Address 
Book appears when you return to it from another 
application. If you check on the box, Address Book 
shows the last category you selected. If you clear it, 
Address Book displays the All category.

• Enable Tap Dialing. Allow automatic dialing by 
tapping a telephone number in Address Book. You must 
have an infrared-equipped mobile phone near your 
Acer s10 to use this feature. 

Rename Custom 
Fields

These custom fields appear at the end of the Address Edit screen. 
Rename them to identify the kind of information you enter in 
them. Names of these custom fields appear in all entries. 

About Address 
Book

Shows version information for Address Book.
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Using To Do List
To Do List is a convenient place to create reminders and prioritize the things that you 
have to do. 

Creating To Do List items
A To Do List item is a reminder of some task that you have to complete. A record in 
the To Do List is called an item.

To create a To Do List item:
1 Press the To Do List button on the front panel of your Acer s10 to display the To Do 

List.

2 Tap New.

3 Enter the text of the To Do List item. The text can be longer than one line.

TIP: If no To Do List item is currently selected, writing in the Graffiti writing area 
automatically creates a new item.

4 Tap anywhere onscreen to deselect the To Do List item.

TIP: You can add a name, address, and phone number to a To Do List item using the Phone 
Lookup option. For more information, refer to "Using Phone Lookup" on page 60.

Setting To Do List priorities
You can set priorities for tasks in your To Do List according to their importance or 
urgency. By default, items are arranged by priority and due date; on top of the list are 
priority 1 (most important) items. Changing an item’s priority may move its position in 
the list. 

New To Do List items automatically have a priority level of 1. If you select another item 
first, before creating a new item, the item you create appears beneath the selected 
item with the same priority as the selected item. 

Tap New.

New To Do 
item



Working with your basic applications
Using To Do List

92   

To set the priority of a To Do List item:
1 If priorities aren’t visible in the To Do List, tap the Show button at the bottom of the 

screen, tap Show Priorities, and tap OK.

2 Tap the Priority number on the left side of the To Do List item. The drop-down column 
of priority levels appears.

3 Tap the Priority number that you want to set for the item, with 1 as the most 
important and 5 as the least important. 

Checking off a To Do List item 
You can check off a To Do List item to indicate that you’ve completed it. 

To check off a To Do List item:
Tap the check box on the left side of the item. The check mark indicates that the item 
has been completed already.

To remove a completed To Do List item:
1 On the bottom of the To Do List screen, tap the Show button. 

2 Tap Show Completed Items. Your completed To Do items disappear from the list. 

Tap to select 
priority.

Tap here.

Completed To Do List item
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NOTE: Items that no longer appear on the list because Show Completed Items is turned off 
have not been deleted. They are still in the memory of your Acer s10. You must purge 
completed items to remove them from memory. Refer to "Purging records" on page 56 for 
more information.

Changing To Do List items details
You can change the details of a To Do List item including the priority level, the item 
category, the assigned due date, and the security status. 

To change the To Do List item details: 
1 In the To Do List, tap the item that you want to change.

2 Tap Details. The To Do Item Details screen appears.
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3 Choose from the folIowing options: 

You can also use the Delete and Note buttons. 

• Delete. Tap to delete the item.
• Note. Let you create a note. Tap the button, then enter information in the 

Graffiti writing area, and tap OK. 
4 Tap OK.

TIP: If you turn on the Show Due Dates option in the To Do Preferences dialog box, you can 
tap directly on the due date in the To Do List to open the pick list shown in step 3.

Sorting To Do items
After setting the item’s option details, you can then sort To Do List items by priority, 
due date, or category.

To sort To Do List items:
1 Tap the Show button on the bottom of the To Do List screen. The To Do Preferences 

screen appears. 

2 Tap Sort by. 

Priority Tap the Priority number that you want to set for the item, 
with 1 as the most important and 5 as the least important.

Category Tap the pick list to select a category for the item. 

Due Date Tap No Date to open the Due Date pick list.

Tap the date that you want to assign the item. Options 
include: 

• Today. Assigns the current date.
• Tomorrow. Assigns tomorrow’s date.
• One Week Later. Assigns the date exactly one week 

from the current date.
• No Date. Removes the due date from the item.
• Choose Date. Displays the date selector from where 

you can select a particular due date for the item. 

Private Tap Private to hide this item when Security is turned on.
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3 Select an option from the Sort by pick list:

4 Tap OK.

Displaying completed and due items
You can have the To Do List display completed items and their completion dates, as 
well as due items and their due dates. 

To display completed and due items in the To Do List:
1 In the To Do List, tap the Show button. The To Do Preferences screen appears.

Tap here.

Priority, Due Date Sort items by priority first, and then due date.

Due Date, Priority Sort items by due date first, and then priority

Category, Priority Sort items by category first, and then priority

Priority, Category Sort items by priority first, and then category.



Working with your basic applications
Using To Do List

96   

2 In the To Do Preferences screen, tap any of the following settings to activate it. 

3 Tap OK.

To Do List menus
To Do List menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

To Do List has three menus: Record, Edit and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Show Completed Items Displays completed items in the To Do List. If this 
setting is turned off, completed To Do items 
disappear from the list, but are kept in the 
memory of your Acer s10. You must purge 
completed items to remove them from memory.

Show Only Due Items Displays only the items that are currently due, past 
due, or have no due date specified. When this 
setting is active, items that are not yet due do not 
appear in the list until their due date.

Record Completion Date Replaces the due date with the actual date when 
you complete (check) the item. If you do not 
assign a due date to an item, the completion date 
still appears when you complete the item.

Show Due Date Displays the due dates for items in the To Do List 
and displays an exclamation mark next to items 
that remain incomplete after the due date passes.

Show Priorities Displays the priority setting for each item.

Show Categories Displays the category for each item. 
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Record menu

Edit menu

Options menu

About To Do List Shows version information for To Do List.
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Using Memo Pad
Memo Pad provides a place to take notes that are not associated with records in the 
Date Book, Address Book, or To Do List.

Creating memos
A record in the Memo Pad is called a memo. A memo can contain up to 4,000 
characters. The number of memos you can store is limited only by the memory 
available on your Acer s10.

NOTE: Your Acer s10 has an internal memory capacity of 16 MB. 

When you create a new memo, you can add information to it from the Address Book 
application, such as a phone number or address, using the Phone Lookup option. 
Refer to "Using Phone Lookup" on page 60. 

To create a new memo:
1 Press the Memo Pad button on the front panel of your Acer s10 to display the Memo 

list

2 Tap New.

TIP: You can also create a new memo by beginning to write in the Graffiti writing area in 
the Memo List screen. The first letter is automatically capitalized and begins your new memo. 

3 Enter the text you want to appear in the memo. Use the Graffiti carriage return stroke 
to move down to new lines in the memo.

4 Tap Done. 

NOTE: You can categorize memos. See "Categorizing records" on page 56. 

Tap New.
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Reviewing memos
The Memo list displays the first line of a memo. This makes it easy to locate and review 
your memos. 

To review a memo:
1 In the Memo List, tap the text of the memo.

2 Review or edit the text in the memo. 

3 Tap Done.

Changing the order in which memos appear in the Memo 
list
You can use Memo Pad Preferences menu to change the the order memos appear in 
the Memo list. 

To set the sorting mode for Memo list

1 Tap the Menu icon . 

2 Tap Preferences. 

3 Tap one of the following options:

4 Tap OK.

Tap a 
memo to 
review its 
contents

Manual Sort new memos in the sequence in which you create 
them.

Alphabetical Sort new and existing memos in numerical and then 
alphabetical sequence.
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Memo Pad menus
Memo Pad menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Memo Pad has three menus: Record, Edit and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Record menus
The Record menu differs depending on whether you’re displaying the menu bar from 
the Memo list or from an open memo. 

Memo list
Open memo 
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Edit menu

Options menus
The Options menu differs depending on whether you’re displaying the menu bar from 
the Memo list or from an open memo.

Memo list
Open memo 

About Memo Pad Shows version information for Memo Pad.



Working with your basic applications
Using Calculator

 103

Using Calculator
The Calculator lets you perform general mathematical functions, such as addition, 
subtraction, multiplication, division, and square root operation. 

Using the Calculator buttons
The Calculator includes several buttons to help you perform calculations.

Displaying recent calculations
The Recent Calculations command lets you review the last series of calculations and 
helps you confirm a chain of calculations.

To display recent calculations:

1 Tap the Menu icon . The Calculator menu bar appears. 

Clears the entire calculation and enables you to begin a 
fresh calculation.

Clears the last number you entered. Tap this button if you 
make a mistake while entering a number in the middle of a 
calculation. This button enables you to re-enter the number 
without starting the calculation over.

Places the current number in memory. Each new number 
you enter with the M+ button is added to the total stored 
in memory. The number that you add can be either a 
calculated value or any number you enter by pressing the 
number buttons. Tapping this button has no effect on the 
current calculation (or series of calculations); it merely 
places the value into memory until it is recalled.

Recalls the total stored value from memory and inserts it in 
the current calculation.

Clears any value that is stored in the Calculator memory.

Calculates the square root of a number. Enter a number 
then tap this button. 

Toggles the current number between a negative and 
positive value. If you want to enter a negative number, 
enter the number first and then tap the +/- button.
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Illustration suggestion (Delete this suggestion when completed): Calculator 
menu bar 

2 Tap Options. 

Illustration suggestion (Delete this suggestion when completed): Options
with drop-down window

3 Tap Recent Calculations.

Illustration suggestion (Delete this suggestion when completed): Show
Recent Calculations screen.

4 When you have finished reviewing the calculations, tap OK.

Calculator menus
Calculator menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Calculator has two menus: Edit and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Edit menu

Illustration suggestion (Delete this suggestion when completed): Edit
menu drop-down window

Options menu

Illustration suggestion (Delete this suggestion when completed): Options
menu drop-down window

About Calculator Shows version information for Calculator.
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Using Expense
Expense lets you record the date, expense type, and the amount you spent; and then 
transfer that information to a spreadsheet on your computer.

Creating an Expense item
A record in the Expense application is called an item. You can sort Expense items into 
categories or add other information to an item.

To create an Expense item

1 Tap the Expense icon  to display the Expense list screeen.

2 Tap New. 

TIP: You can also create a new Expense item in the Expense List screen by writing on the 
number side of the Graffiti writing area. The first number you write begins your new Expense 
item.

3 Enter the amount of the expense. 

4 Tap the Expense type to choose a type from the drop-down list.

Cursor of 
new item

Tap here.

Tap here.
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NOTE: As soon as you choose an Expense type, Acer s10 saves your entry. If you do not 
select an Expense type, it does not save the entry.

TIP: Another quick way to create a new Expense item is to make sure that nothing is 
selected in the Expense List. Then write the first letter or letters of the Expense type to fill it 
in automatically, and then write the numerical amount of the Expense item. 

Changing the date of an Expense item
Initially, Expense items appear with the date you enter them. You have the option to 
change this initial date. 

To change the date of an Expense item:
1 Tap the Expense item you want to change.

2 Tap the date of the selected item to display the date selector. 

3 Tap the new date.

Entering receipt details
You can add detailed information to an Expense item using the Receipt Details dialog 
box.

To enter receipt details in the Receipt Details dialog box:
1 Tap the Expense item to which you want to add information. 

2 Tap Details to display the Receipt Details dialog box.

Tap date.
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3 Choose from any of the following options: 

You can also use the Delete and Note buttons. 

• Delete. Tap to delete the item.
• Note. Let you create a note. Tap the button, then enter information in the 

Graffiti writing area and then tap OK.
4 Tap OK to add the information to the Expense record.

Category Tap the pick list to select the category for the Expense item. 
Tap Edit Categories to rename or delete an existing category. 
You can also choose to create a new category. 

Type Tap the pick list to select the expense type for the expense 
item
Options include Airfare, Breakfast, Bus, Business Meals, Car 
Rental, Dinner, Entertainment, Fax, Gas, Gifts, Hotel, 
Incidentals, Laundry, Limo, Lodging, Lunch, Mileage, Other, 
Parking, Postage, Snack, Subway, Supplies, Taxi, Telephone, 
Tips, Tolls and Train.

TIP: You can fill in the expense type automatically. 

Payment Tap the pick list to select the payment method for the 
expense item.
Options include American Express, Cash, Check, Credit Card, 
MasterCard, Prepaid, VISA, and Unfiled. 
If the item is prepaid (such as airline tickets supplied by your 
company), you can choose Prepaid to place your expense in 
the appropriate company-paid cell of your printed expense 
report spreadsheet.

Currency Tap the pick list to select the currency unit for the payment of 
the expense item.
The default currency unit and the currencies that appear in 
this list are defined in the Preferences dialog box. You can 
customize this list. 

Vendor Enter the name of the vendor (usually a company) associated 
with the expense item. 

City Enter the name the city where the expense was incurred.
For example, a business lunch might be at Rosie’s Cafe 
(Vendor) in San Francisco (City)

Attendees Tap Who to add individual names associated with the Expense 
item. Refer to "To add attendees’ names to an Expense item" 
on page 109 for more information. 
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Adding attendees’ names to an Expense item
You have the option to add the names of individuals associated with an expense 
incurred. 

To add attendees’ names to an Expense item
1 Tap the Expense item to which you want to add information. 

2 Tap Details to display the Receipt Details dialog box.

3 Tap Who to display the Attendees screen.

4 Do one of the following in the Attendees screen:

• In the Graffiti writing area, enter the names of individuals associated with an 
expense incurred. 

• Tap Lookup to display all Address Book names that contain an entry in the 
Company field of the Address Book record. Select the name you want to add, 
and tap Add to add the name to the Attendees screen; repeat the step to add 
more names. 

5 Tap Done.

Filling in the expense type automatically
You can select an expense type merely by writing the first letter or letters of an 
expense type in the Graffiti writing area. For example, writing the letter T enters the 
Taxi expense type. Writing T and then e enters Telephone, which is the first expense 
type beginning with the letters Te.

To fill in the expense type automatically:

1 Tap the Menu icon  to display the Expense menu bar.

2 Tap Options. 

Tap here
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3 Tap Preferences to display the Preferences dialog box.

4 Tap the Use Automatic Fill When Entering Data check box to select the option. 

5 Tap OK.

Changing the Expense List display
You can change the display of expenses, including their sort order, the mileage unit, 
and the currency symbol, using the Show Options dialog box. 

To change the Expense List display: 
1 In the Expense list, tap Show to display the Show Options dialog box.

2 Choose from the any of the following options: 

3 Tap OK.

Changing the currency and symbols display
You can change the currencies and symbols available in the Currency pick list. You can 
also change the default currency that appears when you create a new expense item.

To change the currencies displayed in the Currency pick list: 
1 In the Receipt Details dialog box, tap the Currency pick list. 

Tap Show

Sort by Allows you to set how expense items are sorted. Options 
include Date and Type. 

Distance Allows you to set the distance unit for the Mileage entries. 
Options include Miles and Kilometers. 

Show Currency Allows you to either display or hide the currency symbol in the 
Expense list. Tap the check box to activate this feature. 
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2 Tap Edit Currencies to display the Select Currencies screen.

3 Tap the Currency pick list and select the country whose currency you want to display 
on that line. You can specify up to five currencies. 

4 Tap OK to close the Select Currencies dialog box.

5 Tap OK.

To change the default currency symbol for all Expense items: 

1 Tap the Menu icon  to display the Expense menu bar.

2 Tap Options. 

3 Tap Preferences. to display the Preferences dialog box.

4 Tap the Default Currency pick list to display the currency options. 

5 Tap a currency symbol to select it as the default.

6 Tap OK. The symbol you selected appears with all new Expense items. Existing items 
are not affected. 

NOTE: To use a currency symbol only for a selected Expense item, select the symbol in the 
item’s Receipt Details dialog box. 

Customizing currency symbols
If the currency you want to use is not in the list of countries, you can create your own 
custom currency symbol and add it to the Currency pick list. 

To define a custom currency symbol:

1 Tap the Menu icon  to display the Expense menu bar.

2 Tap Options. 

3 Tap Custom Currencies to display the Custom Currencies dialog box.

4 In the Custom Currencies dialog box, tap one of the four Country boxes to display the 
Currency Properties dialog box. 

Tap Edit 
currencies.
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.

5 In the Currency Properties dialog box, enter the country name and currency symbol 
that you want to appear in the Expense application.

6 Tap OK to close the Currency Properties dialog box.

7 Tap OK.

NOTE: You can use your custom currency symbol as the default currency symbol. See “To 
change the default currency symbol for all Expense items

Transferring your data to Microsoft Excel
Once you have entered expenses in the Expense application on your Acer s10, Palm 
Desktop software lets you view and print the data with your computer. 

NOTE: You must have Microsoft Excel version 5.0 or later to view and print your Expense 
data using one of the provided templates. Microsoft Excel is not included with the Acer s10 
handhel package. The procedures in this section assume that you have installed the Palm 
Desktop software. Refer to ‘To install the Palm Desktop software’ on page 11 for more 
information.

Displaying the euro symbol on your computer
When you perform a HotSync operation, the euro symbol is transferred to your 
computer application like any other piece of data on your Acer s10. The symbol 
appears in your computer application, however, only if you are using fonts that 
support the euro symbol.

These fonts are part of the operating system of your computer. They do not reside on 
your computer application, and they are not produced by Acer Inc. Refer to the 
documentation that accompanies your computer’s operating system for more 
information.

Tap a Country 
box.



Working with your basic applications
Using Expense

 113

Printing the euro symbol
Even with operating system support, problems may arise while printing documents 
that contain the euro symbol. When a font is present on both the printer and the 
computer, the printer font is used by default to increase printing speed. If the printer 
font does not include the euro symbol, a box is printed out instead of it. You can work 
around this problem by sending a bitmap image of the euro to the printer or by not 
using the printer’s built-in fonts (if allowed).

Creating and printing an expense report
Palm Desktop software makes it quick and easy to view and print your Expense data in 
a Microsoft Excel spreadsheet. 

To create or print an expense report:
1 Perform a HotSync operation to transfer your latest Expense data to your computer. 

2 Click the Expense application in Palm Desktop software to open Microsoft Excel and 
the Expense Report configuration dialog box.

NOTE: If you launch the Expense application from the Start menu instead of from Palm 
Desktop software, you must first choose your Acer s10’s user name.

3 Select the expense category using one of the following techniques:

• Click an expense category. 
• Press Ctrl+click to select multiple categories. 
• Select All in the Categories group to print the expenses associated with all of 

your Expense categories.

4 Specify a time period to print:

• Enter a date in the End Date field to define an end date for the expense 
report.

• Do not enter a date in the End Date field to specify, all expense entries for 
the selected categories—up to the date of the last HotSync operation.

5 Print or display the expense information, choosing one of the following options:

• Click Print to display the expense report in the Print Preview window, and 
then click Print in the Microsoft Excel window to print your expense report.

• Click Create to display a Microsoft Excel spreadsheet containing your expense 
data. Your data appears in Microsoft Excel spreadsheet form. You can enter 

Click to select categories.
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information, make formatting changes, and save and print the file in the 
normal manner.

Using expense report templates
Palm Desktop software includes several Expense report templates. When you use one 
of these templates, you can edit your expense data in Microsoft Excel. 

The templates have the extension .xlt and are stored in the template folder in the 
Palm Desktop directory on your computer. To see what a template looks like before 
you use it, open the template in Microsoft Excel. For example, the template 
Sample2.xlt looks like this:

To view your expense data using a Microsoft Excel template:
1 Display your expense data in a Microsoft Excel spreadsheet as described in the 

previous procedure.
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2 Click Options to display the Expense Report Options dialog box. 

3 Enter the name, department, and other information as necessary for your expense 
report.

4 Click the Templates menu. 

5 Select an expense template. 

NOTE: You can create your custom expense template and have it included in the Templates 
menu. Refer to "Customizing existing sample templates" on page 308 for more information. 

6 Click OK.

Expense menus
Expense menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Expense has three menus: Record, Edit and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Choose expense 
template.

Enter report name 
and 
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Record menu

Edit menu

Options menu
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5 Working with your 
supplementary applications

Your Acer s10 includes several supplementary applications that provide innovative 
features to make your handheld a functional everyday companion: 

• Clock
• AudioBox
• Recorder
• eBook Reader
• Backup
• Service Launcher

This chapter is organized into two sections, namely: 

• Overview of supplementary applications
• Using your supplementary applications

Overview of supplementary applications 
This section will give you a brief description of each supplementary application and 
explains how to open it.

Clock
The three-in-one function mode of Clock serves a variety of purposes to suit the 
individual lifestyle of today’s busy professional. For the office executive, it is a smart 
desktop clock, a travel clock for the global entrepreneur and for the athletes, a handy 
stopwatch. 

BottomLine: With Clock in your Acer s10, you can seamlessly manage your time 
across both your business and personal activities.

You can do the following in Clock:
• View the current date and time in your local area.
• View the current date and time in two preselected cities.
• Set alarm reminders for your business and personal schedules. 
• Monitor time-critical activities, such as a sports competition or a time-

balancing study.
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To launch Clock:

• In the Main screen of Applications Launcher, Tap the Clock icon . 
By default, Clock opens in City Clock mode. 

AudioBox
AudioBox, Acer s10’s built-in MP3 player, allows you to play your favorite .mp3 files 
saved in a resident Memory Stick. 

The smartly-designed user interface of AudioBox provides all the standard functions 
of a dedicated .mp3 player built into your Acer s10. 

BottomLine: Combining serious business and musical pleasure need not require a 
bunch of gadgets anymore — only your Acer s10.

You can do the following in AudioBox: 
• Instantly play your favorite .mp3 files.
• Set a play mode for the playback of your favorite tracks. 

To launch AudioBox:
1 Insert a Memory Stick containing an .mp3 file into the Memory Stick slot of your 

Acer s10. 

Refer “To insert a Memory Stick” on page 217 for instructions.
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2 In the Utilities screen of Applications Launcher, tap the AudioBox icon . 
The AudioBox main screen appears.

When the AudioBox icon is tapped and no Memory Stick is detected, a warning 
message pops up.

Tap OK to close the application; insert a Memory Stick containing an .mp3 file then 
repeat step 2. 

When a Memory Stick is detected but no .mp3 file is detected, a warning message 
pops up. 

Tap OK to close the application; insert a Memory Stick containing an .mp3 file then 
repeat step 2.
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Recorder
Recorder allows you to conveniently record audio files whenever and wherever you 
need to and store it either in your Acer s10’s internal memory (.pdb format) or in a 
Memory Stick (.mp3 format). This function is especially useful when you need to 
record notes but jotting them down is not as efficient as in the case of large number 
figures or highly-detailed procedures. 

BottomLine: Scrawling all those figures and instructions during meetings prevents 
you from being part of the meeting. With Recorder, you can focus on what is being 
discuss without worrying if you have that decimal point on figure 4 correct. 

You can do the following in Recorder: 
• Record audio files and store it either in your Acer s10’s internal memory 

(.pdb format) or in a Memory Stick (.mp3 format). 
• Playback your Recorder audio files for reference or for leisure purpose. 

To launch Recorder:
Do one of the following. 

• Press the Recorder Hot Button on the upper-left side of your Acer s10. 
This will automatically activate the Record function and display the Recording 
status screen. 
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• In the Utilities screen of Applications Launcher,tap the Recorder icon  
This will open the Recorder main screen. 

NOTE: Launching Recorder by tapping the Recorder icon on the Utilities screen will disable 
the Hot Button function.

eBook Reader
eBook Reader allows you to read your eBooks (Acer eBook format) with a few quick 
taps in your Acer s10. eBooks can either be stored in your Acer s10’s internal memory 
or in a Memory Stick. 

Use eBook Converter to convert regular document files into Acer eBook format. See 
"Using eBook Converter" on page 203 for more information. 

BottomLine: With eBook Reader, a quick review for a business presentation or a 
leisurely browsing of a favorite literary piece can easily be done with a few quick taps 
on your Acer s10. 

You can do the following in eBook Reader: 
• Read your eBooks whenever and wherever you need them.
• Use bookmarks, internal hyperlinks and the Jump To feature to easily 

navigate through your eBooks. 
• Select a font style in viewing your eBooks.
• Assign eBooks to categories so that you can organize and view them in 

logical groups.

To launch eBook Reader:
1 If your eBook is stored in a Memory Stick, first insert the card into your Acer s10’s 

Memory Stick slot.

Refer to “To insert a Memory Stick” on page 217 for instructions. 
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2 In the Utilities screen of Applications Launcher, tap the eBook Reader icon . 
The Book Manager screens appears.

Book Manager lists the filenames of the available eBooks.

 indicates that the eBook is stored in your Acer s10’s internal memory.

 indicates that the eBook is stored in the resident Memory Stick. 

NOTE: The first time you successfully open the Book Manager, it will highlight the first 
eBook in your file list. Afterwards, it will highlight the last eBook you opened. 

When the eBook Reader icon is tapped but no eBook file is detected, either on the 
Acer s10’s internal memory or on a resident Memory Stick, a warning message pops 
up. 

Tap OK to close the application. 

Do one of the following before attempting to use eBook Reader again.

• Perform a HotSync operation to install an eBook file from your computer to 
your Acer s10. 
See page 253 for more information on HotSync operations.
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• Insert a Memory Stick containing an eBook file(s) into your Acer s10’s 
Memory Stick slot. 
Refer to “To insert a Memory Stick” on page 217 for instructions. 

Every time you launch the eBook Reader and a Memory Stick with no eBook 
directory is detected, the dialog box below appears.

Tap OK. 

Backup
Backup enables you to back up data files and applications in your Acer s10’s internal 
memory to a Memory Stick and to restore data to your handheld. 

With Backup, you can manage the contents of your Acer s10’s internal memory based 
on your current space requirements. 

BottomLine: Backup sets to match your Acer s10’s memory capacity to your 
individual requirements.

You can do the following in Backup: 
• Create backup files of data and applications stored in your Acer s10’s internal 

memory.
• Restore backup data from a Memory Stick back to your Acer s10’s internal 

memory.

To launch Backup:
1 Insert a Memory Stick into the Memory Stick slot of your Acer s10. 

Refer “To insert a Memory Stick” on page 217 for instructions.
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2 In the Utilities screen of Applications Launcher, tap the Backup icon . 
The Backup main screen appears.

Service Launcher
Service Launcher allows you to easily activate dedicated Personal Service applications 
available in your Acer s10. 

BottomLine: Getting wired and connected, fast and easy, to today’s mobile 
information world is what the Service Launcher is all about. 

You can do the following in Service Launcher: 
• Launch dedicated Personal Service applications available in the Service 

category of Applications Launcher.
• Define which dedicated Personal Service application to launch when the 

Service icon  on the upper-left corner of the Graffiti area is tapped. 
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To launch Service Launcher:
Do one of the following: 

• Tap the Service icon  on the upper-right corner of the Graffiti writing area. 

• In the Main screen of Applications Launcher, tap the Service icon . 
The Personal Service screen appears. 
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Using Clock 
Clock makes it easy for you to check date and time as well as set alarm reminders of 
your schedule. It aslo serves as a handy timer for time-critical activities.

Clock modes
Clock operates in three modes: City Clock, Big Clock and Timer, each one designed to 
suit a particular activity in your daily schedule. 

To switch between Clock modes:
1 On the active Clock screen, tap the mode pick list on the upper-right corner to display 

the mode options.
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2 Select a Clock mode. 

Clock shows the main screen of the selected mode. 

City Clock mode
The City Clock mode serves three main functions: local time display, time display for 
two preselected cities (default: New York and Tokyo) and an alarm setting.

Big Clock mode 
main screen

Timer mode
main screen

City Clock mode 
main screen (default mode)

Local time and 
date display

Time display for two 
preselected cities

Alarm setting
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Time display is in hh:mm:ss format. There are two display modes: 12H (AM/PM) which 
is the default mode and 24H. 

Date display for the local city is shown in mm/dd/yyyy format. The current weekday is 
also shown.

An active alarm icon  indicates that an alarm reminder has been previously set. 
Refer to "Alarm setting" on page 134 for more information.

Local time display
Time and date display for the local city is based on current system setting. 

Time display for selected cities 
The time display for two preselected cities is a useful function for the global 
entrepreneur whose business dealings require coordination with associates in other 
parts of the globe. Members of the globetrotting traveller will also find this City Clock 
feature quite handy in synchronizing their schedule to the local time of their 
destination city. 

By default, time display for New York and Tokyo is activated. You can select a different 
city to display, edit the details of a current city entry and add a new city to the current 
city list.

To change the preselected city display: 
1 Tap the city pick list to display the available city options. 

2 Tap the city you want to display the time for. 

NOTE: Ten city names per frame will be displayed. When DST (Daylight Saving Time) 
information is available for the selected city, the  symbol is activated on the City Clock 
main screen. 

Tap here.
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To edit details of a current city list entry:
1 Tap the city pick list to display the current city list. 

2 Select Edit Cities on the bottom of the city list to display the Edit Cities screen.

3 Tap the city entry you want to edit. 

4 Tap OK. The City Details screen appears.

5 Change the city details you want to edit. 

City Defines the city name. Maximum length is 16 alphanumeric 
letters or 8 Chinese characters (including blank spaces).

GMT Offset Defines the offset from GMT (Greenwich Mean Time) of the 
selected city. The first number frame represents the hour value 
from 1 to 12. The second number frame represents the minute 
value. Tap the individual frame then use the  control to set the 
values. Options include ‘00’, ‘15’, ‘30’ and ‘45’. 
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6 Tap OK on the City Details screen to apply the set city values. 

When OK is tapped but the City field remains blank, a warning message pops up. 

a. Tap OK on the warning window to revert to the City Details main screen. 

b. On the City Details main screen, enter a different name then tap OK.

DST Tap the check box to apply DST information (if available) to the 
selected city. 

DST Setting Defines the start and end points for the DST setting. 
1 Tap DST Setting to display the Set DST screen. 

2 Tap the pick lists to define DST values. Options include:

• Day order. Options include 1st (default), 2nd, 3rd, 4th and 
last.

• Day. Options include Sunday (default), Monday, ... 
Saturday

• Month. Options include January (default), February, ... 
December

3 Tap OK.
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c. Tap OK on the Edit Cities main screen.

Once changes are applied, the city list is automatically updated and sorted 
alphabetically. When the city name defined is already in the list, a warning message 
pops up. 

a. Tap OK on the warning window to revert to the City Details main screen. 

b. On the City Details main screen, enter a different name then tap OK.

c. Tap OK on the Edit Cities main screen.

To add a new city to the current city list:
1 Tap the city pick list to display the current city list. 

2 Select Edit Cities on the bottom of the city list to display the Edit Cities main screen.
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3 Tap New to display a blank City Details screen.

4 Define the detail settings for the new city entry. 

5 Tap OK on the City Details screen to set the details for the new city entry. 

6 Tap OK on the Edit Cities screen to add the new city to the current city list.

NOTE: Warning messages for leaving the City field blank and duplicating a name in the 
current city list in editing details for a current city entry also apply when creating a new city 
entry. 

To delete a city from the current city list:
1 Tap the city pick list to display the current city list. 

2 Select Edit Cities on the bottom of the city list to display the Edit Cities main screen. 

3 Tap the city entry you want to delete. 

4 Tap Delete to display the Delete City dialog box.

Tap here.

Tap here.
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5 Tap OK. 

If the city deleted is one of the two current preselected cities in the City Clock main 
screen, the deleted city will be replace by the local city defined in the system 
preferences settings. 

Alarm setting
City Clock enables you to set an alarm to remind your scheduled activities. 

To set an alarm: 

1 On the City Clock main screen, tap the Alarm icon  to display the Alarm Settings 
main screen. 

Tap here.
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2 Define the alarm settings as follows:

Alarm code Defines the alarm code. 
1 Tap the number frame to set the alarm code. You can set up 
to three alarm reminders at a time.
2 Tap the Active check box to enable it. 

Alarm time Defines when the alarm will be activated. 
1 Tap the number frame then use the  control to set the 
values. 
The first number frame represents the hour option from 1 
to 12. The second and third number frame represents the 
minute options. 

2 Select the AM/PM setting for the selected time. 
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Alarm volume Defines how loud the alarm sounds.
Tap the pick list to display the volume options which includes: 

• Off. Non-audible alarm; the LED indicator blinks to 
indicate that an alarm has been set off.

• Low
• Medium
• High 

Repeat Defines how often will the alarm be activated. 
Tap the pick list to display the repeat options which include:

• None. The alarm will only be activated once.
• Daily. The alarm will be activated everyday. 
• Weekly. The alarm will be activated once every week 

based on the preselected weekday.



Working with your supplementary applications
Using Clock

 137

3 Tap OK. 

Big Clock mode 
The large time display in Big Clock mode makes it the mode of choice for those who 
prefer the visual manner of displaying time. The three pointers—hours, minutes and 
seconds, functions just like a physical clock or watch.

Notes Enter a two-line description of the alarm reminder you set 
and have it appear on the Reminders page when the alarm 
is activated. 

NOTE:
Refer to "2 Entering data in your Acer s10" on page 23 on how 
to enter data on your Acer s10. 
Refer to "8 Using the Attention Manager" on page 223 on how 
to work on the Reminders page. 
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Timer mode 
In Timer mode, you can use your Acer s10 as a stopwatch to measure time span for 
time-critical events such as a sports competition, a time-balancing experiment (or even 
in timing that east-to-west overseas call to your loved ones. Mind that phone bill 
please!). Time display is shown in the hh:mm:ss format.

To work in Timer mode:

1 Tap  to start timing an event. The timer will start to count and the button will 

changed to . 

2 Tap  to stop the timer. The image will revert to .

3 Tap  to reset the timer to 0. 
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Clock menu 
The Clock menu shown here for your reference only. Features that are not explained 
in this section are discussed elsewhere in this Manual.

Clock has one only menu: Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

Options menu

Preferences

• Time format. Defines the time display format for 
City Clock mode. 
1 Tap the pick list to display the format options 
which include: 

– 12H (AM/PM) 
– 24H 

2 Tap OK.

About Clock Shows version information for Clock.
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Using AudioBox
AudioBox lets you to play your favorite .mp3 files saved in a Memory Stick. 

Using AudioBox functions
The AudioBox command interface is designed with your ease and convenience in 
mind. Enjoying your music time with your Acer s10 is now only a tap away.

Before launching the AudioBox:
• Insert a Memory Stick into your Acer s10’s Memory Stick slot. 

Refer “To insert a Memory Stick” on page 217 for instructions.

• Check that the audio files in your Memory Stick is in .mp3 format. 
You can listen to AudioBox tracks either through your Acer s10’s built-in speaker or 
through an earphone (included in the package contents) you connect to the earphone 
jack found on of your handheld. 

NOTE: You cannot use the both the earphone jack and the internal speaker at the same 
time. Using one will disable the other. 

Refer to page 4 for the location of your Acer s10’s earphone jack and to page 2 for the 
location of the internal speaker. 

To select a track to play:
1 On the AudioBox main screen, tap the Track pick list to display the available tracks in 

the resident Memory Stick. 

The track number and title are displayed on the list. 

Tap here



Working with your supplementary applications
Using AudioBox

142   

2 Tap a track title to select it for playback. 

The track information of the selected track will be displayed. This includes:

To play a selected track:
1 Select a track to play. Refer to the procedure in the preceeding section. 

2 Tap  to start playing the track. 

While in playback mode, image changes to  and the LED indicator flashes red.

During playback, tap: 

•  to pause playback. Image changes to . Tap again to resume playback.

•  to go back to the previous active track on the playlist. 

•  to skip the next active track on the playlist.

• Shuffle to play the tracks in random order. 
• Repeat to repeat playback of a selected track or the whole playlist. 

Refer to "Options menu" on page 147 for more information. 
• LCD off to turn off the LCD screen during playback. 

NOTE: When the LCD screen is off, the four application buttons and the Graffiti area are 
disabled. Tap anywhere on the AudioBox screen to turn the LCD screen back on. 

To set the LCD off settings:
To save battery consumption, it is advisable to turn off the LCD backlight during 
playback mode. Follow the steps below to set the LCD off settings: 

1 Do one of the following to display the Preferences dialog box : 

• Tap the Menu icon , open the Options menu, and then tap Preferences. 
• Tap the inverted application title tab at the top of the screen; then tap 

Preferences in the Options menu. 
• In the text Graffiti area, drag a diagonal line from the lower left to upper 

right to display the Command toolbar. In the text area, write an R, the 
shortcut for the Preferences command. 

Track number Track title

Total playback timeCurrent playback time



Working with your supplementary applications
Using AudioBox

 143

2 Tap the LCD off After pick list to display the time interval options. These include:

To repeat a section of the active track: 

1 During playback, tap  to select the starting point of the track section to be 
repeated. 

NOTE: The  function is only active during playback mode; otherwise, the button is 
grayed out to indicate it is disabled. 

2 Tap  again to select the end point of the track section to be repeated. 

The selected section would then be repeatedly played until  is tap again. 

To adjust the volume:
Do one of the following:

• Tap on the volume bar. 

Never The LCD backlight will remain on all throughout the 
playback period. This setting requires the highest demand 
on battery consumption. 

1 minute The LCD backlight automatically turns off one minute after 
playback begins. 

2 minutes The LCD backlight automatically turns off two minutes after 
playback begins. 

3 minutes The LCD backlight automatically turns off three minutes 
after playback begins. 

A�B

A�B

A�B

A�B
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• Drag the volume slider. 

• Press the up and down scroll buttons. 

To stop playback: 
Do one of the following:

• Tap . 

• Press the power button. AudioBox is relaunched when you turn your Acer s10 
back on. 

AudioBox playlist
The playlist displays all the audio files stored in the resident Memory Stick. 

To display the playlist: 
1 On the AudioBox main screen, tap the Playlist button. 

The Playlist Edit screen appears displaying the track number and titles of the available 
files. 

Drag the volume slider.

Tap on the volume bar.

Tap here.
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NOTE: AudioBox displays the Playlist Edit screen from the most recent AudioBox session. 

The playlist displays the track number, title and corresponding playback time of each 
.mp3 file; the total playback time of the whole playlist is also indicated. A maximum of 
six track entries will be displayed per frame.

2 Do any of the following: 

• Tap the check box before each track number to include that track in the 
active playlist. 

NOTE: Only checked track entries are played during playback mode. 

• Select a track entry and tap  to move it up or tap  to move it down the 
playlist.

• Select a track entry and tap Delete to delete it from the playlist. 
A confirmation dialog box appears.

Tap OK. 

Alarm reminder
When an alarm event is activated during playback mode, a blinking indicator appears 
on the left corner of the title bar.

t u

Alarm indicator
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Stop first track playback to be able to tap the alarm indicator. Tapping the alarm 
indicator will open the Attention Manager’s Reminder page. 

Refer to "Using the Reminder command buttons" on page 223. 

AudioBox menu
The AudioBox menu shown here is for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

AudioBox has only one menu: Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.
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Options menu

Preferences

• LCD off after. Sets the preset time afterwhich the 
LCD screen will automatically turn off during 
playback mode. Options include Never, 1 minute, 2 
minutes and 3 minutes. 

• Repeated by. Sets the Repeat mode during 
playback. Options include: 

– One. The current track will be played 
repeatedly until the Repeat button is tapped 
again. 

– All. The whole active playlist will will be played 
repeatedly until the Repeat button is tapped 
again. 

• Sleep setting. Sets the number of minutes before 
the application automatically turns off. Options 
include 15 minutes, 30 minutes and 60 minutes.

About AudioBox Shows version information for AudioBox.
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Using Recorder
Recorder allows you to conveniently record audio files whenever and wherever you 
need to. This application is especially useful when you need to record notes but 
jotting them down is not as efficient as in the case of a large number of figures or 
highly-detailed procedures. 

Recorder main screen
When Recorder is launched by tapping the Recorder icon in the Applications screen, 
the Recorder main screen appears. 

Audio recording function
You have two options to activate the Record function and start recording audio. 

• On the Utilities screen of Applications Launcher, tap the Recorder icon , 

then on the Recorder main screen, tap the Record icon .
• Use the Recorder Hot Button function. Refer to page 4 for the location of the 

Hot Button. 

NOTE: During Recording mode, the application buttons, the scroll buttons and the Graffiti 
area are disabled; the LED indicator flashes red. 

To start recording using the Recorder icon: 

• On the Recorder main screen, tap the Record icon . 

NOTE: No file should be selected in the file list, otherwise, Playback rather than Record 
mode will be activated. 

Audio file list number 

Date audio file 
was created

Play icon 

Audio file 
playback time

Audio filename 

Record icon 

Available time left for 
recording in the active 
storage 

Active storage 
pick list
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The Recording status screen appears. The same screen appears when Recording mode 
is activated via the Hot Button. 

.

The available recording time in the active storage should be more than 10 seconds to 
start/continue with the recording, If it’s not, a warning message pops up.

NOTE: The warning messages above are also applicable when insufficient memory is 
detected when Recording mode is activated via the Hot Button. 

Do one of following to stop recording: 

• Tap the Stop icon . 
• Pressing the power button will also stop recording. When you turn on your 

Acer s10, the Recorder main screen will again be displayed. 

Recorded audio is save to the active storage and the screen reverts to the Recorder 
main screen.

To start recording using the Hot Button:

Default procedure
1 Press and hold Hot Button until a beep is heard. 

2 Release hot button to start recording. 
The Recording screen appears.

3 Press the hot button again to stop recording. 

Elapsed recording time

Remaining time 
available for recording 

Pause icon Stop icon

Insufficient memory detected 
before Recording mode 

is activated. 

Insufficient memory 
detected during Recording 

mode. 
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Alternative procedure
1 Press and hold Hot Button until a beep is heard.

The Recording screen appears.

2 Start recording with the Hot Button still pressed down.

3 Release the hot button to stop recording. 

NOTE: Tapping any icons on the Recording status screen when Hot Button is used to 
activate Recording mode will disable the Hot Button function. 

To pause Recording:

• Tap the Pause icon . 

Tap the Record icon  to continue with the recording; otherwise, tap the 
Stop icon  to cancel Recording mode. Recorded audio is save to the active 
storage and the screen reverts to the Recorder main screen.

Storage options for recorded audio
There are two storage options in saving recorded audio files:

• Expansion Card. Recorded audio file is saved in .mp3 format in the resident 
Memory Stick. 
When this option is selected and there is no Memory Stick inserted in the 
Acer s10’s Memory Stick slot, storage category automatically changes to 
Internal. 

• Internal. Recorded audio file is saved in .pdb format in your Acer s10’s 
internal memory. 
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To select a storage option, tap the pick list on the upper-right corner of the Recorder 
main screen, then select a storage category. 

Using the Recorder command buttons
The command buttons on the Recorder screen allows you to view detailed 
information regarding the listed audio file(s); you can also rename or delete an audio 
file. 

You must first select an audio file before tapping any of the command buttons; 
otherwise, the message below appears. 

Tap OK to revert to the Recorder main screen, then select an audio file before tapping 
any of the command buttons. 

NOTE: The rule of selecting first an audio file before performing a command also applies 
when using the Record menu options as well as in activating the Playback function. 
For more information on the Record menu, refer to page 157. 
Refer to "Audio recording function" on page 149 for more information on the Playback 
function. 

Tap here.
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To view detailed information: 
1 Select an audio file from the file list. 

2 Tap the Details button to display the Recorder Item Details screen of the selected 
audio file. 

The Recorder Item Details screen displays the following information about the 
selected audio file:

3 Tap OK to revert to Recorder main screen. 

To rename an audio file: 
1 Select the audio file you want to rename. 

2 Tap the Rename button. 

The Rename screen for the selected audio file appears. The current filename is 
highlighted.

Tap here.

Filename Displays the audio filename.

Date Displays the date when audio file was recorded.

Name Displays the audio file’s total playback time.

Time Displays the audio file size.

Tap here.
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3 Enter a new filename. The maximum length for a filename is 20 characters (including 
blank spaces). 

4 Tap OK to rename the file.

When a file on the active storage has the same filename as the one specified on the 
Rename screen, the warning message below pops up. 

a. Tap OK to revert to the Rename screen with the original filename highlighted.

b. Enter a different filename. 

c. Tap OK. 

To delete an audio file:
1 Select the audio file you want to delete. 

2 Tap the Delete button. A confirmation dialog box appears.

3 Tap OK. 

To delete all file(s) in the audio file list:
To delete all files in the audio file list, use the Delete All menu command under the 
Record menu.

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

Tap here.
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1 On the Record menu, tap Delete All. A confirmation dialog box appears. 

2 Tap OK. 

Audio playback function
In addition to its Recording function, Recorder also provides a Playback function 
which allows you to play your audio files, stored either in your Acer s10’s internal 
memory or in a resident Memory Stick. 

You can listen to your audio files either through your Acer s10’s built-in speaker or 
through an earphone (included in the package contents) you connect to the earphone 
jack found on of your handheld. 

NOTE: You cannot use the both the earphone jack and the internal speaker at the same 
time. Using one will disable the other. 

Refer to page 4 for the location of your Acer s10’s earphone jack and to page 2 for the 
location of the internal speaker. 

To start audio playback: 
1 Select the audio file you want to play. 

2 Tap the Play icon . The Playback status screen appears.

In the Playback screen, the following information is displayed: 

Audio file list number Audio filename

Total playback timeCurrent playback time
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NOTE: During Playback mode, the application buttons, the scroll buttons and the Graffiti 
area are disabled; the LED indicator flashes red. 

During playback, tap: 

•  to pause playback. Image changes to . Tap this to resume playback.

•  to play the previous audio file in the audio file list. Icon is disabled when 
current file is the first file on the audio file list. 

•  to play the next audio file in the audio file list. Icon is disabled when 
current file is the last file on the audio file list. 

•  to stop playback and revert to the Recorder main screen. 

To adjust volume:
Do one of the following:

• Tap on the volume bar. 
• Drag the volume slider. 

• When the backlight is on, press the up and down scroll buttons.

Drag the volume slider.

Tap on the volume bar.
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Alarm reminder
When an alarm event is activated during Playback mode, a blinking indicator appears 
on the left corner of the title bar.

Stop first recording/playback to be able to tap the alarm indicator. Tapping the alarm 
indicator will open the Attention Manager’s Reminder page. 

Refer to "Using the Reminder command buttons" on page 223.

Recorder menus
Recorder menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Recorder has two menus: Record and Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

Record menu

Alarm indicator

Alarm indicator during 
Recording mode 

Alarm indicator

Alarm indicator during 
Playback mode 
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Options menu

Preferences. Tap to display the Preferences screen. Use this screen to define settings 
for the various Recording features. 

NOTE: Settings shown in the following screens are the default system settings. 

There are two screen tabs: Record and Other. 

• Record 

– Record To. Select storage category for recorded files. There are two 
options: 
- Internal. Stores recorded audio files in your Acer s10’s internal memory. 

- Expansion Card. Stores recorded audio files in the resident Memory 
Stick. 

Tap the Tips icon to display related information on the Record To 
options.

– Hot Button. Select recording procedure in using the Hot Button 
function. There are two options:
- Press once to record, press again to stop. 

- Press and hold to record, stop with release of button.

Tap Done to revert to the Record tab screen. 
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• Other 

– Sort by. Select basis for viewing files in the audio file list. There are two 
options: 
- Time. Files are sorted based on the date they were recorded, with the 
earliest recorded file on top of the list. 

- Filename. Files are sorted alphabetically or numerically in an ascending 
order. 

– LED. Select whether the LED indicator will flash red or or not during 
Recording/Playback mode. There are two options: On and Off.

– Beep. Select whether a beep will be sounded or not prior to Recording 
mode activated via Hot button. There are two options: On and Off.

Tap the Tips icon to display related information on the Record To and 
Recording Quality options.

Tap Done to revert to the Other tab screen.

About Recorder. Shows version information for Recorder.
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Using eBook Reader
eBook Reader enables you to read your eBooks (Acer eBook format) with a few quick 
taps on your Acer s10. eBook Reader can detect eBook files stored in your Acer s10’s 
internal memory or in a Memory Stick . 

Use eBook Converter to convert your regular document files into Acer eBook format ( 
.pdb file format). See "Using eBook Converter" on page 203 for more information. 

Working on the Book Manager screen
Book Manager is the default opening screen when eBook Reader is launched. 

NOTE: If in a previous eBook Reader session, you close the application from the Read 
Document mode, relaunching eBook Reader will display that Read Document page rather 
then the Book Manager screen. 

While in the Book Manager screen, you can categorize eBook files, edit the category 
list, add new categories, view and edit eBook details, or delete the eBook file from 
your Acer s10’s memory or in a resident Memory Stick. 

To categorize an eBook file: 
1 In the Book Manager screen, select the eBook file you want to categorize. 

2 Tap the category pick list to display the eBook category list. 

There are five default eBook categories: All, Novel, Science, Poem, History and 
Unfiled. On the bottom of the category list is a command option, Edit Categories. 

NOTE: New eBooks are categorize under the Unfiled category. 

Tap here.

non-matching screen?
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3 Tap the eBook category under which you want to categorize the selected eBook file. 
The selected category will be displayed on the eBook’s Details page. 

To edit the eBook category list: 
1 Tap the category pick list to display the eBook category list. 

2 Select Edit Categories on the bottom of the list to display the Edit Categories screen. 

3 Do any of the following: 

• Tap New to create a new category.
• Select an existing category then tap Rename to change the name of the 

category.
• Select an existing category then tap Delete to delete that category from the 

category list.

NOTE: The All and Unfiled category cannot be renamed or deleted.

Tap the Tips icon  to view related information on editing categories. 

To view detailed information about an eBook file: 
1 In the Book Manager screen, select an eBook file. 

Tap here.

Tap here.
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2 Tap the Information icon  to display the corresponding Details page. 

The first four fields display general information regarding the selected eBook and are 
not configurable. 

The last two fields are user-configurable. 

To delete an eBook file:
1 In the Book Manager screen, select the eBook file you want to delete. 

2 Tap the Delete icon  to display the Delete eBook Reader dialog box. 

Tap here.

Book Name Indicates the eBook’s filename. A filename can be up to 16 
alphanumeric characters or 8 Chinese characters in length 
(including blank spaces).

Author Indicates the name of the eBook creator. (may have a blank 
value)

Publisher Indicates the name of the eBook’s publisher. (may have a blank 
value)

Publish Date Indicates when the source file was created.

Size Indicates the eBook file size.

Category Tap the pick list to change the eBook category of the selected 
file.

Privacy When the option box is checked (default), the Current Privacy 
setting under the system Security preferences. is applied. 
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3 Tap OK. 

Reading your eBook files
You can access your eBook files through the Book Manager screen. 

To open an eBook:
1 In the Book Manager screen, tap the eBook file you want to open. 

2 Do any of the following:

• Tap the Open icon .
• Double-tap the eBook file.
• Tap the inverted application title tab, tap Options, then select Open. 

The selected eBook file is shown in Read Document mode.

Tap here.
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Working in Read Document mode
There are several command icons on the Read Document screen to help you navigate 
through your eBook. 

To revert to the Book Manager screen: 

• Tap the Go Back icon . All the current eBook settings are retained and will 
be applied when you reopen the file. 

To define font type in viewing the eBook: 
1 In the Book Manager screen, tap an eBook file. 

2 Tap the Font icon  to display the Font Selection window. 

3 Tap on any of the font type frame to select an option. 

4 Tap OK. 

NOTE: Font settings are saved separately for each eBook file. It does not affect font display 
in other files or in other applications. 

To search for a particular text in the eBook: 

1 Tap the Find icon  to display the Find screen.

2 Enter the word or phrase you want to search for. 

Tap here for standard font (default).

Tap here for bold font.
Tap here for large font.

Tap here for large, bold font.
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NOTE: Refer to "2 Entering data in your Acer s10" on page 23. 

If you have previously used the Find function on the same eBook Reader session, the 
Find screen appears with the last word/phrase searched is highlighted on the First line. 

3 Define the search mode. 

4 Tap OK. 

Tapping OK when the Find line is left blank will display the message below. 

Tap OK to revert to the Find screen, and enter a word or phrase to search for.

When a match is found for the searched text, the match word is highlighted and is 
shown on the first line of the screen. 

When no match is found for the searched text, a message window appears.  

Case Sensitive Tap the check box to consider text case in 
searching for the specified string.

From top of the document Defines the search range. Tap the check box to 
start the search from the top of the document; 
otherwise, Find starts searching from the first 
line of the current page.

Match word
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Tap OK to revert to the Find screen. 

To move around in Read Document mode 
Do any of the following: 

• Tap on the top half of the screen to scroll the text up half a page; tap on the 
lower half of the screen to scroll the text down half a page (default action). 
You can change the result of the tap action in the Preferences screen. Refer 
to "Preferences" on page 178 for more information. 

NOTE: Pressing the stylus on the top/bottom half of the screen for more than a second will 
scroll the screen up/down continuously. Release the stylus to stop scrolling. 

• Press the top scroll button to scroll the text up one screen; press the bottom 
scroll button to scroll the text down one screen.

• Tap  to activate Auto Scroll mode. This will continuously scroll the screen 
based on the settings made on the Preferences screen. 
For more information on the Preferences settings, refer to  page 178. 

• Use bookmarks. 
Refer to "Working with bookmarks" on page 167 for more information. 

• Use the Jump To function. 
Refer to "Using the Jump To function" on page 172 for more information. 

• Use hyperlinks. 
Refer to "Working with hyperlinks" on page 172 for more information. 

Working with bookmarks
Bookmarks help you navigate through your eBook by jumping to the specific location 
referred to by its marker. 

To go to a bookmark location: 

1 On the Read Document view, tap the Bookmark icon  to display the Bookmark 
screen.

2 Tap the bookmark entry you want to view. 

Tap here.
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3 Tap the Go To button.

The screen reverts to Read Document mode with the location referred to by the 
selected bookmark’s location moved to the first line of the screen. 

To create a new bookmark:
1 In Read Document mode, place the cursor on the location you want the bookmark to 

refer to.

2 Tap the Bookmark icon .

TIP: You can also use the Add menu command under Note menu to add a bookmark. 

Tap here.

Tap here.
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3 Tap New to display the New Bookmark screen. 

By default, the first 20 characters (including spaces) on the first line of the selected 
bookmark location serves as the title for the new bookmark. You can define a specific 
title by deleting the default title and entering a new one.

4 Tap OK. 

When OK is tapped but no title is defined for the new bookmark, the warning 
message below pops up.

Tap OK to revert to the New Bookmark screen, and enter a bookmark title.

Tap here.
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When OK is tapped but the title defined for the new bookmark already exists in the 
document, the warning message below pops up. 

Tap OK to revert to the New Bookmark screen, and enter a different bookmark title.

When a bookmark already exists in the location defined for the new bookmark, the 
dialog box below appears. 

Tap OK to confirm creation of the new bookmark on the same location, otherwise, 
tap Cancel.

To delete a bookmark: 
1 In the Bookmark list, tap the bookmark entry you want to delete. 
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2 Tap the Del button. A confirmation dialog box appears.

3 Tap OK. 

To delete all bookmarks in a document: 
1 In the Bookmark screen, tap the Del All button. A confirmation dialog box appears.

2 Tap OK. 

Tap here.

Tap here.
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Using the Jump To function
Another navigation tool provided by eBook Reader is the Jump To function. 

To use the Jump To function:
1 In Read Document mode, tap the percentage value pick list to display the Jump To 

options.

2 Select a Jump To option:

Working with hyperlinks
Hyperlinks embedded in your eBook let you jump from one location to another within 
the same eBook. Text links appear with a dotted underline.

Tap here.

Top The screen will jump to the first line of the document.

Bottom The screen will jump to the last line of the document.

Percentage values The screen will jump to the location corresponding to 
selected percentage value. Percentage values increase in 
10% increments.
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To use hyperlinks:
1 Tap the text link (location A) then release to jump to the related location (location B) 

it refers to. 

2 On the related location (location B) screen, the Back icon  appears. Tap this icon to 
revert to the location of the tapped link (location A). 

3 After you go back to the text link location screen (location A), the Back icon  is 

replaced by the Forward icon . Tap this icon to revert to the related location 
(location B) referred to by the last used text link. 

Attaching a note to an eBook
You have the option to create a descriptive note for your eBooks. 

To attached a note to an eBook:
1 Open the eBook file you want to attach a note to. 

2 Do one of the following to display the New Note screen: 

• Tap the Menu icon  to display eBook Reader’s menu bar. Tap Note, then 
tap Add. 

• Tap the inverted application title tab to display eBook Reader’s menu bar. 
Tap Note, then tap Add.

• Draw the Add Note Graffiti shortcut: Graffiti command stroke + H.

Location B after tapping 
text link

Location A after tapping 
text link

Location A before 
tapping text link
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3 Enter related note information.

TIP: Tap the Tips icon to display information regarding the maximum length for a note title 
and the note content.

.

Working on Note Manager
You can use the Note Manager command buttons to manage the note(s) attached to 
your eBook. 

To use the Note Manager command buttons: 
1 Do one of the following to display the Note Manager screen: 

• Tap the Menu icon  to display eBook Reader’s menu bar. Tap Note, then 
tap View. 

• Tap the inverted application title tab to display eBook Reader’s menu bar. 
Tap Note, then tap Add.

Note Title The maximum length for a note title is 20 characters 
(including blank spaces). A note title that exceeds this limit 
will be automatically cut off.

Note Content The maximum length for the note is 280 characters 
(including blank spaces). A note content that exceeds this 
limit will be automatically cut off.
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• Draw the View Note Manager Graffiti shortcut: Graffiti command stroke + V.

2 Tap a note entry. 

3 Tap any of the following command buttons to perform a task. 

• View. Tap to display the View Note screen. 

The note title and note content of the selected note entry is displayed on the 
View Note screen. There are three command buttons on this screen: 

– Done. Tap to revert to the Note Manager screen.
– GoTo Page. Tap to open the eBook file to which the note was added.

Tap here.
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– Delete. Tap to delete the selected note entry. A confirmation dialog box 
appears. 

• Delete. Tap to delete the note currently highlighted in the Note Manager 
screen. A confirmation dialog box appears.

• Delete All. Tap to delete all note(s) displayed in the Note Manager screen. 
A confirmation dialog box appears.

• Done. Tap to revert to Read Document mode.

eBook Reader menus
eBook Reader menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

eBook Reader has three menus: Options, Bookmark and Note.

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Tap here.

Tap here.
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Options menu 
The Options menu differs depending on whether you’re displaying the menu bar from 
the Book Manager screen or from Read Document mode.

Options menu in 
Book Manager view

Options menu in 
Read Document mode

Large Line Space Sets the line space between lines to four pixels. 

Median Line Space Sets the line space between lines to three pixels. 

Small Line Space Sets the line space between lines to two pixels. 

Book Manager Display the Book Manager screen. 
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Preferences

Opens the eBook Reader Preferences screen to define 
default Options settings for the active document. 

• Tap Action. Defines the scrolling behavior 
after tapping the top/bottom half of the 
screen. Options include: 

– 1/2 Page. Scrolls the screen up/down half a 
page. 

– Page. Scrolls the screen up/down one 
page.

– Line. Scrolls the screen up/down one line.
• Auto Scroll Page Speed. Defines the speed of 

scrolling when Auto Scroll mode is activated. 
Speed options include: 

– every (5, 10, 15, 20, 25, 30,3 5, 40, and 45) 
seconds. Default value is 10. 

• Show line from previous page. Enabling 
(default) this option will scroll up the screen 
minus one line of text. This means that the last 
line of the screen after scrolling is the same line 
that was at the top of the screen before 
scrolling. 

About eBook Reader Shows version information for eBook Reader.
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Bookmark menu

Note menu
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Using Backup
Backup allows you to back up data files and applications from your Acer s10’s internal 
memory to a Memory Stick and to restore such data back to your handheld. This 
feature enables you to manage the contents of your Acer s10’s internal memory based 
on your current space requirements.

NOTE: Before using the Backup utility, first insert a Memory Stick into your Acer s10’s 
Memory Stick slot. Refer to “To insert a Memory Stick” on page 217 for more information. 

Backup function
The Backup function has two operating modes based on the scope of files to be back 
up:

• Complete Backup. Scope of backup files includes all data and program files, 
including applications and databases stored in your Acer s10’s internal 
memory. 

• Partial Backup. Scope of backup files only includes PIM (Personal 
Management Information) databases — referring only to your basic 
applications. 
Your Acer s10’s basic applications include Date Book, Address Book, To Do 
List, Memo Pad, Expense and Mail. 

NOTE: All application launch keys are disabled during the backup process. 

When the Complete Backup or Partial Backup tab is tapped when no Memory Stick is 
properly inserted in the slot, a warning message pops up. 

Tap OK to revert to the Backup main screen, then check if a Memory Stick is properly 
inserted in the slot. 

NOTE: This warning message also applies when the Complete Restore or Partial Restore tab 
is tapped. 



Working with your supplementary applications
Using Backup

182   

When free space in the resident Memory Stick is less than the size of the data to be 
copied from the Acer s10’s internal memory, a warning message pops up 

Tap OK to revert to the Backup main screen, then either delete files from the resident 
Memory Stick to increase its free space or insert a new Memory Stick with a larger free 
space enough to accomodate the size of the intended backup data. 

To perform a complete backup: 
1 On the Backup main screen, tap Complete Backup to display the Complete Backup 

dialog box.

You can tap the Tips icon  to view information on the Complete Backup function. 

Tap Done after viewing. 

Tap here.

Tap here.
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2 Tap OK to start backup process. 

During the backup process, a progress screen displaying related backup information 
appears.

Tap Cancel to stop the backup process. No files will be saved and the backup process 
will be disregarded. 

3 When the backup process is completed, a message window appears.
.

4 Tap OK to revert to the Backup main screen.

Progress status of the 
backup process

Total size of the files to 
be backup 

Size of free space in the 
resident Memory Stick

Estimated time for the 
backup process to be 
completed
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To perform a partial backup: 
The procedure in performing a partial backup is similar to the complete backup 
process. 

1 On the Backup main screen, tap Partial Backup to display the Partial Backup dialog 
box. 

You can tap the Tips icon  to view information on the Partial Backup function. 

Tap Done after viewing.

2 Tap OK to start backup process. 

Elements in the Partial Backup progress screen are similar to those shown in the 
Complete Backup progress screen. 

Tap Cancel to stop the backup process. No files will be saved and the backup process 
will be disregarded. 

Tap here.

Tap here.
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3 When the backup process is completed, a message window appears.

4 Tap OK to revert to the Backup main screen.

Backup errors

In cases when a processing error is encountered during the backup process, an error 
message appears. 

You can later review these error messages using the Log feature of the Restore 
function. Refer to "To view backup error log" on page 189 for more information. 

Restore function
The Restore function has two operating modes based on the type of backup data to 
be restored:

• Complete Restore. Enables you to restore backup data generated by a 
complete backup process to your Acer s10’s internal memory. 

• Partial Restore. Enables you to restore backup data generated by a partial 
backup process to your Acer s10’s internal memory. 

NOTE: During the restore process, all application launch keys as well as the power button is 
disabled. 

Error message encountered in a 
Complete Backup process 

Error message encountered in a 
Partial Backup process 
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To perform a complete restore: 
1 On the Backup main screen, tap Complete Restore to display the Complete Restore 

dialog box.

You can tap the Tips icon  to view information on the Complete Restore function. 

Tap Done after viewing.

NOTE: The Complete Restore and Partial Restore functions display the same Tips 
information. 

Tap here.

Tap here.
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2 Tap the Source pick list to select the Complete Backup file to restore.

The Complete Restore screen displays the following information regarding the 
selected backup file:

NOTE: Only Complete Backup files copied from the same Acer s10 (i.e., same device ID) is 
displayed in the Source drop-down window.

3 Tap OK to start the restore process. 

During the restoration process, a progress screen appears displaying related 
information on the restore process. 

4 When the restore process is completed, a message window appears.

Device (handheld) ID from 
where the backup file was 
copied

Date and time when 
backup data was created

Size of the selected 
backup data

Progress status of the 
restore process

Total size of the files to 
be restored Estimated time for the 

restore process to be 
completed
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5 Tap OK to revert to the Backup main screen. 

To perform a partial restore: 
The procedure in performing a partial restore is similar to the complete restore 
process. 

1 On the Backup main screen, tap Partial Restore to display the Partial Restore dialog 
box.

2 Tap the Source pick list to select the Partial Backup file to restore.

Elements in the Partial Restore screen are similar to those shown in the Complete 
Restore screen. 

NOTE: Only Partial Backup files copied from the same Acer s10 (i.e., same device ID) is 
displayed in the Source drop-down window.

3 Tap OK to start the restore process. 

Elements in the Partial Restore progress screen are similar to those shown in the 
Complete Restore progress screen.

4 When the restore process is completed, a message window appears.

5 Tap OK to revert to the Backup main screen.

Tap here.
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Deleting a backup file from the Memory Stick 
To increase the size of available free space in the resident Memory Stick, you have the 
option to delete backup files that you no longer need. 

To delete a backup file from the resident Memory Stick: 
1 In either the Complete Restore or Partial Restore dialog box, tap the Source pick list to 

select the backup file you want to delete. 

2 Tap Delete. A confirmation dialog box appears. 
.

3 Tap OK. 

Viewing backup error log 
You have the option to review error messages encountered during a complete or 
partial backup process. 

To view backup error log
1 In either the Complete Restore or Partial Restore dialog box, tap the Source pick list to 

select a backup file with an error log you want to view. 

2 Tap Log to display the Error Log screen. 
.

Tap here to delete 
selected backup file.

Tap here to select a 
backup file to delete.

Tap here to view 
error log. 

Tap here to select a 
backup file.
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3 Tap OK. 

Backup menu
The Backup menu shown here is for your reference only.

Backup has only one menu: Options. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

Options menu

About Backup Shows version information for Backup.
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Using Service Launcher
With Service Launcher, you can easily activate dedicated Personal Service applications 
installed in your Acer s10. 

Using Service Launcher
Activate Service Launcher to let search for dedicated Personal Service applications 
under the Service category of the Applications Launcher. 

If a dedicated Personal Service application is found, the Personal Service screen 
appears.

Illustration suggestion (Delete this suggestion when completed): Personal
Service screen

NOTE: Only applications categorized under the Service category will be displayed on the 
Personal Service screen. 

Tap any application icon on the Personal Service screen to automatically launch that 
application.

If a pre-categorized Service application is moved or deleted to another category, 
Service Launcher will no longer include the application in the Personal Service screen. 

When no dedicated Personal Service application is found, the dialog box below 
appears. 



Working with your supplementary applications
Using Service Launcher

192   

Illustration suggestion (Delete this suggestion when completed): Welcome
page of Personal Service screen

Using the Quick Launcher function
By default, tapping the Service icon  on the upper-right corner of the Graffiti area 
will launch Service Launcher displaying the Personal Service screen. However, you can 
choose to reassign this icon to launch a specific dedicated Personal Service application. 

Using the Quick Launcher function, you can set which dedicated Personal Service 
application to launch whenever the Service icon on the upper-right corner of the 
Graffiti area is tapped. 

To define Quick Launcher settings: 
1 On the Personal Service screen, tap the Quick Launcher pick list to display the 

applications categorized under the Service category. 

Illustration suggestion (Delete this suggestion when completed): Personal
Service screen with call out to Quick Launcher with options

2 Select an application. 

The selected application will now be launch every time you tap the Service icon on the 
upper-right corner of the Graffiti area. 
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To disable Quick Launcher function:
1 On the Personal Service screen, tap the Quick Launcher pick list. 

Illustration suggestion (Delete this suggestion when completed): Personal
Service screen with call out to Quick Launcher showing options

2 Select None. 

Quick Launcher settings revert to its default value, that is to open Service Launcher 
every time the Service icon  on the upper-right corner of the Graffiti area is tapped. 
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6 Working with your 
PC-end utilities
Your Acer s10 includes PC-end utilities designed to complement the functions of your 
handheld applications.

• Palm Desktop Software
• Voice Converter
• eBook Converter

This chapter is organized into two sections, namely: 

• Overview of PC-end utilities 
• Using your PC-end utilities

Overview of PC-end utilities
This section will give you a brief description of each PC-end utility.

Palm Desktop software
The main complementing function of Palm Desktop software to your Acer s10 is its 
role in performing a HotSync operation so that information in your handheld and 
your computer remains synchronized with each other. 

For more information on instaling Palm Desktop software in your computer, refer to 
"Installing Palm Desktop software" on page 11.

For more information on using your Palm Desktop software, refer to its online help. 

Refer to "11 Exchanging and updating data using HotSync operations" on page 253 
for more information. 

To launch Palm Desktop software:

1 Click the Windows Start button . 

2 Select Programs > Palm Desktop.

3 Select the Palm Desktop software you want to open.
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Voice Converter
Voice Converter enables you to convert the .pdb audio files generated by Recorder 
into .mp3 files that you can play from using any regular MP3 player. 

Voice Converter only supports conversion of Recorder .pdb files to standard .mp3 
format. Conversion mode is from .pdb to .mp3 format. 

For more information on using Recorder, refer to page 149. 

To launch Voice Converter:

1 Click the Windows Start button . 

2 Select Programs > Acer s10. 

3 Click the Voice Converter icon .

eBook Converter
eBook Converter enables you to convert your regular document files into Acer eBook 
file format supported by your Acer s10’s eBook Reader. 

File formats supported by eBook Converter includes:

• .html 
• .txt 
• Microsoft Word (97 and 2000 version) .doc and .rtf 
• Palm eBook format (.pdb) 

After conversion, you can use HotSync to transfer the new eBook files to your 
Acer s10’s internal memory or you can store it in a Memory Stick. Either way, 
converted documents will be accessible from your Acer s10 through eBook Reader. 

For more information on using eBook Reader, refer to page 161. 

Refer to page 253 for more information on HotSync operations.

To launch eBook Converter:

1 Click the Windows Start button . 

2 Select Programs > Acer s10. 

3 Click the eBook Converter icon . 
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Using Voice Converter
With Voice Converter, you can convert the .pdb audio files generated by Recorder into 
.mp3 files which you can play from any regular MP3 player. 

NOTE: Voice Converter only supports conversion of Recorder .pdb files to standard .mp3 
format. Conversion mode is from .pdb to .mp3 format.

After conversion, you can transfer the converted files to your Acer s10 via HotSync 
procedures. 

Refer to page 253 for more information on performing HotSync operations. 

Installing Voice Converter
1 Turn on your computer. 

2 Insert the Acer s10 handheld Installation CD into the computer’s CD-ROM drive. 

3 On the menu screen, click Install Supplementary Applications. 

4 Select Install Voice Converter. 

5 On the Choose Destination Location window, select a folder where Setup will install 
the program files. 

Default directory is C:\Program Files\Acer s10\Voice Converter. 

Click the Browse button to select a different location. 

6 Click Next. 

7 On the Select Program Folder window, select a program folder where Setup will add 
the program icons. 

The default program folder is Acer s10.

You can choose another program folder from the Existing Folders list.

8 Click Next to start the installation process. 

9 Click Finish on the Setup Complete window. 

If the Launch Voice Converter option box is checked (default), Voice Converter is 
automatically launched, displaying the application main screen. 
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Voice Converter toolbar
Use the four command icons on the toollbar to perform basic application tasks.

NOTE: The toolbar icons perform the same function as their corresponding menu bar 
commands. 

Default path for the Convert to field is C:\Program Files\Acer s10\Voice Converter. If 
you want to define a different destination folder to which the converted file will be 
save, click .

To select a file in the source file list: 
• Left-click. Selects a single file in the source file list. 
• Click and drag. Selects sequential files in the source file list.
• Shift + Left-click. Selects sequential files in the source file list.
• Ctrl + Left-click. Selects non-sequential files in the source file list.
• Left-click on an empty area. Deselects all selected file(s).

To add a file to the source file list:

NOTE: Adding a file to the source file list does not remove that file from its original 
location; only a copy of that file is added to the source file list folder.
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1 Click the Add icon  to display the Add window.

2 Define the source path of the file you want to add. 

3 Select the file you want to add. 

TIP: You can select and add multiple files at the same time. 

4 Do one of the following: 

• If you selected a single file, click the Open button or double-click the selected 
file.

• If you selected multiple files, click the Open button.

NOTE: The first time you add a file, the default destination folder is the program’s path you 
defined during the installation process. Afterwhich, the default path will be change to the 
last folder from which you accessed a file for conversion.

To remove a source file from the source file list:
1 On the source file list, select the file you want to remove. 

TIP: You can select and remove multiple files at the same time. 

2 Click the Remove icon . 

TIP: You can also use the Delete key in your keyboard. 

The selected file(s) is removed from the source file list.

To remove all files from the source file list:
1 Click the File menu. 

2 Select Remove All. A confirmation dialog box appears.

3 Click Yes. 

To convert listed source file(s) to .mp3 format: 

1 Click the Browse icon  to define the destination folder where the converted file 
will be save. 
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2 Click the Convert icon . 

If an error occurred during conversion, a warning message pops up. 

Click OK.

If an existing .mp3 file in the destination folder has the same filename as the source 
file that is to be converted, the following dialog box appears: 

Click Yes to overwrite the existing file; otherwise, click No.

To convert all listed files to .mp3 format:
• Click the Convert All icon .

NOTE: The warning messages that appear when converting selected file(s) in the source file 
list also applies when the same situations are encountered in converting all files in the list. 

Voice Converter source file list
The Voice Converter source file list displays four columns of information:

Name Displays the filename of the source file.

Size Displays the size of the source file.
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Voice Converter menus
Voice Converter menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Voice Converter has four menus: File, View, Action, and Help. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

File menu

View menu
.

Action menu
.

Modified Date Displays the date when the source file was last modified.

Status Displays the conversion status of the source file. 

• Cancelled. Indicates that the user has chosen not to 
overwrite an existing file. 

• Converted. Indicates that the source file has been 
successfully converted to .mp3 format.

• Failed. Indicates that an error occured during file 
conversion. 

Exit Closes Voice Converter.

Toolbar Check to show toolbar (default). To hide toolbar, uncheck this 
option.

Status Bar Check to show status bar (default). To hide the status bar 
uncheck this option. 



Working with your PC-end uti l it ies
Using Voice Converter

202   

Help menu

Illustration suggestion (Delete this suggestion when completed): Help
drop-down window and About box

Help Topic Click to display the Voice Converter online guide. 

About Voice Converter Displays version information for Voice Converter.
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Using eBook Converter
With eBook Converter, you can convert regular document files into Acer .pdb format 
files that you can access from your Acer s10 using eBook Reader. 

Installing eBook Converter 
1 Turn on your computer. 

2 Insert the Acer s10 handheld Installation CD into the computer’s CD-ROM drive. 

3 On the menu screen, click Install Supplementary Applications. 

4 Select Install eBook Converter. 

5 On the Choose Destination Location window, select a folder where Setup will install 
the program files. 

Default directory is C:\Program Files\Acer s10\eBook Converter. 

Click the Browse button to select a different location. 

6 Click Next. 

7 On the Select Program Folder window, select a program folder where Setup will add 
the program icons. 

The default program folder is Acer s10.

You can choose another program folder from the Existing Folders list.

8 Click Next to start the installation process. 

9 Click Finish on the Setup Complete window. 

If the Launch eBook Converter option box is checked (default), eBook Converter is 
automatically launched, displaying the application main screen.
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eBook Converter toolbar
Use the seven command icons on the toolbar to perform application tasks.

NOTE: The toolbar icons perform the same function as their corresponding menu bar 
commands. 

The User and Install to fields are disabled if the Select a Palm Desktop User for Auto 
Installation option on the Destination window is unchecked.

Refer to "Options menu" on page 212 for more information.

To select a file in the source file list: 
• Left-click. Selects a single file in the source file list. 
• Click and drag. Selects sequential files in the source filelist.
• Shift + Left-click. Selects sequential files in the source file list.
• Ctrl + Left-click. Selects non-sequential files in the source file list.
• Left-click on an empty area. Deselects all selected file(s).

To create a new list file: 

• Click the New icon . A new list file appears. 
If there is an open, unsaved list file, a dialog box prompting the open list file 
to be save appears. 

Click Yes to save the open, unsaved list file; otherwise, click No. 

To return to the open, unsaved list file, click Cancel.

To open an existing list file: 

1 Click the Open icon  to display the Open window.

Illustration suggestion (Delete this suggestion when completed): Open
window

If there is an open, unsaved list file, the same dialog box as above appears.

2 Define the source path of the list file you want to open. 
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3 Select the list file you want to open. 

4 Do one of the following: 

• Click the Open button. 
• Double-click the selected list file.

To save a list file:

• Click the Save icon . 

To use the Save As menu command: 
1 Click the File menu. 

2 Select Save As. The Save As window appears.

3 Define the destination folder where the list file will be save. 

4 Specify a filename for the list file.

5 Click the Save button. 

If an existing list file in the destination folder has the same filename as the one you 
defined, a dialog box appears. 

Click Yes to overwrite the existing file with the current file; otherwise, click No.



Working with your PC-end uti l it ies
Using eBook Converter

206   

To add a file to the source file list:

NOTE: Adding a file to the source file list does not remove that file from its original 
location; only a copy of that file is added to the source file list folder.

1 Click the Add icon  to display the Add window. 

2 Define the source path of the file you want to add. 

3 Select the file you want to add. 

TIP: You can select and add multiple files at the same time. 

4 Do one of the following: 

• If you selected a single file, click the Open button or double-click the selected 
file.

• If you selected multiple files, click the Open button.
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If an existing file (of the same file format as the file you intend to add) in the source 
file list has the same filename as the file you want to add, the dialog box below 
appears. 

Click Yes to overwrite the existing file; otherwise, click No.

NOTE: Yes to All and No to All options apply when multiple files in the source file list have 
the same filename as the files you want to add. 

The maximum file size for a source file to be converted by eBook Converter is 10 MB. 
When you try to add a file greater than 10 MB, the warning message below appears, 
and the attempt to add the file to the source file list will be disregarded. 

Click OK.

NOTE: The first time you use the Open, Add, Save and Save As commands, the default 
destination folder is the program’s path you defined during the installation process. The 
default path will be change to the last folder you opened or saved a list to for the Open, Save 
and Save As commands. For the Add command, it is the last folder from which you accessed a 
file for conversion. 

To remove a file from the source file list:
1 On the source file list, click the file you want to remove. 

NOTE: You can select and remove multiple files at the same time. 

2 Click the Remove icon . 

To remove all files from the source file list:
1 Click the File menu. 

2 Select Remove All. A confirmation dialog box appears.
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3 Click Yes. 

To convert a source file to Acer eBook format: 
1 On the source file list, select the file you want to convert. 

TIP: You can select and convert multiple files at the same time. 

2 Click the Convert icon . 

If a Microsoft Word file is selected for conversion and Microsoft Word 97 or Microsoft 
Word 2000 is not installed in your system, a warning message pops up. 

Click Yes to convert all selected file(s), excluding Word file(s); otherwise, click No.

If an error occurred during conversion, a warning message pops up. 

Click OK.
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If an existing eBook file in the destination folder has the same filename as the source 
file that is to be converted, the following dialog box appears: 

Click Yes to overwrite the existing file; otherwise, click No.

To convert all files in the source file list:

• Click the Convert All icon .

NOTE: The warning messages that appear when converting selected file(s) in the source file 
list also applies when the same situations are encountered in converting all files in the list. 

Conversion reminders
Note the following reminders before performing a conversion task. 

1 When converting an .html file, remember to:

• Keep only the internal hyperlinks (i.e., hyperlinks with target location within 
the same document).

• Remove all images from the file. 
2 When converting a Microsoft Word .doc file with hyperlinks, convert first the .doc file 

to HTML format before converting it to Acer eBook format. 

eBook Converter source file list 
The eBook Converter source file list displays six columns of information which include:

Source Displays the filename of the source file.

Title Displays the eBook’s title defined in the File Properties screen. If 
no title is defined, this column will be empty.

User Displays the eBook’s user name defined in the Destination 
screen. If no user name is defined, this column will be empty. 

Destination Displays the full path of the destination location of the eBook. 
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eBook Converter menus
eBook Converter menus are shown here for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

eBook Converter has five menus: File, View, Action, Options and Help. 

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

File menu

Size Displays the file size of the source file.

Status Displays the conversion status of the source file. 

• Conversion successful, eBook file size. Indicates 
that the source file has been successfully converted to 
Acer eBook format; also shows the file size of the 
eBook. 

• Conversion Failed. Indicates that an error occured 
during file conversion. 

• Cancelled. Indicates that the user has chosen not to 
convert the source file. 

Exit Closes eBook Converter. 
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View menu

Toolbar Check to show toolbar (default). To hide toolbar, uncheck 
this option.

Status Bar Check to show status bar (default). To hide the status bar 
uncheck this option. 
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Action menu

Options menu

• File Properties. Click to display the File Properties screen. This option is 
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disabled when multiple files are selected in the source file list. 

Use this screen to define general information for the corresponding eBook 
file of the selected source file. These information will be displayed in the 
eBook Reader’s Details screen when you open the eBook from your Acer s10. 

Refer to “To view detailed information about eBook file” on page 162 for 
more information. 

The first two items are non-configurable.

– Source Location. Shows the file path for the source file of the selected 
eBook. 

– Size. Shows the file size of the corresponding eBook.
The last four items are user-configurable. 

– Author. Enter the name of the eBook’s author (may be left blank).
– Publisher. Enter the name of the eBook’s publisher (may be left blank).
– Publish Date. Click the pick list to display a calendar window to specify 

the eBook’s publish date (may be left blank). 

– eBook Title. Enter an eBook title. 
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NOTE:
The maximum length for the eBook’s Author, Publisher and Title field is 16 characters 
(including blank spaces). Default eBook title will be taken from the first 16 characters of the 
source filename.

• Destination. Click to display the Destination screen. 

Use this screen to define default destination properties for all files in the 
source file list. 

– Select a Palm Desktop User for Auto Installation. Check this option 
to select a Palm Desktop user name. The selected user name will appear 
in the toolbar’s User field. When this option is unchecked, the User and 
Install To fields on the toolbar will be disabled. 
There are two options:

- Install to Handheld. eBook files are automatically installed on your 
Acer s10 after a HotSync operation. 

- Install to Expansion Card. eBook files will be stored in a 
Memory Stick.

– Save a Copy to. Define the folder where eBook Converter will save a 
copy of the eBook to. 
There are two options:

- Same folder as source file. A copy of the eBook will be created in the 
same folder as the source file.

- Specify folder. A copy of the eBook will be created in the defined 
path. Default path is the system Temp folder. Click the _______ to select 
another path.
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Help menu

Help Topic Click to display the eBook Converter online Help.

About eBook Converter Displays version information for eBook Converter.
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7 Using expansion 
features
On the top of your Acer s10 is a Memory Stick slot. This enables you to use a Memory 
Stick for installing additional applications, increasing memory and performing backup 
procedures. 

Refer to "Rear panel" on page 4 for the location of the Memory Stick slot.

For instructions on how to use a Memory Stick to perform backup procedures, refer to 
"Using Backup" on page 181.

In addition, your Acer s10’s versatile connector allows you easily attach and use 
peripheral hardware devices, such as a modem, a portable keyboard or a Global 
Positioning System (GPS) receiver. Refer to "Front panel" on page 2 for the location of 
the versatile connector.

NOTE: For information on how to install and operate your peripheral devices, refer to the 
documentation that accompany each device. 

Inserting and removing a Memory Stick 
To insert a Memory Stick:

1 Hold your Acer s10 securely. 

2 Insert the Memory Stick into the Memory Stick slot. 
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3 Push the card into the slot using your finger until you feel the card lock and hear an 
audible system sound; this will signal that the card is already properly seated within 
the slot. 

To remove a Memory Stick: 
1 Hold your Acer s10 securely. 

2 Release the card from the slot by using your thumb to push against the top of the 
card, as if you were pushing it further into the slot. An audible system sound will 
signal that the card has been released. 

3 Gently remove the card from the slot. 

Switching between your Acer s10 internal memory 
and a Memory Stick 

When you use a Memory Stick, Acer s10 creates and displays a new source category 
referring to the resident Memory Stick. You can then easily switch between the 
applications stored in your Acer s10 internal memory and on the Memory Stick. 

To switch source category to Memory Stick:
1 In Applications Launcher, tap the pick list in the upper-right corner of the screen. 

2 Tap the item referring to the resident Memory Stick. The contents of the resident 
Memory Stick will be displayed on the Applications Launcher screen.

NOTE: Name for the source category referring to the resident Memory Stick is 
user-configurable. Refer to "Renaming a card" on page 221 for more information. 

Copying applications to a Memory Stick 
You can copy applications from your Acer s10 to your Memory Stick and vice versa. 

To copy an application:

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

2 Tap Copy to display the Copy screen.

3 Select the source and the destination using the From and the Copy To pick lists

4 Select the application and then tap Copy. The application is copied to the selected 
destination. 



7 Using expansion features
Deleting applications from a Memory Stick

 219

NOTE: Some applications and databases are copy-protected and cannot be copied. These 
are listed with a lock icon next to them.

Deleting applications from a Memory Stick
To delete an application from a Memory Stick:

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

2 Tap Delete to display the Delete screen.

3 Tap the application you want to delete. 

4 Tap Delete. 

5 Tap Done. 

Displaying information for Memory Stick applications
To display information about an application on your Memory 
Stick:

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

2 Tap Info.
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3 In the Device pick list, tap the item referring to the resident Memory Stick. The size of 
the applications in the resident Memory Stick is displayed.

NOTE: The Memory Stick icon is displayed on the pick list with the corresponding card name 
indicated. This card name is user-configurable. 

4 To display the application version, tap Version.

NOTE: When you tap More, you access the Card Info application, described in the Using 
Card Info section.

Card Info
Card Info displays the summary information for each known directory type found in 
the resident Memory Stick. 
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Reviewing card information

1 In Applications Launcher, tap the Card Info icon .

Information on Card name, Type and Size are displayed as well as a summary of its 
contents by directory.

Renaming a card

1 In Applications Launcher, tap the Card Info icon .

2 Tap the Menu icon . 

3 Tap Rename Card to display the Rename Card dialog box. 

4 Enter the new name for the card. 

5 Tap Rename. 

Formatting a card

1 In Applications Launcher, tap the Card Info icon .

2 Tap the Menu icon . 
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3 Tap Format Card to display the Format Card dialog box.

4 Tap OK. 

NOTE: When you format a Memory Stick, all data stored on will be lost.

Card Info menu
The Card Info menu shown here is for your reference only. Features that are not 
explained in this section are discussed elsewhere in this Manual.

Card Info has only one menu: Card

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus. 

Card menu

Help Provides help text.

About Card Info Shows version information for Card Info. 
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8 Using the Attention 
Manager
Many applications (such as Date Book and Clock) want to get your attention with 
some sort of alarm. Attention Manager allows you to conveniently manage all of 
these notifications in one place. Appointments and messages can stack up while you 
are away from your device. Attention Manager lets you view them from a single list, 
where you can selectively dismiss or follow up on each event.

Applications will signal for your attention at two different levels: insistent and subtle. 
Each will be discussed in detail below.

Insistent alarms
Insistent applications open a Reminders dialog screen, and may play a sound or flash 
the LED indicator depending on your Alarm Preferences settings. Alarms continue 
until you snooze or dismiss them. If the sound can be interrupted, you can tap 
anywhere on the screen, or press any button to silence it. Attention Manager will 
always open immediately when new insistent alarms are posted.

Using the Reminder command buttons
The Reminder dialog screen has three buttons for responding to an alarm. 



8 Using the Attention Manager
Insistent alarms

224   

Setting the alarm volume
You control most alarm volumes globally in the General panel of the Prefs menu:

1 Tap the Applications icon , and then tap the Prefs icon .

2 Tap the General pick list in the upper right corner of the screen.

3 Set the volume using the Alarm Sound pick list. 

NOTE: Your Acer s10 has a LED indicator which you can set to flash when an alarm is 
activated by toggling the Alarm LED setting on and off. 

Setting alarm sound effects
Some applications allow you to set a song or a sound effect to use as an alarm, 
determine how many times to play it, with a pause in between. For example, to set 
alarm preferences for a Date Book alarm, do the following:

1 In Date Book, tap the Menu icon .

2 Tap the Options menu. 

3 Select Preferences to display the Preferences screen. 

OK Tap to make the reminder go away, with no further 
notification.

Snooze Tap to switch to the application that was running when the 
alarm went off. The Reminder dialog screen will again be 
displayed after five minutes.
You can go back to the Reminder dialog screen right away by 
tapping on the blinking indicator in the upper left corner of 
the screen. For more information, see “Understanding the 
blinking alarm indicator” later in this chapter.

Go To Tap to switch to the application that created the alarm, and 
show the record that caused the alarm. You may have to 
navigate within the application. There will be no further 
notification.
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4 Tap the Alarm Preset check box. If you want alarms to sound, define a value for the 
following by tapping on their respective pick lists:

Using the Reminders list screen
The Reminders screen changes to a list of items that require your attention under two 
insistent alarm conditions:

• When a second application attempts to get your attention and the first has 
not been dismissed or snoozed.

• When the same application makes a second attempt when the first Reminder 
screen has not been yet dismissed or snoozed.

Each listed reminder contains the date and time of the event. Depending on the 
application displaying the reminder, you may see an icon representing the application, 
and up to two lines of text. 

Tapping on the text or icon will “Go To” that item and delete the event from the 
Reminders list screen.

Tapping the check box will clear that item, similar to a To Do list item. The Attention 
Manager will draw a line through the text lines, pause for a moment, and then 
remove the item from the list, although the original data remains in the application.

Alarm Sound Sets the alarm sound effects, for example, Bird or Concerto.

Remind Me Sets how soon you want the alarm to sound before the event.

Play Every Sets how many times the alarm repeats before giving up; the 
pause between each time the alarm sounds
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The Reminders list screen displays three buttons that are used to respond to all of the 
items in the list:

For more detail, see “Understanding the blinking alarm indicator” below.

Subtle alarms
Some applications provide a visual, and an optional audible indication, but do not 
otherwise disrupt your workflow. Subtle alarms do not display a Reminders screen. 
Instead, a blinking indicator will flash in the upper left corner of the title bar (in 
applications that allow it) when an alarm is activated. 

Understanding the blinking alarm indicator
A blinking alarm indicator appears in the upper left corner of the screen in the menu 
bar (in applications that allow it) under the following conditions:

• While viewing a Reminders dialog screen, you tap the Done or the Snooze 
button.

• A subtle alarm is present.
The indicator appears in three different states:

• Off. The indicator is not shown at all when the list is empty.
• Blinking, two states: When the list is not empty and there are no new 

items, the “star” indicator will blink on and off until the list has been 
emptied.

Snooze Puts the Reminders list screen to sleep for five minutes. After this 
time interval, the Reminders list screen is displayed again. You 
can go directly to the Reminders list screen without waiting, by 
tapping the blinking alarm indicator. 

Done If the Reminders list appeared because of more than one 
insistent alarm, tapping Done closes the Reminders list screen, 
although the events will remain in the application that created 
them. The Reminders list screen will not appear again, unless you 
tap the blinking alarm indicator in the menu bar.

If the Reminders list appeared after you tapped the Snooze 
button, then tapped the blinking alarm indicator, then tapped 
the Done button, thereminder continue to snooze.

Clear All Removes all the items from the list, but does not close the 
Reminders screen. Tap this button to erase a list of events that 
have passed.
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• Blinking, three states: When a new subtle alarm is received, the star will 
alternate flashing solid, exploded, then off, until you view the new event.

Tapping the indicator opens the Attention Manager in list mode, even if 
there is only one item.
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9 Managing your 
desktop email 
One of Acer s10’s basic applications—Mail, enables you to manage the email you send 
and receive through your computer’s email application. You can read, reply to, 
compose, and delete emails on your Acer s10 once you’ve performed a HotSync 
operation.

You can send or receive email after you’ve performed a HotSync operation, either 
locally using your Acer s10’s cradle, or remotely using a modem.

Mail synchronizes the emails in the Inbox of your desktop email application with the 
emails in the Inbox on your Acer s10. 

You can do the following in Mail:
• View, delete, file, and reply to incoming emails.
• Create outgoing email items and drafts of email items.
• Create simple or complex filters, which will let you to decide which type of 

email Acer s10 retrieves from your computer’s email application.
• Use your Acer s10 in its cradle to send and retrieve email items from your 

computer’s email application.

Setting up the Mail application on your computer
Before you use the Mail application for the first time, make sure that your computer’s 
email application is installed and running. You must also set up the Palm Desktop 
software for use with your computer’s email application. 

NOTE: For instructions on how to set up Palm Desktop sodtware, refer to "Installing Palm 
Desktop software" on page 11.

Acer s10 supports various computer email applications, including: 

• Microsoft Exchange (version 4.0 or higher)
• Eudora (version 3.0.3 or higher)
• Lotus cc: Mail (versions 2.5, 6.0, and 7.0). 

You can view the full list of the supported applications when you set up Mail.
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If your computer’s email application does not appear on the list, you may still be able 
to manage your computer’s email application from your Acer s10 using special 
connection software, called a conduit, that lets you synchronize your computer’s email 
application and your Acer s10. Contact the vendor of your email application for more 
information.

Setting up the Mail application and HotSync options
The following instructions assume that you have installed Palm Desktop software on 
your computer, but have not yet set up Mail. 

To set up Mail on your computer:
1 Choose one of the following options:

• If you have not yet installed Palm Desktop software on your computer, install 
the software now. You will be prompted to set up Mail as part of the Palm 
Desktop installation.

• If you already installed Palm Desktop on your computer, and set up Mail, skip 
to the next procedure, to set up the HotSync options for Mail.

2 In the Windows taskbar, click Start.

3 Select Programs, select Palm Desktop Software, and then click Mail Setup to begin the 
setup.

4 Follow the instructions onscreen to set up your Acer s10 for use with your computer’s 
email application.

To set or change HotSync options for synchronizing 
the Mail application:

1 Do one of the following:

• In the bottom right corner of the Windows taskbar (in the system tray), click 

the HotSync Manager icon . 
• If the HotSync Manager icon does not appear on the taskbar, select Programs 

from the Start menu. Then select HotSync Manager from the Palm Desktop 
menu.

2 Choose Custom.

TIP: You can also choose Custom from the HotSync menu in Palm Desktop software.

3 Choose Mail from the list box.

4 Click Change.
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5 Select one of the following options:

NOTE: When you first set up Mail, Synchronize the Files is the default setting.

• To turn off Mail, select Do Nothing and then select the Set As Default check 
box.

6 Click OK. 

Synchronizing Mail with your email application
After you turn on and set up Mail, you must perform a HotSync operation to 
synchronize Mail with your computer’s email application. 

For complete information on using HotSync, refer to "11 Exchanging and updating 
data using HotSync operations" on page 253.

To open Mail:

• In Applications Launcher, tap the Mail icon  to display the Message list 
screen.

Synchronize the Files Synchronizes the email on your Palm Desktop software 
and your computer’s email application.

Desktop overwrites 
handheld

Replaces the email on your Acer s10 with the email in your 
computer’s email application. Use this option only if the 
two inboxes get out of sync for some reason. This setting 
applies to only one HotSync operation and then reverts to 
the default.

Do Nothing Turns off communication between your Acer s10 and your 
computer’s email application. This setting applies to only 
one HotSync operation and then reverts to the default.

Set As Default Changes the default setting for all HotSync operations.

Previously read
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Viewing, creating, and replying to email
The Mail application lets you create email that your computer’s application can send, 
and view, edit, and reply to email received from your computer. The first time you 
open the Mail application, it displays the Message list screen. 

Viewing email items
The Message list displays a list of your incoming email items, who sent them, and the 
date they were received. 

A check mark indicates that the emailhave already been read. Email items in bold text 
indicates a high-priority level.

To view email items:
• Tap an item in the Message list. 

By default, the Mail application shows only the From and Subject fields. You 
can display complete information about the sender, receiver, and copied 
recipients, as well as the subject and the date the email item was created. 

To change header information:
• Tap a header mode icon in the upper right corner of the screen:

NOTE: The header type you select is applied to all email items.

To close an email item
• To close an email item, tap Done.

Recipient
Sender

Time and date sent

email body

Subject

Header mode icons

Complete Header Display the complete information about the sender, 
receiver, and copied recipients, in addition to the 
subject and date the email item was created.

Abbreviated Header Redisplay the abbreviated header.
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Creating email items
You create email items in your Acer s10 the same way you create email in your 
computer’s email application: 

• Identify the recipient of the email item (To field). 
• Define a subject (Subject field). 
• Create the email body. 

At a minimum, all email items must contain information in the To and Subject fields.

You create original email items and replies in the New Message screen. 

To create an email item:
1 Tap New to display the New Message screen.

TIP: You can also create an email item by tapping New in the Message menu.

2 Enter the email address of the recipient, using the same format as you would from 
your computer’s email application. 

For example, if you’re sending an email item to a user on the same network, you don’t 
have to add Internet information, such as @mycorp.com.

3 To send a copy of the email item to additional recipients, tap the CC field, and enter 
the email addresses of the additional recipients, separating the addresses with a 
comma followed by a space.

4 Tap the Subject (Subj:) field and enter a subject for your email item. 

5 Tap the Body field and enter the text of your email item.

Tap New.
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NOTE: If the address, CC, subject, or body exceeds the capacity of the screen display, tap the 
name of the field (for example, tap “To:”) to expand that field. Tap Done to return to the 
New Message screen.

To reply to an email item:
1 Tap an email item in the Message List to display it onscreen.

2 Tap Reply to display the Reply Options screen
.

3 Tap the Reply To pick list to select who should receive the reply. There are three 
options:

• Sender 
• All (recipients) 
• Forward. To reply to someone who didn’t see the original email item.

4 Tap Include Original Text to include the original email message in the reply. Clearing 
the option creates a blank reply. 

5 If you selected Include Original Text, tap Comment Original Text to let you edit the 
original text. 

6 Tap OK.

7 Enter the text of your reply.

8 If you are forwarding the message, enter a recipient in the To field.

Tap to return to New Message screen.

Tap the name of the field to open it.
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9 Tap Send to place your reply in the Outbox. 

See "Storing and editing email items" on page 238 for more information.

The email items you create are stored in your Acer s10’s Outbox folder until you 
perform a HotSync operation to synchronize your device with your computer. 

Looking up an address
To identify the recipient of an email item, you must enter that person’s email address. 
You can either enter the data directly in the To or CC field, or use the Look Up 
command to access the information from your Address Book. 

To look up an email address:

1 In Applications Launcher, tap the Mail icon , and then tap New. 

2 In the New Message screen, tap either the To or CC field name to expand it.

3 Choose from the following options:

• Tap Lookup to display the Lookup dialog box. The Lookup screen lists all 
records that contain information in the email field.

• Enter the first few letters of the last name of the person whose address you 
want to find, and tap Lookup. If Acer s10 completes the desired address for 
you, tap Done to return to the New Message screen.

TIP: You can also display the Lookup dialog box from the New Message, To or CC screens by 
tapping the Menu icon on the front panel of your Acer s10; then tap Options and tap Lookup. 
Or use the Graffiti® Command stroke /L. 

4 In the Lookup dialog box, enter the first letter of the entry you want, to scroll to the 
first entry that begins with that letter. Enter additional letters to have the list scroll to 
the first entry that starts with those letters. 

5 Tap an address to select it, then tap Add. 

Tap Lookup.
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6 Tap Done to return to the New Message screen.

Adding details to email items
Before you send your email item, you can add additional information to the message 
if your computer’s email application supports the feature. For example, you can 
specify the message’s priority, create a blind carbon copy, add a signature, or confirm 
that the message was delivered or read. Your Acer s10 cannot attach an email item 
details or attributes that your computer’s email application doesn’t support. 

To add details to an email item:
1 In the New Message screen, tap Details.

2 Choose from the following options:

Tap here to enter address in field.

Tap to select.

Tap here.

 Priority Tap the pick list to display the Priority options. There are 
three options: High, Normal,and Low priority. 

 BCC Creates a blind carbon copy field in the New Message screen. 

Signature Attaches a previously defined text at the end your email.
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NOTE: The Priority and BCC setting must be set for each email item you create.

3 Tap OK.

4 If you selected the BCC option, in the New Message screen, tap the BCC field and 
enter an address. 

Creating a signature for your email item
A signature refers to defining information, such as your name, address, phone and fax 
numbers, and any other text you want to include. It is automatically added to the end 
of every email item you create. The signature is visible only to the email recipient, and 
does not appear in your email item. 

To create a signature:

1 Tap the Menu icon .

2 Tap Options, and then tap Preferences.

3 Tap the Signature text field and enter the text of your signature. 

4 Tap OK.

Confirm Read Requests a confirmation telling you when the email item was 
read.

Confirm Delivery Requests a confirmation telling you when the email item was 
delivered.

BCC field

Add signature text here.
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Storing and editing email items
Sending an email item from your device stores it in the Outbox folder until you 
perform a HotSync operation. You can edit unsent email as long as you have not yet 
performed a HotSync operation. 

You can also draft email items and store them until you’re ready to send them; 
another option is for you to file email items. 

Storing and editing unsent email items
The email items you send from your Acer s10 are actually stored in the device’s Outbox 
folder until you perform a HotSync operation to synchronize your device with your 
computer. During synchronization, Acer s10 transfers email items stored in the Outbox 
folder to your computer’s email application. The next time you send mail from this 
application, it sends the mail created on your Acer s10.

When you edit an email item, Acer s10 removes the item from the Outbox folder and 
displays the New Message screen, where you can edit the item and resend it, save it as 
a draft, or delete it.

For instructions on synchronizing your device, see "Synchronizing Mail with your 
email application" on page 231. 

To store an email item in the Outbox folder:
1 Create a new email item or reply to an item. 

2 Tap Send. 

To edit an unsent email item:
1 In the Mail list, tap the pick list in the upper right corner of the screen.

2 Select Outbox from the pick list.

3 Tap the email item you want to retrieve.

Tap here to display folder list.
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4 Tap Edit then change the email item as desired.

5 Choose from the following options:

• To return the email item to the Outbox, tap Send.
• To store the email item in the Draft folder, tap Cancel. When prompted, tap 

Yes.

Setting mail preferences
You can set preferences to prompt you before deleting mail:

1 Tap the Menu icon . 

2 Tap Options, and then tap Preferences. 

3 Tap Confirm Deleted Message to display a prompt before the mail is deleted.

Drafting email
You can save email items that you’re drafting and not ready to send by storing them 
in the Draft folder. 

To save an email item as a draft:
1 Create an email item.

2 Choose from the following options:

• Tap the Menu icon , tap Message, and then tap Save Draft.
• In the New Message screen, tap Cancel, and then tap Yes at the prompt.

To edit an email item saved as a draft:
1 In the Message screen, tap the pick list in the upper right corner of the screen.

2 Select Draft from the pick list.

3 Tap the email draft you want to display.

Tap here to 
select item.

Tap to 
edit item.
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4

5 Tap Edit.

6 Enter any changes.

7 Choose from the following options:

• To resave the draft in the Draft folder, tap the Menu icon , tap Message, 
and tap Save Draft; or tap Cancel and when prompted, tap Yes.

• To transfer the item to your Outbox folder, tap Send.

Filing an email item
You can file email in your Acer s10’s Filed folder. During a HotSync operation, Acer s10 
stores a backup copy of the Filed folder on your computer hard drive, but does not 
automatically synchronize the contents of this folder with your computer’s email 
application.

You can retrieve an email item from the Filed folder, edit it, send it, save it as a draft, 
or return it to the Filed folder.

To file an email item:
1 In the Message list, tap an email item to open it.

2 Tap the Menu icon . 

3 Tap Message, and then tap File.

4 Tap No to save the email item in the Filed folder. 

Tap Yes to file the item in the Filed folder and keep a copy in the Inbox.

To retrieve an email item from the Filed folder:
1 In the Mail list, tap Filed from the pick list in the upper right corner of the screen.

2 Tap the email item you want to restore.

3 Tap Edit to display and modify the item.

4 To store the email item, choose from the following options:

• Tap Cancel and tap Yes to store the item in the Draft folder.
• Tap Send to store the email in the Outbox.
• Return the message to the Filed folder, following the preceding procedure.

Tap here to 
display 
folder list.
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Deleting email items
When you delete an email item, Acer s10 stores it in the Deleted folder until you 
purge the folder’s contents or perform the next HotSync operation. You can purge the 
contents of the Deleted folder to avoid having deleted emails monopolize your 
Acer s10’s storage space. Synchronization deletes the email item, as well as purged 
items, from your computer’s email application.

You can restore a deleted email item by removing it from the Deleted folder, if you 
haven’t purged the folder contents or performed a HotSync operation yet.

To delete and email:
1 In the Message list, tap the email you want to delete. 

2 Tap Delete. 

3 Tap Yes. 

To restore an email item by moving it out of the Deleted folder:
1 In the Mail list, tap Deleted from the pick list in the upper right corner of the screen.

2 Tap the email item you want to restore. 

3 Choose from the following options:

• If you created the email item that you deleted, tap Edit to display and modify 
the item. You can send the item or save it as a draft.

• If you received the email item that you deleted, tap Undelete to move the 
selected item to the Inbox and mark it as Read.

To purge the contents of the Deleted folder:

1 Tap the Menu icon . 

2 Tap Message. 

3 Tap Purge Deleted.

4 Tap Yes. 

NOTE: You cannot restore email items after you purge them.

To display a prompt before email is deleted: 

1 In the Mail list or in a Message screen, tap the Menu icon . 

2 Tap Options, and then Tap Preferences.

3 To display a prompt, tap the Confirm Deleted Message screen. 

To delete a message without a prompt, clear the check box.
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Categorizing and sorting email items
You can display email items by the folders Acer s10 provides for categorizing mail, and 
according to the email date. 

NOTE: By default, the Date column is hidden in the Mail list to increase the available screen 
space. 

You can also sort email items by the date sent, by sender, or by subject. No matter how 
you sort the list, high-priority email items always appear first.

To select an email folder to display:
1 In the Mail list, tap the pick list in the upper right corner or your screen to display the 

list of folders.

2 Tap a folder you want to display in the Message list screen. Options include: 

3 Repeat steps 1 and 2 to choose another folder. 

To display the Date column in email items:
1 In the Mail list, tap Show.

2 Tap the Show Date check box to select it. 

Inbox Contains email items received from your computer’s email 
application Inbox, except any excluded using filtering 
options. 
Refer to "Using filters to control downloading" on page 244 
for more information on filtering options.

Outbox Contains email items you created and sent on your Acer s10 
since the last HotSync operation.

Deleted Contains any email you deleted since the last HotSync 
operation

Filed Contains email items that you’ve stored on your Acer s10

Draft Contains the email items you’ve created using your Acer s10 
but have not yet sent.

Tap Show.
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3 Tap OK.

To sort the Message List:
1 In the Mail list, tap Show.

2 Tap the Sort By pick list and tap one of the following options to select it:

3 Tap OK. 

Managing your email application with HotSync
You can manage your email application more effectively by selecting HotSync options 
to control which email items to download when you synchronize your Acer s10 and 
your computer. You can define different settings for local and remote 
synchronization. 

For example, you may want to download all of your email items when you’re working 
at the office and synchronizing your devices locally, but only urgent email items when 
you’re away from your office and synchronizing your devices remotely. Once your 
local and remote options have been defined, your Acer s10 determines if 
synchronization is occurring locally or remotely and uses the appropriate settings for 
the HotSync operation.

You can filter messages to control which ones to download, and you can set 
truncation options to download only part of lengthy email items.

Downloading transmits only email items and any text information, not attachments, 
to your Acer s10. Downloaded attachments are left in your computer’s email 
application. 

To set HotSync Options to control synchronizing 
email items:

1 In Applications Launcher, tap the Mail icon .

2 Tap the Menu icon .

3 Tap Options, and then tap HotSync Options.

Date Sorts email by date and displays the most recent email item at 
the top of the screen.

Sender Sorts email by the sender’s user name and displays items in 
ascending alphabetical order, based on the first word on the 
From field.

Subject Sorts email by the subject and displays items in ascending 
alphabetical order, based on the first word on the Subject 
field.
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4 Tap the Settings For pick list, and select Local HotSync or Remote HotSync.

For more information on Local and Remote HotSync operations, refer to "11 
Exchanging and updating data using HotSync operations" on page 253. 

5 Tap the filtering option you want to apply during synchronization:

6 Choose from the following options:

• If you selected All, Send Only, or Unread, tap OK. 
• If you selected Filter, continue to the next section.

Using filters to control downloading
You can create special filters to control the type of email items that you download to 
your Acer s10 during synchronization. Special filters ignore or retrieve items that 
contain specific information in their header fields, according to what you’ve 
instructed your Acer s10 to look for in the To, From, and Subject fields. 

To access the special filter screen: 

1 Tap the Applications icon , and then tap the Mail icon .

2 Tap the Options menu, then select HotSync Operations.

Tap here to 
display 
HotSync 
options. 

All Download all email items in your computer’s Inbox to your 
Acer s10, and to send all email items in your Acer s10’s Outbox 
to your computer’s email application.

Send Only Send only email items in your Acer s10’s Outbox to your 
computer’s email application; from there, your computer’s 
email application sends the items to their destinations

Filter Download all email items that meet specific criteria from your 
computer’s Inbox to your Acer s10, and to send email items 
that meet specific criteria from your Acer s10’s Outbox to your 
computer’s email application. 
When you select the Filter setting, the HotSync Options dialog 
box opens and displays additional filter settings. 

Unread Download only unread email items from your computer’s 
Inbox to your Acer s10, and all items in your Acer s10’s Outbox 
to your computer’s email application
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3 In the HotSync Options dialog box, tap Filter.

To create the special filter settings:
1 On the HotSyns Options dialog box, choose from the following filter options:

• Retrieve All High-Priority. If your email application can flag high-priority 
items, tap this option to retrieve these items and override any filter settings

• To define whether to ignore of receive and an email that meets filter 
settings, tap the pick list on the middle of the screen. 

Options include:

• To define a filter string, fill-out the To, From, and Subject fields. 
• Truncate. To stop long email items from downloading, and then specify a 

number of characters, between 250 and 8,000 (the default is 4,000.) Tap OK.
A lower Truncate value reduces the time to synchronize your computer’s 
email and Mail; less email storage space in your Acer s10 will also be used. 
Messages longer than 8,000 characters will be truncated.

Tap here to select Filter option.

Tap here 

Ignore Messages 
Containing

To have Acer s10 exclude email items that meet the defined 
criteria and download all other email items during 
synchronization. In general, this filter downloads more email 
during synchronization because it blocks only one defined 
subset of email

Retrieve Only Msgs 
Containing

To have Acer s10 include only the email items that meet the 
defined criteria and ignore all other email items during 
synchronization. This filter can block more email during 
synchronization because it downloads only one subset of 
email.
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2 Tap OK.

Defining filter strings
Acer s10 filters email items based on information in their To, From, and Subject fields, 
called a filter string. You create a filter string by listing the words you want Acer s10 to 
find and separating them by either a comma or a space. Each word in the filter string 
is joined by an implicit OR; Acer s10 adds the logical connectors like AND or OR.

To create a more complex filter, you can define filter strings for the To, From, and 
Subject fields. Acer s10 joins the filter strings for these fields using an implicit AND, 
and adds the logical connector for you.

For example, you might want to receive only email items from John Smith 
(jsmith@aol.com) or Jack Jones (jjones@aol.com) concerning the Apollo Project. You 
would create the following filter strings:

• In the To field: jsmith@aol.com, jjones@aol.com
• In the Subject field: Apollo Project

Acer s10 interprets this as, “Accept email items about the Apollo Project from John 
Smith or Jack Jones. Do not accept email items from other people. Do not accept email 
items from John or Jack about any other subject.”

When you define a string, Acer s10 searches for any instance of that sequence of 
characters. For example, if you define a filter that retrieves only email items with the 
string “info,” appropriate matches would include “info,” “rainforest” and “kinfolk.” 

To define a filter string:
1 Tap the To, From, or Subject header field in the HotSync Options dialog box. 

Tap here. 

Tap to
select 
maximum 
length.

Tap here 
to insert 
cursor.
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2 Enter your filter string, using commas or spaces to separate the words. Do not add 
connectors, such as AND or OR, between words in a string.

3 If your string exceeds the length of the field, tap the name of the field to display the 
Notes screen for that header field. 

4 Tap Done to return to the HotSync Options dialog box.

5 Tap OK.

Mail menus
Mail menus are shown here for your reference only. Features that are not explained in 
this section are discussed elsewhere in this Manual.

Mail has two menus: Message and Options.

See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

Message menu
The Message menu differs depending on whether you are viewing an email item, 
creating an email item or viewing the Message list. 

Illustration suggestion (Delete this suggestion when completed): Message
menu with drop-down box from the three different views: Message list,
New Message screen and open email item

Options menu
The Options menu differs depending on whether you are creating or editing an email 
item. 

Illustration suggestion (Delete this suggestion when completed): Options
menu with drop-down box from the two different views: Message list and
New Message screen

Tap here. 

Tap Done to 
return to 
HotSync 
Options.

About Mail Displays version information for Mail.

Enter 
filter data.
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10 Beaming information
Your Acer s10 is equipped with an IR (infrared) port that you can use to beam 
information to another Palm OS handheld that is close by and also has an IR port. The 
IR port is located at the top of the your Acer s10, behind the small dark shield. 

You can beam the following information between Palm OS handhelds:

• The record currently displayed in Date Book, Address Book, To Do List, or 
Memo Pad.

• All records of the category currently displayed in the Address Book, To Do 
List, or Memo Pad applications.

• A special Address Book record that you designate as your business card, 
containing information you want to exchange with business contacts.

• An application installed in RAM memory.
• An application installed on an resident Memory Stick. 

NOTE: HotSync operations can also be done using the IR port. Refer to "IR HotSync 
operations" on page 258 for more information. 

Beaming a business card
To select a business card for beaming:

1 Press the Address Book button on the front panel of your Acer s10.

2 In the Address List, do one of the following: 

• Create a new entry to contain the information you want on your business 
card.

• Select an existing entry containing the information you want on your 
business card. 

3 In Address view, tap Record. 

4 Tap Select Business Card. 

5 Tap Yes.
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Beaming a record
To beam a record, business card, or category of records:

1 Locate the record, business card, or category you want to beam.

2 Tap the Menu icon .

3 Tap Record.

4 Choose from the following options:

• Tap Beam to beam an individual item.
• In the Address Book application only, tap Beam Business Card.
• Press the Address Book application button for about two seconds to beam 

your business card.
• Tap Beam Category (for records that are displayed in a category).
• Draw the Graffiti Command stroke to activate the toolbar, and then tap the 

Beam icon. 
• Use the Graffiti Command stroke /B to beam the current entry.

NOTE: You can set the full-screen pen stroke to beam the current entry. Refer to “To 
change what the full-screen pen stroke activates” on page 271 for instructions. 

5 When the Beam Status dialog box appears, point the IR port directly at the IR port of 
the receiving handheld.

TIP: For best results, Acer s10 handhelds should be between 10 centimeters (approximately 4 
inches) and 1 meter (approximately 39 inches) apart, and the path between the two devices 
must be clear of obstacles. Beaming distance to other Palm OS handhelds may be different.

When the Beam Status dialog box indicates that the transfer is complete, you can 
resume working on your Acer s10.

Beaming an application
To beam an application:

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 

2 Tap App, and then tap Beam.

3 Tap the application you want to transfer, and tap Beam.
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NOTE: Some applications are copy-protected and cannot be beamed; this is indicated by a 
lock icon next to application icon.

4 When the Beam Status dialog box appears, point the IR port directly at the IR port of 
the receiving device.

When the Beam Status dialog box indicates that the transfer is complete, you can 
resume working on your Acer s10.

Receiving beamed information
To receive beamed information:

1 Turn on your Acer s10.

2 Point the IR port directly at the IR port of the transmitting handheld to open the 
Beam Status dialog box.

3 On the Beam Status dialog box, select a category for the incoming information, create 
a new category or leave it unfiled.

4 Tap Yes.

5 Wait for the Beam Status dialog box to indicate that the transfer is complete, and 
then tap OK to display the new entry. 

NOTE: Incoming records, unless categorized, are placed in the Unfiled category.

Turning off beaming
To turn beaming on or off:

1 In Applications Launcher, tap the pick list in the upper right corner of the screen. 

2 Tap Select All or System. 

3 Tap Preferences.
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4 In the pick list in the upper right corner, tap General.

5 In the General Preferences screen, tap the Beam Receive pick list, and then tap On or 
Off to select the option.
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11 Exchanging and updating 
data using HotSync operations

HotSync® technology lets you synchronize—exchange and update—data between one 
or more Acer s10 handhelds and Palm Desktop software or another PIM such as 
Microsoft Outlook. To synchronize data, you must connect your Acer s10 and Palm 
Desktop software either directly, by placing your handheld in the cradle attached to 
your computer or using infrared communications, or indirectly, with a modem or 
network.

The HotSync process automatically synchronizes data between your Acer s10 and Palm 
Desktop software. Changes you make on your Acer s10 or on your Palm Desktop 
software appear in both places after a HotSync operation. HotSync technology 
synchronizes only the needed portions of files, thus reducing synchronization time. 

Performing a HotSync operation 
The first time you synchronize your data, you must enter user information on both 
your Acer s10 and Palm Desktop software. After you enter this information and 
synchronize, the HotSync Manager recognizes your Acer s10 and doesn’t ask for this 
information again.

Creating a user profile
If you are a System Administrator preparing several handhelds for a group of users, 
you may want to create a user profile. 

NOTE: You can create a user profile to load data into a handheld without associating that 
data with a user name, using the File Link feature. File Link lets system administrators to 
configure several handhelds with specific information (such as a company phone list) before 
distributing them to their actual users. Refer to "Using File Link" on page 267 for more 
information. 

To create a user profile:
1 Open Palm Desktop software.

2 From the Tools menu, choose Users.

3 Click Profiles. 

4 Click New. 

5 Enter a unique name for the profile, and click OK.
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Performing the first HotSync operation

IMPORTANT: You must perform your first HotSync operation with a local, direct connection 
or with infrared communication, rather than using a modem.

The following steps assume that you have already installed the Palm Desktop 
software. If you have not yet installed this software, refer to "Installing Palm Desktop 
software" on page 11 for instructions.

To perform the first HotSync operation:
1 Insert your Acer s10 into the cradle.

2 If the HotSync Manager is not running (i.e., the HotSync Manager icon  is not visible 
in the bottom right corner of the Windows system tray) start it: 

• On Windows desktop, click Start, and then choose Programs. 
• Navigate to the Palm Desktop program group and choose HotSync Manager. 

Alternatively, you can start the Palm Desktop software which automatically 
opens the HotSync Manager.

3 Press the HotSync button on the cradle.
.

NOTE: If you are using an optional USB or Serial sync cable instead of a cradle, click the 
HotSync Manager icon in the bottom right corner of the Windows system tray, then select 
Local from the menu.

4 Enter a user ID in the New User dialog box and click OK. The HotSync Progress dialog 
box appears and synchronization begins.

IMPORTANT: Every handheld should have a unique name. To prevent loss of of user’s 
records, never try to synchronize more than one handheld to the same user name.
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5 Wait for a message on your Acer s10 screen indicating that the process is complete.

6 When the HotSync process is complete, you can remove your Acer s10 from the cradle 
by gently tilting the handheld forward and then pulling it up to remove.

Selecting HotSync setup options
You can choose when you want HotSync Manager to run. If necessary, you can adjust 
the local and modem HotSync settings as well.

To set the HotSync options:

1 Click the HotSync Manager icon  in the Windows system tray.

2 Choose Setup. 

3 Click the General tab, and select one of the following options:

Always Available Default setting. Adds HotSync Manager to the Startup 
folder and constantly monitors the communication 
port for synchronization requests from your Acer s10. 
With this option, the HotSync Manager synchronizes 
data even when Palm Desktop is not running.
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If you’re not sure which option to use, keep the default setting.

4 If you are using a Serial sync cable, click the Local tab to display the settings for the 
connection between your computer and the Serial sync cable.

NOTE: If you are using a USB cradle, you do not need to use the settings on the Local tab 
for a direct HotSync operation. 

5 Adjust the following options as needed:

6 Click the Modem tab to display the modem settings and adjust the options as needed.

For more information on HotSync operations via modem, refer to page 261.

Available Only When Palm 
Desktop software is 
running 

Starts HotSync Manager and monitors requests 
automatically when you open Palm Desktop software.

Manual Monitors requests only when you select HotSync 
Manager from the Start menu.

 Serial Port Identifies the port that HotSync Manager uses to 
communicate with the Serial sync cable. The Palm 
Desktop software automatically detects the port to 
which you connected the Serial sync cable. If necessary, 
you can change the port selection. 

NOTE: The selection should match the number of the port 
to which you connected the Serial sync cable. Acer s10 
cannot share this port with an internal modem or anoother 
device. 

Speed Determines the speed at which data is transferred 
between your Acer s10 and Palm Desktop software.
Try the As Fast As Possible rate first, and adjust 
downward if you experience problems. This setting 
allows Palm Desktop and your Acer s10 to find and use 
the fastest speed.
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7 If you are attached to a network, click the Network tab to display the network settings 
and adjust the options as needed. 

For more information on HotSync operations via network, refer to page 264.

8 Click OK.

Customizing HotSync application settings
For each application, you can define a set of options that determines how records are 
handled during synchronization. These options are called a “conduit.” By default, a 
HotSync operation synchronizes all files between your Acer s10 and Palm Desktop 
software.

In general, you should leave the settings to synchronize all files. The only reason you 
might want to change these settings is to overwrite data on either your Acer s10 or 
Palm Desktop software, or to avoid synchronizing a particular type of file because you 
don’t use it.

In addition to the conduits for Date Book, Address Book, To Do List, Memo Pad, and 
Expense, Palm Desktop software includes System and Install conduits. 

The System conduit backs up the system information stored on your Acer s10, 
including Graffiti® ShortCuts. 

The Install conduit installs applications on your Acer s10. 

To customize HotSync application settings:.

1 Click the HotSync Manager icon  in the Windows system tray. 

TIP: You can also click the HotSync command on the Palm Desktop software menu bar.

2 From the HotSync Manager menu, choose Custom.

3 Select the appropriate user name from the list.

4 Select an application in the Conduit list. 

5 Click Change.

6 Click the direction in which you want to write data, or click Do Nothing to skip data 
transfer for an application.
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7 Choose how long the setting will remain in effect:

• To have the setting affect only the next HotSync operation, deselect the 
Default button. Thereafter, the HotSync Actions revert to their default 
settings. 

• To use a new setting as the default, select the option. Thereafter, whatever 
you selected as the default setting is used when you click the Default button 
in the Custom dialog.

8 Click OK.

9 Repeat steps 4 through 8 to change conduit settings for other applications.

10 Click Done to activate your settings.

IR HotSync operations
Your Acer s10 is equipped with an infrared (IR) port that supports the IrCOMM 
implementation of the standards for infrared communication established by the 
Infrared Data Association (IrDA). This means that not only can you beam data to 
another Palm OS handheld but also to any other device that supports the IrCOMM 
implementation of the IrDA standards. 

But more importantly, your IR port allows you to perform HotSync operations without 
using a cradle. This is very useful if you travel with an infrared-enabled laptop. You 
simply enable infrared communication on your laptop and on your Acer s10, then 
follow the steps"Performing an IR HotSync operation" on page 260. 

Preparing your computer for infrared communication
Before you can perform a HotSync operation using the IR port, the computer you 
want to synchronize with must meet the following requirements:

• The computer must support the IrCOMM implementation of the IrDA 
standards.

• The computer must have an enabled infrared port built-in, or an enabled 
infrared device attached to the computer.
Desktop computers are likely to require an infrared device attached to a 
physical COM port. Laptops are likely to have a built-in IR port. 

NOTE: Check your computer’s documentation to determine if the computer supports 
infrared communication.
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• Your computer must also have an installed infrared driver. If you have an 
external infrared device attached to your computer, a driver is probably 
included with the device. Consult the documentation that came with your 
device for information on installing the required driver. 

NOTE: Infrared communication is built into the operating system for Microsoft Windows 98 
and later versions. 

To check your computer for IR capability:

1 Click Start  in the Windows taskbar.

2 Choose Settings, and then choose Control Panel.

3 In the Control Panel look for the Infrared icon.

If the icon is there, your computer is enabled for infrared communication. If it isn’t 
there, you need to install an infrared driver.

After you install the infrared driver or determine that the infrared driver is already 
installed, check the ports used by your computer for infrared communication.

To check the ports used for infrared communication:

1 Click Start  in the Windows taskbar.

2 Choose Settings, and then choose Control Panel.

3 Double-click Infrared.

4 Click the Options tab.

5 Select Enable infrared communication.

Illustration suggestion (Delete this suggestion when completed): Show
Options tab of Infrared Monitor screen.

The COM port displayed in the drop-down box is the port where your infrared device 
is attached. It should be different from any port used by the HotSync Manager.

6 Make a note of which port is listed as “Providing application support”. 

You need this information to configure the HotSync Manager for infrared 
communication. This port is the simulated port. It is the channel through which the 
actual infrared communication takes place between your computer and your Acer s10. 

7 Deselect all other check boxes in the Options tab.

8 Click Apply. 

9 Click OK.

Configuring HotSync Manager for infrared communication
Next you need to go to the HotSync Manager and specify the simulated port used for 
infrared communication.
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To configure HotSync Manager for infrared communication:
Click the HotSync Manager icon  in the Windows system tray and make sure 
Infrared is checked.

If you do not have an Infrared option on the HotSync Manager menu, complete the 
following steps. 

1 Make sure Local is checked on the menu.

2 Choose Setup.

3 Click the Local tab.

4 In the Serial Port drop-down box, select the the simulated port that your computer 
uses for infrared communication. 

NOTE: Refer to the documentation of your operating sytem for instructions on finding the 
simulated port. This information is usually contained in the Control Panel.

5 Click OK.

The HotSync Manager is now communicating with the simulated port defined for 
infrared communication.

NOTE: If your cradle is connected to a USB port, you can continue using it while HotSync 
Manager is configured for infraded communication. 

Performing an IR HotSync operation
After you complete the steps to prepare for an IR HotSync operation it is easy to 
perform the actual operation.

To perform an IR HotSync operation:

1 In Applications Launcher, tap the HotSync icon .

2 Tap Local.

3 Tap the pick list below the HotSync icon and select IR to a PC/Handheld.

Illustration suggestion (Delete this suggestion when completed): Side-by-
side illustrations. 1. Show HotSync Welcome screen with IR to a PC/
Handheld displayed in the pick list. 2. Show HotSync Connecting with
desktop screen.

4 Position the IR port of your Acer s10 within a couple of inches of the infrared port of 
your computer.

5 Tap the HotSync icon  to start the IR HotSync operation.

Returning to using the cradle for HotSync operations
It’s easy to return to using the cradle for HotSync operations.
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NOTE: If you are using the provided USB cradle, you can continue using it while HotSync 
Manager is configured for infrared communication. Use the following instructions to return 
to Local USB cradle HotSync operations only when needed, such as when you have 
disconnected the cradle from the USB port. 

To return to local USB cradle HotSync operations:
1 If needed, connect the cradle to the USB port on your computer used for HotSync 

operations. 

2 Click the HotSync Manager icon . in the Windows system tray.

3 Select Local USB if it is not already checked.

Performing a HotSync operation via modem
You can use a modem, to synchronize your Acer s10 when you are away from your 
computer.

NOTE: The first HotSync operation must be local, using the cradle or via infrared 
communication. After that, you can perform a modem HotSync operation.

To perform a HotSync operation via modem you must complete the 
following steps:

• Connect a modem to your computer.
• Configure the Palm Desktop software for use with your modem.
• Connect a modem to your Acer s10.
• Configure the Modem preferences on your Acer s10 for use with your modem 

(Serial to Modem or IrCOMM to Modem). 
Refer to "Connection preferences" on page 272 and "Network preferences" 
on page 279 for more information. 

Preparing your computer
You must perform a few steps to prepare your computer for a modem HotSync 
operation. Be sure to perform these steps before you leave your office so that your 
computer is ready to receive a call from your Acer s10. 

To prepare your computer for a modem HotSync operation:
1 Confirm that the computer modem is connected and turned on, and that no 

communications applications, such as fax or telephony software, are running on a 
COM port.

NOTE: Make sure that the computer is disconnected from all online services, such as 
America Online (AOL) and CompuServe, to avoid conflicts with the COM port.

2 Start HotSync Manager if it is not already running, and from the HotSync Manager 
menu, choose Modem.
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3 Adjust the following options as needed:

4 Click OK.

Preparing your Acer s10
In addition to preparing your computer, you must perform a few steps to prepare your 
Acer s10 for a modem HotSync operation. 

To prepare your Acer s10 for a modem HotSync operation:

1 In Applications Launcher, tap the HotSync icon .

2 Tap Modem.

3 Tap the pick list below the icon and select a modem configuration. 

Serial Port Identifies the port for the modem. If you are unsure of 
the port assignment, look at the Modem Properties in 
the Windows Control Panel. 

Speed Determines the speed at which data is transferred 
Try the As Fast As Possible rate first, and adjust 
downward if you experience problems. This setting 
allows Palm Desktop and your Acer s10 to find and use 
the fastest speed.

Modem Identifies the modem type or manufacturer. Refer to 
your modem manual or face plate for its type or 
settings. If you’re not sure of your modem type or your 
modem doesn’t match any that appear in the list, select 
Hayes Basic.

Setup String Identifies the setup string for your particular modem. 
Not all modems require a setup string. Refer to your 
modem manual and enter the setup string if 
recommended by the manufacturer.
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Illustration suggestion (Delete this suggestion when completed): screen-
shot of select a modem configuration

NOTE: If you need to create a configuration, tap the Menu icon and then select Options > 
Connection Setup. For more information, Refer to "Connection preferences" on page 272 and 
"Network preferences" on page 279 for more information. 

4 Tap the Enter phone # field.

NOTE: If you plan to connect to your company’s dial-in server (network modem) instead of 
connecting to a computer modem, refer to "Performing a HotSync operation via a network" 
on page 264. 

5 Enter the telephone number to access the modem connected to your computer.

6 If needed, enter a dial prefix (such as “9”) to access an outside line, and then tap the 
Dial Prefix check box.

TIP: You can enter a comma in the field to introduce a “pause” in the dialing sequence. 

7 If the phone line you’re using for your Acer s10 has Call Waiting, select the Disable call 
waiting check box to avoid an interruption during the modem HotSync operation. 

8 If you want to use a calling card to place the call, select the check box and enter the 
calling card number. 

9 Tap OK.

Selecting conduits for a modem HotSync operation
The Conduit Setup dialog box on your Acer s10 lets you define which files, 
applications, or both on your handheld synchronize during a modem HotSync 
operation. This is to minimize the time required to synchronize data with a modem. 

To change the Conduit Setup settings for a modem HotSync 
operation:

1 In the Applications Launcher, tap the HotSync icon .
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2 Tap the Menu icon . 

3 Tap Options, and then tap Conduit Setup.

4 In the Conduit Setup dialog box, tap the check boxes to deselect the files and 
applications that you do not want to synchronize during a modem HotSync operation. 
The default setting is to synchronize all files. 

NOTE: Applications that do not have a database (such as games) do not synchronize even if 
you select the item in the Conduit Setup dialog box.

5 Tap OK.

Performing a HotSync operation via a modem
After you prepare your computer and your Acer s10, and select your Conduit Setup 
options, you are ready to perform a modem HotSync operation.

To perform a modem HotSync operation:

1 In Applications Launcher, tap the HotSync icon . 

2 Tap the Modem icon to dial the Palm Desktop modem and synchronize the 
applications.

Illustration suggestion (Delete this suggestion when completed): Modem
icon

3 Wait for the HotSync operation to complete.

Performing a HotSync operation via a network
When you use the Network HotSync software, you can take advantage of the LAN and 
WAN connectivity available in many office environments. The Network HotSync 
technology lets you perform a HotSync operation by dialing in to a network or by 
using a cradle that is connected to any computer on your LAN or WAN (provided that 
the computer connected to the cradle also has the Network HotSync software 
installed, your computer is on, and the HotSync Manager is running).
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To perform a HotSync operation via a network, you must meet the following 
requirements:

• Your computer has TCP/IP support installed.
• Both your company’s network system and its remote access server support 

TCP/IP. (Your system administrator has this information.)
• You have a remote access account. (If you don’t have an account, consult your 

system administrator.)
Everything you need to connect to your company’s dial-in server (network modem) is 
included in the Palm Desktop software and in your Acer s10. You need to activate the 
feature, however, on both Palm Desktop software and on your Acer s10.

To prepare your computer for a network HotSync operation:
1 Click the HotSync Manager icon in the Windows system tray.

2 From the HotSync Manager menu, choose Network.

3 From the HotSync Manager menu, choose Setup.

4 Click the Network tab and make sure that a check mark appears next to your user 
name. If no check mark appears, select the check box next to your user name.

5 Click OK.

6 Place your Acer s10 in the cradle, and perform a HotSync operation.

The HotSync operation records network information about your computer on your 
Acer s10. With this information, your Acer s10 can locate your computer when you 
perform a HotSync operation over the network.
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To prepare your Acer s10 for a network HotSync operation:

1 In Applications Launcher, tap the HotSync icon . 

2 Tap the Menu icon .

3 Tap Options, then tap Modem Sync Prefs.

4 Tap Network.

Illustration suggestion (Delete this suggestion when completed): screen-
shot of Modem Sync Prefs

5 Tap OK.

6 Tap Select Service. 

Illustration suggestion (Delete this suggestion when completed): screen-
shot of tapping Select Service

7 Tap Service and select a service. 

Illustration suggestion (Delete this suggestion when completed): screen-
shot of tapping Service

8 Tap Done. 

9 Tap the Menu icon . 

10 Tap Options, then Conduit Setup. 

11 In the Conduit Setup dialog box, tap the check boxes to deselect the files and 
applications that you do not want to synchronize during a modem HotSync operation. 
The default setting is to synchronize all files. 

12 Tap OK. 

Performing a HotSync operation via a network
After you prepare your computer and your Acer s10, and select your Conduit Setup 
options, you are ready to perform a network HotSync operation.

To perform a network HotSync operation:
• Tap the Modem HotSync icon to begin the operation. 

Illustration suggestion (Delete this suggestion when completed): screen-
shot of Modem HotSync icon
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Using File Link
The File Link feature lets you import Address Book and Memo Pad information into 
your Acer s10 from a separate external file such as a company phone list. HotSync 
Manager stores the data in a separate category on your Palm Desktop software and 
on your Acer s10. You can configure the File Link feature to check for changes to the 
external file when you perform a HotSync operation. 

With File Link, you can import data stored in any of the following file formats:

• Comma delimited (.csv)
• Tab delimited (.tsv)
• Memo Pad archive (.mpa)
• Address Book archive (.aba)
• Text (.txt)

For information on how to set up a file link, see the Palm Desktop software online 
Help.
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12 Setting preferences 
for your Acer s10
Using the Preferences screen, you can customize the configuration options of your 
Acer s10. These options include:

Selecting the Preferences screen
You set preferences to customize your device. To open the Preferences screen, do the 
following:

1 Tap the Applications icon .

2 On the All or System screen, tap the Prefs icon . 

Screen shows the most recently accessed Preferences option.

3 Tap the pick list in the upper right corner of the screen.

Buttons Assign different applications to the buttons on front panel of 
your Acer s10 and to the HotSync button on the cradle, and 
reaasign the full-screen pen stroke command.

Connection Configure cradle, modem, and infrared communication 
settings.

Date and Time Set the date, time, time zone and Daylight Saving Time (DST) 
switch.

Digitizer Calibrate the screen of your Acer s10.

Formats Set the country default and the formats for date, times, 
calendar, and numbers.

General Set the auto shut-off interval, the Stay on in Cradle feature, 
the system, alarm, and game sounds; and the Beam Receive 
feature.

Network Configure your Acer s10 for use with a network.

Owner Assign your name, phone number, and other owner 
information to your Acer s10.

Phone Select the connection type for your phone applications.

ShortCuts Define a list of Graffiti abbreviations.
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4 Select the Preferences option you want to view. 

Buttons preferences
Buttons preferences let you assign different applications to the buttons on the front 
panel of your Acer s10, and to the HotSync button on the cradle. For example, if you 
find that you seldom use the To Do List and often use Mail, you can assign the To Do 
List button to start the Mail application.

You can also use the Buttons preferences to determine whether the full-screen pen 
stroke activates the Graffiti Help application or one of your Acer s10 controls.

To change the Buttons preferences:
1 In the the Button Preferences screen, tap the pick list next to the button you want to 

re-assign.

2 Tap the application that you want to assign to that button.

TIP: To restore all of the buttons to their factory settings, tap Default.

To change the HotSync buttons preferences:
1 In the Buttons Preferences screen, tap HotSync to display the HotSync Buttons screen. 

need new screen?
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2 Tap the pick list next to the button you want to assign.

3 Tap the application you want to assign to each button. 

The default setting for each button is the HotSync setting, which means the cradle 
and the optional modem perform their normal HotSync functions.

4 Tap OK.

To change what the full-screen pen stroke activates:
1 In the Buttons Preferences screen, tap Pen to display the Pen screen.

2 Tap the pick list, and tap one of the following settings for the full-screen pen stroke:

3 Tap OK.

Tap arrow to 
show pick list.

need new screen?

Backlight Turns on the backlight of your Acer s10.

Keyboard Opens the onscreen keyboard for entering text characters.

Graffiti Help Opens a series of screens that show the complete Graffiti 
character set.

Turn Off & Lock Turns off and locks the Acer s10. You must assign a 
password to lock your handheld. When locked, you need to 
enter the password to use your Acer s10. Refer to "Locking 
your Acer s10" on page 43.

Beam Data  Beams the current record to another IR-enabled device that 
is near your Acer s10. Refer to "10 Beaming information" on 
page 249.
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Connection preferences
The Connection Preferences screen allows you to create configurations for 
communicating with a PC, a modem, or a GSM mobile phone. Configurations, or 
profiles, once activated are available to various end-user applications running on your 
Acer s10. 

The Connection Preferences screen displays a list of available configurations that can 
be modified to reflect the required settings. This list will vary depending on the 
software you have added to your Acer s10.

Connection Types
There are five basic types of connections you can choose from when configuring your 
preferences. They are described here:

Standard Modem This connection type defines a connection between a 
modem attached to the versatile port of your Acer s10 and a 
modem.

Cradle/Cable This connection type defines the direct cradle/cable 
connection between your Acer s10 and your computer. It is 
used when performing a local HotSync operation. Your 
Acer s10 is connected by its versatile port to the cradle/
cable. The cradle/cable is attached by its cable to a USB/
serial port on your computer. 

IR to a PC/Handheld This connection type defines a connection between the IR 
port of your Acer s10 and the infrared device of your 
computer or other devices.

IR to GSM Phone This connection type defines a connection between the IR 
port of your Acer s10 and an infrared-enabled GSM mobile 
phone. 

Serial to GSM Phone This connection type defines a connection between the 
versatile port of your Acer s10 and a GSM mobile phone, 
using a special cable designed to match your phone.
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Other possible connection types: 

To modify Connection preferences:
• In the Connections Preferences screen, tap a connection option. 

Setting modem configurations
Modem configurations let your Acer s10 use a connected modem to communicate 
with remote devices, such as your ISP (Internet Service Provider) or dial-in server, to 
access a remote computer. 

You must set Network preferences, in addition to configuring Modem settings, to be 
able to use the TCP/IP software included in your Acer s10’s operating system before 
connecting to remote devices.

To set Serial to Modem preferences:
1 In the Connection Preferences screen, select an available modem option. 

2 Tap Edit to display the Edit Connection screen. 

The name of the current configuration appears at the top of the screen.

Modem via Cradle/
Cable

This connection type defines a connection between your 
Acer s10’s versatile port and a modem for dialing in a 
modem that is part of your computer.

Modem via Infrared This connection type defines a connection between the IR 
port of your Acer s10 and a modem. The modem can be 
attached to or within a mobile phone or other devices 
supporting an IR port. (Some IR phones have modems.) 
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3 Tap the Connect to pick list and select the device to connect to. 

4 Tap the Via pick list and select the type of connection.

5 In the Dialing pick list, tap TouchTone or Rotary. Select Rotary only if your telephone 
service does not support TouchTone dialing.

6 Tap the Volume pick list and select the speaker volume for the modem.

7 Tap Details at the bottom of the screen

8 Tap the Speed pick list and select the maximum speed for your modem to 
communicate with your Acer s10. 
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NOTE: This setting does not control the speed at which your modem communicates with 
your telephone service.

9 Tap the Flow Control (Flow Ctl) pick list, and select Automatic, On, or Off flow control 
for the modem connection.

10 If necessary, edit the Init String text to change the modem setup string. 

11 Tap OK through each screen until you are returned to the Connection Preferences 
screen.

Setting an Infrared to modem connection
You can create a modem connection that enables IR HotSync through an IR-enabled 
modem. This modem would then dial a modem attached to your computer to perform 
the remote HotSync operation.

To create an Infrared to Modem connection:
1 In the Connection Preferences screen, tap New.

2 Enter a name for this configuration.

3 Tap the Connect to pick list and select Modem.

4 In the Via pick list, select Infrared.

Date & Time preferences
The Date & Time Preferences screen lets you set the date, time, time zone and 
Daylight Saving Time (DST) options for your Acer s10.

To set the date:
1 Tap the Set Date box to display the Set Date calendar screen. 

2 Tap the arrows at the top of the Set Date calendar screen to select the current year.

3 Tap the month.

4 Tap the current date.

The screen closes and the dates you selected are displayed in the Set Date box.
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To set the time:
1 Tap the Set Time box to display the Set Time dialog box. 

2 Tap the Up or Down arrow to change the hour. 

3 Tap each minute number and then tap an arrow to change the number. 

4 If available, tap AM or PM. 

5 Tap OK to set the new time. 

NOTE: To display time based on a 24-hour clock, change the time format. See "Formats 
preferences" on page 277. 

To set the time zone:
1 Tap the Set Time Zone box.

2 Use the up and down arrows to scroll to your country and time zone. 

TIP: You can use the hardware scroll buttons to view the list a page at a time.

3 Make sure your time zone is highlighted. 

4 Tap OK.

TIP: Choose the time zone from the list that corresponds to where you are. When you 
travel, use this dialog to change time zones. If you’re not sure what time zone you are in, find 
out what time it is, and select the time zone which shows the current time. Do not use the 
Time Zone dialog to switch between daylight savings time and standard time. Use the 
Daylight Savings pick list.

The screen closes and the dates you selected are displayed in the Date & Time 
Preferences screen.

To set daylight saving time:
• Tap on the Daylight Saving pick list to toggle this feature on or off.

Digitizer preferences
The first time you start your Acer s10, setup instructions appear onscreen. These 
instructions include a calibration screen, or Digitizer. Calibration aligns the internal 
circuitry of your Acer s10 with its touch-sensitive screen so your handheld can detect 
the task you want to perform when you tap an element on the screen.

You can recalibrate your screen after a hard reset, or if your digitizer drifts. 

To calibrate your screen:
• In the Digitizer screen, follow the onscreen instructions, tapping the screen 

where indicated.
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Formats preferences
The Formats Preferences screen lets you choose a default country for your Acer s10 
and also lets you set the display format for times, dates, and numbers. 

Setting default country 
The default country adjusts the time, date, and number formats, as well as the 
starting day of the week.

To choose a default country : 
1 Tap the Preset To pick list. 

2 Tap a country name.

Setting time, date, week start, and number display formats
The Time setting defines the format for the time of the day. The time format that you 
select appears in all applications in your Acer s10. 

To change the formatting of the time, date, week start, and 
numbers:

1 Tap the Time pick list and select a format, where H is hour and M is minute. 

2 Tap the Date pick list and select a format, where D is day, M is month, and Y is year.

3 Tap the Week starts pick list, and select whether you want the first day of the week to 
be Sunday or Monday. 

NOTE: This time, date and week start settings controls the Day, Week, Month, and Agenda 
views in Date Book and all other aspects of your Acer s10 that display a calendar.

4 Tap the Numbers pick list, and select formats for the decimal point and thousands 
separator.
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General preferences
The General Preferences screen enables you to set the Auto shut-off interval;the Stay 
on in Cradle feature, sounds and volume, and the Beam Receive feature. 

Setting the Auto-off interval time
You can set when your Acer s10 automatically shuts off. Your Acer s10 automatically 
turns off the power and backlight after a period of inactivity, to conserve battery 
power. If you find that your Acer s10 shuts itself off before you finish reviewing the 
information on the screen, you can increase the automatic shutoff setting.

To set the Auto-off interval time:
1 Tap the Auto-off after pick list. 

2 Tap an option — 30 seconds, 1 minute, 2 minutes, or 3 minutes.

Setting your Acer s10 to stay on while in the cradle
You can choose to leave your Acer s10 on when it is in the cradle during a HotSync 
operation, or when you are recharging your battery, so you can continue viewing your 
data. 

To set your device to stay on while in the cradle:
• Tap the Stay on in Cradle check box to allow your Acer s10 to stay on while in 

the cradle. 
Unchecking the box will cause your Acer s10 to shut off after the Auto 
shutoff time interval that you set. 

Setting the sounds and volumes
Your Acer s10 uses a variety of sounds. You can control the sound and volume for 
system alerts, alarms, and games using the General Preferences screen.
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To set the system and alarm sounds:
1 Tap the System Sound pick list and select the sound level—Off, Low, Medium, or High.

NOTE: When you turn off the System Sounds, you can also turn off the ‘chimes’ tones 
associated with HotSync operations.

2 Tap the Alarm Sound pick list and select the sound level.

3 Tap the Game Sound pick list and select the sound level. 

NOTE: The Game Sound setting typically works only with newer games that are 
programmed to respond to it. Older games don’t usually respond to this setting.

Setting the LED settings
You can set alarms in Date Book and Clock to remind yourself of important 
appointments or events. When you enable the LED settings, your Acer s10 LED 
indicator flashes to notify you of alarms. This is useful for situations where you want 
the Alarm Sound off, but still be notified of alarms. 

To set the LED settings:
• Tap the Alarm LED pick list and select On or Off.

Turning Beam Receive on and off
You can choose to turn off the Beam Receive feature. This prohibits anyone from 
beaming information to your Acer s10. It also results to a slight saving in battery 
power. 

To change the Beam Receive feature: 
• Tap the Beam Receive pick list and select On or Off. 

For more information on Beaming, refer to "10 Beaming information" on page 249. 

For information on assigning different applications to your Acer s10 buttons, refer to 
"ShortCuts preferences" on page 294. 

Network preferences
The TCP/IP software that is included in your Acer s10 ’s operating system lets you 
connect with remote Internet Service Providers (ISPs) or dial-in (remote access) servers, 
using applications that let you view the transmitted data. 

To use TCP/IP, you must first create a configuration in Connection Preferences and 
then create Network preference settings. Then you connect to your ISP or dial-in 
server. 
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Network preferences let you set a password, telephone number, DNS number, IP 
address, as well as create a login script for remote connections. You can use a preset 
service template for your ISP or dial-in server, and edit, save, and reuse settings. Or 
you can create your own service template.

To set network preferences:
1 In the Network Preferences screen, tap the Service pick list. 

2 Tap the predefined service template you want to use.

Service templates are a set of ISP and dial-in configuration settings that you can 
create, save and reuse.

3 Tap the User Name field. Only two lines appear onscreen, but the field can contain 
multiple lines of text.

The user name identifies the name you use when you log into your ISP or dial-in 
server. 

4 Enter the user name that identifies you when logging in to your ISP or dial-in server. 
Do not enter spaces in your user name unless your dial-in server accepts them. 

5 Choose whether to use a password when logging onto your ISP or dial-up service:

• To not be prompted for a password during log-on, tap the Password field. 
Enter your password and tap OK. “Assigned” appears in the field. 

• To have your Acer s10 prompt you for the password during log-on, leave 
“Prompt” in the Password field and do not enter anything. You should 
choose this option if you’re concerned about security. 

Tap to display a list of 
service templates.
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6 Tap the Connection pick list and select one. 

The list includes the configurations displayed in your Connection Preferences panel. 
Refer to "Connection preferences" on page 272. 

7 Tap the Phone Number field to display the Phone Setup dialog box.

Use this setting to define the telephone number you use to connect with your ISP or 
dial-in server. 

8 Enter the phone number you use to reach your ISP or dial-in server. 

9 If you need to enter a prefix or disable Call Waiting, proceed to the next steps. 
Otherwise, tap OK.

Enter password.

Tap here.

Tap to display a list of 
connection configurations.

Enter your ISP phone 
number.
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10 To enter a prefix before the telephone number to access an outside line, tap the Dial 
Prefix check box, and enter the prefix.

A prefix is a number that you dial before the telephone number to access an outside 
line. For example, many offices require that you dial “9” to dial a number outside the 
building.

11 To turn off Call Waiting, tap the Disable call waiting check box to select it, and enter 
the code to turn off Call Waiting. (If you don’t know the code, contact your local 
telephone company for the appropriate code.)

NOTE: Call Waiting can end your network session if you receive a call while you are 
connected.

12 To use a calling card to dial your ISP or dial-up service: 

a. Tap the Use Calling Card check box. 

b. On the Use Calling Card line, enter three commas. (Each comma delays 
transmission of your calling card number for two seconds, to compensate for the 
delay before the number is entered.) 

c. Enter your calling card number. 

Enter your 
prefix.Select to use a 

prefix.

Enter your disable 
code.

Select to turn 
off Call Waiting.
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13 When you have finished setting up your phone number, tap OK.

Connecting to your ISP or dial-in service
Once you’ve set the Connection and Network preferences, you can easily connect to 
your ISP or dial-in server using PPP (Point-to-Point Protocol), SLIP (Serial Line Internet 
Protocol), or CSLIP (Compressed Serial Line Internet Protocol) protocols. 

You can make the connection using either Network Preferences commands or a 
third-party application. 

NOTE: TCP/IP provides the ability to connect to your ISP or dial-in server with third-party 
application, such as a Web browser or news reader, that lets you view the transmitted data. 

To establish a connection: 
• In the Network Preferences screen, tap Connect to dial the current service 

and display the Service Connection Progress messages. 

TIP: To see expanded Service Connection Progress messages, press the lower half of the 
Scroll button during login.

To close a connection: 
• Tap Disconnect to terminate the connection between your Acer s10 and your 

service.

Customizing service templates
You can create your own service templates from scratch or duplicate existing 
templates and edit the information. 

If you use one of the predefined service templates, you probably only need to enter 
your user name and telephone number. If you create a new service template, you may 
have to provide additional information.

Enter your calling 
card number.

Select to use a 
calling card.
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To create a new service template:

1 Tap the Menu icon  to display the menu bar. 

2 Tap Service. 

3 Tap New. A new service template (called Untitled) is added to the Service pick list. 

To duplicate an existing service template:
1 In the Network Preferences screen, tap the Service pick list. 

2 Tap the predefined service template you want to duplicate.

3 Tap the Menu icon . 

4 Tap Service. 

5 Tap Duplicate. A copy of the service template is added to the Service pick list.

To edit a service template: 
1 In the Network Preferences screen, select a service template. 

2 Tap Details.

3 Tap the Connection Type pick list, and select a connection type:

4 Tap the Idle Timeout pick list to specify how long will Acer s10 wait to drop your 
connection when you switch out of a TCP/IP application. Choices include: 

Select connection type.

PPP Point-to-Point Protocol
Select this type if you’re unsure which you need. If PPP doesn’t work, 
ask your ISP or your system administrator for the correct connection 
type.

SLIP Serial Line Internet Protocol

CSLIP Compressed Serial Line Internet Protocol

1 minute Your Acer s10 will wait for one minute for you to open another 
application before it drops the connection.

2 minutes Waits for two minutes.
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5 Enter a DNS number following the instructions on “ To specify a primary and 
secondary DNS number” on page 285. 

6 Tap OK.

To delete a service template:
1 Tap the Service pick list.

2 Tap the service template you want to delete.

3 Tap the Menu icon . 

4 Tap Service. 

5 Tap Delete, then tap OK.

Entering DNS numbers and IP addresses
The Internet uses the Domain Naming System (DNS) to translate the names of host 
computers into IP addresses. A DNS number (or IP address) identifies a specific server 
that handles the translation services. 

Each DNS or IP address is a series of four numbers, from 0 to 255, separated by periods.

Anyone who logs onto the Internet must have a unique identifier—an IP address. This 
IP address can be either temporary—assigned automatically each time you log on—or 
permanent. 

Not all systems require that you enter a DNS number; check whether it is with your 
system administrator. If a DNS number is required but not entered, logging on to your 
network may appear successful. However, the connection will fail if you try to use an 
application or look up information.

If your system requires DNS numbers, ask your Internet Service Provider or system 
administrator what they are.

To specify a primary and secondary DNS number:
1 In the Network Preferences screen with a service template selected, tap Details. 

3 minutes Waits for three minutes.

Never Your Acer s10 will keep the connection until you turn off the device 
(or until it times out). 
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2 Tap the Query DNS check box to deselect it. 

3 Choose one of the following options:

• If your system doesn’t require a DNS or you’re not sure whether it does, leave 
the DNS field blank. 

• To enter the Primary DNS number: 
– Tap the space to the left of the first period in the Primary DNS field and 

enter the first section of the IP address using a number only, from 0 to 
255. 

4 Enter the second, third, and last sections of the Primary DNS field by repeating the 
procedures above. 

5 Enter the Secondary DNS number using the same procedures as for entering the 
Primary DNS number.

To specify the IP address: 

NOTE: Check with your system administrator whether your IP address is automatically 
(temporarily), or permanently assigned, and if permanent, get the address.

1 In the Network Preferences screen, with a service template selected, tap Details. 

2 Choose one of the following options:

• If your IP address is automatic and temporary, make sure that the IP Address 
check box is selected.

Tap to deselect.

Tap to select an automatic 
IP address. 
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• If your IP address is permanently assigned: 
– Tap the IP Address check box to deselect it. 
– In the permanent IP address field, tap the space to the left of the first 

period, and enter the first section of the IP address using a number only, 
from 0 to 255. 

3 Enter the second, third, and last sections of the IP Address field by repeating the 
procedures above. 

4 Tap OK.

Creating a login script
A login script is a series of commands that automates logging into a network server, 
for example, your office LAN or your ISP. A login script is asociated with a specific 
service template created in Network Preferences. 

You can create login script files in two ways: 
• Ina text editor on your computer, in which you create a file with an extension 

pnc. You can then install this file in your Acer s10 using the Install Tool. 
• In the Login Script dialog box, accessed from the Details dialog box in 

Network Preferences. 

NOTE: Some commands, such as Send, require additional information and have a parameter 
field to add the necessary data.

You can also use non-ASCII and literal characters in your login script. Refer to "Using 
non-ASCII characters in login scripts" on page 289.

To create a login script on your Acer s10:
1 With a service template selected in the Network Preferences screen, tap Details.

2 In the Details dialog box, tap Script.

3 In the Login Script screen, tap the End pick list.
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4 In the pick list, tap any of the following commands to select them, and then enter 
additional information if a field appears:

Wait For Instructs Acer s10 to wait for specific characters from the TCP/IP 
server before executing the next command

Wait for Prompt Detects a challenge-response prompt coming from the server 
and then displays the dynamically generated challenge value. 
You then enter the challenge value into your token card, which 
in turn generates a response value for you to enter on your 
Acer s10 . This command takes two arguments, separated by a 
vertical bar (|) on the input line. 

Send Transmits specific characters to the TCP/IP server to which you 
are connecting.

Send CR Transmits a carriage return or LF character to the TCP/IP server 
to which you are connecting.

Send User ID Transmits the User ID information entered in the User ID field of 
the Network Preferences screen.

Send Password Transmits the password entered in the Password field of the 
Network Preferences screen. If you did not enter a password, 
this command prompts you to enter one. 

NOTE: The Password command is usually followed by a Send CR 
command.

Delay Instructs Acer s10 to wait a specific number of seconds before 
executing the next command in the login script.

Get IP Reads an IP address and uses it as the IP address for your 
Acer s10 . This command is used with SLIP connections. 

Prompt Opens a dialog box and prompts you to enter text of some kind, 
for example, a password or a security code.

End Identifies the last line in the login script.
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5 Repeat steps 3 and 4 until you have completed the login script.

6 Tap OK. 

7 Tap OK in the Details dialog box.

Using non-ASCII characters in login scripts
If you know how to write custom scripts with non-ASCII characters, you can 
incorporate the caret (^char) character, carriage returns and line feeds, and literal 
characters in your custom login scripts.

Caret (^ char)
Use the caret (^ char) character to transmit ASCII command characters. If you send 
^char, and the ASCII value of char is between @ and _, then the character is 
automatically translated to a single-byte value between 0 and 31. 

For example, ^M is converted to a carriage return. If char is a value between a and z, 
then the character sequence is translated to a single-byte value between 1 and 26. If 
char is any other value, then the character sequence is not subject to any special 
processing. Thus, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage return and line feed
You can include carriage return and line feed commands as part of the login script, 
when entered in the following format:

<cr> Sends or receives a carriage return

<lf> Sends or receives a line feed

For example, the string “wait for Joe<cr><lf>” waits to receive Joe, followed by a 
carriage return and line feed from the remote computer, before executing the next 
command in the script.

Literal characters
You can use the backslash ( \ ) character to specify that the next character be 
transmitted as a literal character, and not be subject to any special processing 
ordinarily associated with that character. For example:

\^ Includes a caret as part of the string

\< Includes a < as part of the string

\\ Includes a backslash as part of the string

Plug-in applications
You can create a plug-in application containing script commands that extends the 
functionality of your Acer s10’s built-in script command. A plug-in application is a 
standard prc application that you install on your Acer s10 just like any other 
application. After you install the plug-in application, you can use the new script 
commands in a login script. 
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Plug-in applications have the following characteristics:
• Written in C language
• Compiled into a device executable
• Called properly from a login script
• Able to return control to a login script after it terminates
• Created using a development environment that supports Palm OS software, 

such as Metrowerks CodeWarrior for Palm Platform 

Troubleshooting TCP/IP connections
If you have problems connecting to a network using TCP/IP, you can display various 
information to troubleshoot the problem. These includes: 

Also, check with your system administrator whether a DNS number is required. If a 
number is required but not entered, the connection may fail. Refer to "Entering DNS 
numbers and IP addresses" on page 285 for more information. 

To expand the display of progress messages during login:
1 In the Network Preferences screen, tap Connect. 

2 To see the expanded Service Connection Progress messages, press the lower half of 
the Scroll button during login.
Refer "Connecting to your ISP or dial-in service" on page 283 for more 
information.

To view the Network Log:

1 With the Network Preferences screen displayed, tap the Menu icon .

2 Tap Options. 

3 Tap View Log.

4 Tap the Up and Down arrows of the scroll bar to see the entire Network Log.

5 Tap Done.

Network Preferences menus
The Network Preferences screen has a menu bar contaning commands that will help 
you create and edit service templates. The menus are shown here for your reference. 
Features that are not explained in this section are discussed elsewhere in this Manual.

Network Preferences has three menus: Service, Edit and Options. 

Expanded Service 
Connection Progress 
messages

Describes the current stage of login prrocedure.
These messages are helpful in identifying at what point 
in the login procedure did the connection failed. 

Network Log Lists all the communication that occurs between your 
modem and dial-in server during the login procedure. 
This information can help your ISP or your system 
administrator identify where and why the login 
communication fails.
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See "Using menus and menu commands" on page 18 for information on how to open 
and use menus.

Service menu

Edit menu 

Options menu
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Owner preferences 
The Owner Preferences screen let you record a name, company name, phone number, 
or any other information you want to include on your Acer s10 .

If you use the Security application to turn off and lock your Acer s10 with a password, 
information that you enter in the Owner Preferences screen appears the next time 
you turn on your handheld. 

To change owner preferences on your Acer s10:
1 In the Owner Preferences screen, enter the text you want to associate with your 

Acer s10 . If you enter more text than can fit on one screen, a scroll bar appears at the 
right side of the screen. 

NOTE: If you have assigned a password to your device using the Security application, you 
must unlock the Owner Preferences screen to change the information on it. 

To unlock the Owner Preferences screen: 
1 Display the Owner Preferences screen.

2 Tap Unlock. The Unlock Message dialog box appears. 

3 Enter your current password (the one you entered in the Security application).

4 Tap OK. 

5 Edit the Owner Preferences text as desired.
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Phone preferences
Your Acer s10 can be connected to a GSM mobile phone to give you wireless access to 
email and the Internet. Depending on the type and model of your phone, your 
Acer s10 can communicate using the infrared port, or a cable. Here are a few 
guidelines:

• You must have digital services already activated on your phone.
• Your phoe must have a driver.
• Your phone must have an enabled infrared capability that complies with the 

IrDA standard, or you must purchase a cable designed for your phone model.

Communicating with your mobile phone
Once you have set up your wireless account, you are ready to set up connection to 
your GSM mobile phone. Your phone can then be used to connect to the Internet 
wirelessly, similar to a modem. In addition, you can manage the data on your mobile 
phone using your Acer s10 . These includes: 

• Access and exchange phone book records between your Acer s10 and your 
mobile phone

• Use your Acer s10 to look up and dial numbers
• Check the status of your phone, signal strength, and battery level.

Setting up related Network preferences
You use the Network Preferences screen to record information about your internet 
service provider (ISP) which includes your login information and connection profile: 

1 On the Network Preferences screen, tap the Connection pick list.

2 Select Infrared to GSM Phone or Serial to GSM Phone according to your connection 
setup.

3 Use information about your ISP to fill in the remainder of the screen, and the Details 
screen.

Setting up related Connection Preferences
You use the Connection Preferences screen to select your mobile phone, and the 
connection profile.

1 On the Connection Preferences screen, select Infrared to GSM Phone, or Serial to GSM 
Phone, according to your hardware setup.

2 Tap the Edit button.

3 Tap on the Connect to pick list, and select Phone.

4 In the Via pick list, select Infrared or Serial according to your hardware setup.

5 Tap on the Details button. The phone driver will automatically fill in the speed and 
initialization string, and you will probably not have to adjust these parameters. 

NOTE: The initialization string is dependent on the carrier hardware, rather than the type 
of phone.
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6 Tap OK.

7 In the Confirmation screen, choose whether you want this configuration to be the 
default for your phone applications.

Setting up Phone preferences

Illustration suggestion (Delete this suggestion when completed): related
Phone pref screens

Use the Phone Preferences screen to select the connection profile you configured in 
the Connection panel. These settings will be applied when you use Phonebook access 
and voice applications. 

1 On the Phone Preferences screen, tap the Connection pick list. 

2 Select Infrared to GSM Phone or Serial to GSM Phone, according to your hardware 
setup. 

The details of you connection should already be set up, based on what you picked in 
the Connection pick list. However, you can edit this information from this pick list.

If no connection methods are available, then None is shown in the pick list. This means 
that no phone drivers exist on your Acer s10. In this case you must install the phone 
driver on your computer then HotSync it to your Acer s10 .

If your phone is enabled and connected, you can test the connection by tapping on 
the Test button. This initiates a simple query of the phone to make sure the 
connection is working and the correct phone is being used.

ShortCuts preferences
You can use the ShortCut preferences to create Graffiti ShortCuts of up to 45 
characters. For example, you could create a ShortCut for your name or for the header 
of a memo. All ShortCuts you create appear on the list in the ShortCut Preferences 
screen and are available in any of your Acer s10 applications. This list is backed up on 
your computer when you perform a HotSync operation. 

For more information on how to use ShortCuts, refer to "Using Graffiti ShortCuts" on 
page 29.
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To create a ShortCut:
1 In the the ShortCut Preferences screen, tap New to display the ShortCut Entry screen. 

2 In the ShortCut Name line, enter the letter(s) you want to use to activate the ShortCut.

3 In the ShortCut Text line, enter the text that will appear when you write the ShortCut 
character(s). 

You can add a space character after the last word in your ShortCut text, so that a 
space automatically follows the ShortCut text.

4 Tap OK.
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13 Frequently Asked 
Questions
If you encounter a problem with your Acer s10, do not call Technical Support until you 
have reviewed the following list of frequently asked questions, and you have also 
reviewed the following:

• The README file located in the folder where you installed the Palm Desktop 
software on your Windows computer

• The Helpnote folder located in the folder where you installed the Palm 
Desktop software on your Windows computer

• The Palm Desktop online Help
• The most recent Acer s10 help on your regional Acer web site

If you are still having problems, contact your local dealer or distributor.  You may also 
access the Acer web site at http://www.acer.com/ for information on how and where 
to contact the service centers available in your area.

NOTE: Thousands of third-party add-on applications have been written for the Palm OS 
handhelds. Unfortunately, we are not able to support such a large number of third-party 
applications. If you are having a problem with a third-party application, please contact the 
developer or publisher of that software.

Software installation problems

Problem Solution

I cannot install the Palm Desktop 
software on my Windows computer.

Try the following:

1 Disable any virus scanning software on your computer.
2 Press Ctrl-Alt-Delete and end all tasks except Systray and 

Explorer.

NOTE: If a dialog box with buttons appears instead of a list of tasks, 
click the Task List button and then end all tasks except Systray and 
Explorer.

3 Make sure your computer has at least 30 MB of disk space 
available.

4 Delete all temporary files.
5 Run ScanDisk on your computer.
6 Reinstall Palm Desktop software.

http://www.acer.com
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Operating problems

Problem Solution

I don’t see anything on my Acer s10 
screen.

Try each of these in turn:

• Press an application button to ensure your Acer s10 is 
turned on.

• Tap the Contrast icon  on the upper-left corner of the 
Graffiti® writing area. 
On the Contrast dialog box, adjust the contrast by 
holding down the up scroll button for a few seconds. If 
this doesn’t work, hold the down scroll button for a few 
seconds.

• If your Acer s10 was exposed to cold, make sure it is at 
room temperature.

• Recharge the unit.
• Perform a soft reset. If your Acer s10 still doesn’t turn on, 

perform a hard reset. See "Resetting your Acer s10" on 
page vi for instructions. 

IMPORTANT: WIth a hard reset, all records and entries stored in your 
Acer s10 are erased. Never perform a hard reset unless a soft reset does 
not solve your problem. You can restore any data previously 
synchronized with your computer during the next HotSync operation. 

I get a warning message telling me 
memory in my Acer s10 is full.

• Purge records from Date Book and To Do List. This deletes 
To Do List items and past Date Book events from the 
memory of your Acer s10. See "Purging records" on page 
56. 
You may need to perform a HotSync operation to recover 
the memory. Refer to "11 Exchanging and updating data 
using HotSync operations" on page 253.

• Delete unused memos and records. If necessary, you can 
save these records. See "Deleting records" on page 55.

• If you have installed additional applications on your 
Acer s10, remove them to recover memory. See "To 
remove an add-on application" on page 40.

My Acer s10 keeps turning itself off. Your Acer s10 is designed to turn itself off after a period of 
inactivity. This period can be set at one, two, or three minutes. 
Check the Auto-off setting. See "Setting the Auto-off interval 
time" on page 278.

My Acer s10 is not making any sounds. Check the System, Alarm and Game Sound settings. See "Setting 
the sounds and volumes" on page 278.

My Acer s10 LED indicator is not 
blinking when alarms occur.

Check the Alarm LED setting. See "Setting the LED settings" on 
page 279.

My Acer s10 has frozen. Perform a soft reset. See "Performing a soft reset" on page vi.
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Tapping and writing problems

Application problems

Problem Solution

When I tap the buttons or screen icons, 
my Acer s10 activates the wrong 
feature.

Calibrate the screen. See "Digitizer preferences" on page 276.

When I tap the Menu icon , nothing 
happens.

Not all applications or screens have menus. Try changing to a 
different application.

I cannot get my Acer s10 to recognize 
my handwriting. 

• For your Acer s10 to recognize handwriting input with 
the stylus, you need to use Graffiti writing. See "Entering 
data using Graffiti" on page 23.

• Make the Graffiti character strokes in the Graffiti writing 
area, not on the display part of the screen.

• Write Graffiti strokes for letters in the left-hand side, and 
the strokes for numbers in the right-hand side of the 
Graffiti writing area.

• Make sure that Graffiti is not shifted into extended or 
punctuation modes. See "Entering data using Graffiti" on 
page 23.

• See "Graffiti tips" on page 31 for tips on increasing your 
accuracy when you write Graffiti characters.

Problem Solution

I tapped the Today button, but it does 
not show the correct date.

Your Acer s10 is not set to the current date. Make sure the Set 
Date box in the Date and Time Preferences screen displays the 
current date. See "Date & Time preferences" on page 275 for 
more information.

I know I entered some records, but they 
do not appear in the application.

• Check the Categories pick list (upper-right corner). 
Choose All to display all records for that application.

• Check Security and confirm that Private Records is set to 
Show private records.

• In To Do List, tap Show and see if Show Only Due Items is 
selected.
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HotSync problems

I am having problems listing memos the 
way I want to see them.

• If you cannot manually arrange the order of the memos 
in the list screen, check the Memo Preferences setting. 
Make sure that Sort by is set to Manual.

• If you choose to view your memos alphabetically on Palm 
Desktop software and then perform a HotSync operation, 
the memos on your Acer s10 still appear in the order 
defined in the Memo Preferences setting. In other words, 
the sort settings you use with Palm Desktop software are 
not transferred to your Acer s10 .

I created an event in Date Book, but it 
doesn’t appear in the Week View.

In the Week View, you cannot select overlapping events that have 
the same start time. If you have two or more events with the same 
start time, choose the Day View to see the overlapping events.

I entered the euro symbol, but after a 
HotSync operation it doesn’t appear in 
my Palm Desktop software.

You must have fonts that include the euro symbol on your 
computer. Check this web site for additional information:
http://www.microsoft.com/windows/euro.asp/.

Problem Solution

Problem Solution

I cannot do a HotSync operation; what 
should I check to make sure I am doing 
it correctly?

• Make sure the cradle/cable is connected securely.

On a Windows computer, try these steps:

• Check the Windows system tray to make sure the HotSync 

Manager is running (i.e., the HotSync Manager icon  is 
visible in the bottom right corner of the Windows system 
tray). If it is not, open Palm Desktop software.

• Make sure you selected Local USB or Local Serial, as 
appropriate, from the HotSync Manager menu.

• If you are using the optional Serial sync cable , make sure 
you selected the correct serial port on the Local tab in the 
Setup dialog. It should be set to the port where you 
connected the Serial sync cable.

I did a HotSync operation, but one of 
my applications did not synchronize.

On a Windows computer, click the HotSync Manager icon  and 
choose Custom. Check that the correct conduit is active.

I am using Microsoft Outlook as my PIM, 
but I cannot do a HotSync operation. • Click the HotSync Manager icon  and choose Custom. 

Check that the correct conduit is active.
• Check that Intellisync Lite (conduit for Microsoft Outlook) 

is installed and properly configured. If it is not, use the 
Acer s10 Installation CD to install and configure Intellisync 
Lite in your computer. Refer to "Using your Acer s10 with 
another personal information manager" on page 14. 

www.microsoft.com/windows/euro.asp/
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I cannot launch the HotSync Manager. • If you are using the optional Serial sync cable, or if you 
are performing a HotSync operation using a modem, 
make sure you are not running another program, such as 
America Online, CompuServe, or WinFax, that uses the 
serial port you selected in the Setup dialog box.

• Backup the Palm Desktop software, uninstall it, then 
reinstall it.

I tried to do a local HotSync operation, 
but it did not complete successfully.

• Make sure your Acer s10 is properly seated in the cradle.
• Check the connection between the cradle and the USB (or 

serial port, if you are using the optional Serial sync cable) 
on your computer.

• Make sure the user name you selected in Palm Desktop 
software matches the user name assigned to your 
Acer s10 .

• Make sure the date on your computer matches the date 
on your Acer s10 .

• Read the HotSync Log for the user account for which you 
are peforming a HotSync operation.

On a Windows computer, try each step in turn:

• Make sure HotSync Manager is running. If it is running, 
close it, and restart it.

• Make sure you selected Local USB or Local Serial, as 
appropriate, from the HotSync Manager menu.

• If you are using a Serial sync cable, make sure you 
selected the correct serial port on the Local tab in the 
Setup dialog. It should be set to the port where you 
connected the Serial sync cable.

• If you are using a Serial sync cable, try a lower baud rate 
setting on the Local tab in the Setup dialog.

• If you are using a Serial sync cable, make sure you are not 
running a program, such as America Online, CompuServe, 
or WinFax, that uses the serial port you selected in the 
Setup dialog box.

Problem Solution
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I tried to do a modem HotSync 
operation, but it did not complete 
successfully.

Check the following on your computer:

• Make sure your computer is turned on and that it does 
not shut down automatically as part of an energy-saving 
feature.

• Make sure the modem connected to your computer is 
turned on and is connected to the outgoing phone line.

• Make sure the modem you are using with your Acer s10 
has an on-off switch. Your Acer s10 cannot “wake up” a 
modem that has an auto-off feature.

• Make sure the modem is connected properly to your 
computer and is connected to the incoming phone line.

On a Windows computer, check the following:

• Make sure Modem is checked in the HotSync Manager 
menu.

• Confirm that the Setup String in the Setup dialog box 
configures your modem correctly. You may need to select 
a different Modem Type or enter a custom Setup String. 
Most modems have a Setup String that causes them to 
send initial connection sounds to a speaker. You can use 
these sounds to check the modem connection.

• Confirm that the Speed setting in the Setup dialog box 
works for your modem. If you have problems using the As 
Fast As Possible option or a specific speed, try using a 
slower speed.

• Make sure you are not running another program, such as 
WinFax, CompuServe or America Online that uses the 
serial port you selected in the Setup dialog box.

• Make sure your modem resets before you try again. (Turn 
off your modem, wait a minute, then turn it back on.)

I cannnot perform an IR HotSync 
operation.

• On a Windows computer, be sure the HotSync Manager is 
running and the Serial Port for local operations is set to 
the simulated port for infrared communication. See "IR 
HotSync operations" on page 258 for details.

• On your Acer s10 , be sure the HotSync application is set 
to Local, with the option IR to PC/Handheld.

• Be sure the IR port of your Acer s10 is aligned directly 
opposite to, and within a few inches of, the infrared 
device of your computer.

• IR HotSync operations do not work after you receive a 
low battery warning, check the battery power of your 
Acer s10 . Recharge the unit.

My Acer s10 seems to freeze when I 
place it near my computer.

Move your Acer s10 away from the computer’s infrared port.

When I press the HotSync button on the 
cradle, nothing happens on Palm 
Desktop software and my Acer s10 
times out.

• Make a copy of your Palm folder. Uninstall, then reinstall 
Palm Destkop software.

• Turn on your Acer s10 and tap the Applications icon . 

Tap the HotSync icon  , then tap Local.

Problem Solution
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Beaming problems

When I perform a HotSync operation, 
my information does not transfer to 
Palm Desktop software.

• If you have performed a HotSync operation successfully, 
but you cannot find the data from your Acer s10 on Palm 
Desktop software, check to see you have the correct user 
name selected for viewing data.

• On the Windows system tray, click the HotSync Manager 

icon  and choose Custom. Check that all conduits are 
set to synchronize files.

My Acer s10 displays the message 
“Waiting for sender’ when it’s near my 
computer’s infrared port.

• Your computer’s infrared port may be set to search 
automatically for the presence of other infrared devices. 
Consult the documentation for your operating system for 
information about turning off this option.

• In some cases, simply moving your Acer s10 away from 
the computer’s infrared port solves the problem.

I want to synchronize my computer with 
more than one handheld.

If the computer running Palm Desktop software synchronized 
with more than one handheld, each handheld must have a unique 
name. Assign a user name to your Acer s10 the first time you 
perform a HotSync operation. See "Creating a user profile" on 
page 253. 

IMPORTANT: Please be aware that synchronizing more than one 
handheld with the same user name causes unpredictable results and, 
potentially, loss of information on your handheld.

Problem Solution

Problem Solution

I cannot beam data to another Palm OS 
handheld.

• Confirm that your Acer s10 and the other Acer s10 
handheld are between ten centimeters (approximately 
4”) and one meter (approximately 39”) apart, and that 
the path between the two handhelds is clear of obstacles. 
Beaming distance to other Palm OS handhelds may be 
different.

• Move your Acer s10 closer to the receiving handheld.

When someone beams data to my 
Acer s10 , I get a message, telling me it 
is out of memory.

• Your Acer s10 requires at least twice the amount of 
memory available as the data you are receiving. For 
example, if you are receiving a 30K application, you must 
have at least 60K free.

• Perform a soft reset. See "Performing a soft reset" on 
page vi for instructions.
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Recharging problems

Password problems

Problem Solution

When I place my Acer s10 in the cradle, 
the LED indicator does not go on.

• Confirm that your Acer s10 is well seated in the cradle.
• Confirm that your AC adapter is properly connected to 

the back of the cradle’s power jack. 
• Confirm that your AC adapter is plugged into an AC 

outlet that has power.

Problem Solution

I forgot the password, and my Acer s10 
is not locked.

First, use the password hint to try and remember the password. If 
this does not help, or if you do not have a password hint, you can 
use Security to delete the password, but Acer s10 deletes all 
entries marked as private. However, if you perform a HotSync 
operation before you delete the password, the HotSync process 
backs up all entries, whether or not they are marked private. 
Then, you can follow these steps to restore your private entries:

1 Use the Palm Desktop software and the cradle or infrared 
communication to synchronize your data.

2 Tap Forgotten Password in Security to remove the 
password and delete all private records.

3 Perform a HotSync operation to synchronize your data 
and restore the private records by transferring them from 
your computer to your Acer s10.

I forgot the password and my Acer s10 is 
locked.

First, use the password hint to try and remember the password. If 
this does not help, or if you do not have a password hint, you must 
perform a hard reset to continue using your Acer s10. See 
"Performing a hard reset" on page vii for instructions.
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Technical support
If, after reviewing the sources listed at the beginning of this appendix, you cannot 
solve your problem, contact us at http://www.acersupport.com/. 

Before requesting support, please experiment a bit to reproduce and isolate the 
problem. When you do contact support, please be ready to provide the following 
information:

• The name and version of the operating system you are using
• The actual error message or state you are experiencing
• The steps you take to reproduce the problem
• The version of Acer s10 software you are using and available memory
• The product ID of your Acer s10 (the 12-digit number indicated on your 

handheld’s rear panel)

Finding version and memory information

1 In Applications Launcher, tap the Menu icon  to display the menu bar. 
2 Tap App, then select Info.
3 Tap Version to see version numbers, and tap Size to see the amount of free 

memory in kilobytes.

NOTE: Thousands of third-party add-on applications have been written for the Palm OS 
handhelds. Unfortunately, we are not able to support such a large number of third-party 
applications. If you are having a problem with a third-party application, please contact the 
developer or publisher or that software

http://www.acersupport.com
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Appendix A

Appendix — Creating 
a custom Expense 
Report
This section explains how to modify exisitng Expense application templates and how 
to create your own custom expense report templates for use with the Expense 
application.

NOTE: This section assumes that you are familiar with Microsoft Excel or a similar 
spreadsheet application. If you are not familiar with Microsoft Excel, consult your company’s 
Information Services department or another experienced user.

About mapping tables
Before creating or modifying an Expense template, it is important to understand the 
function of the Palm™ Desktop software Expense application. In simple terms, the 
Expense application is designed to move Expense data from your Acer s10 into a 
Microsoft Excel spreadsheet. Each Expense item stored in your Acer s10 represents a 
group of related data. You can associate the following data with an expense item:

• Category
• Date
• Expense type
• Amount
• Payment method
• Payment currency
• Vendor
• City
• Attendees
• Note

When you perform a HotSync operation between your Acer s10 and Palm Desktop 
software on your computer, the Expense data is stored on your computer (in a file 
named Expense.txt). When you open the Expense application in Palm Desktop 
software, an Excel macro starts, and populates an expense template with your data 
based on the rules specified in a spreadsheet file named Maptable.xls.

The Maptable.xls file is an editable spreadsheet that functions as a “mapping table.” 
The function of the mapping table is to guide the Excel macro in extracting the 
Expense data. The mapping table tells the Excel macro how large the spreadhseet is 
and provides the data-cell layout of the Excel template used for the Expense Report.
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Customizing existing sample templates
Four sample Expense Report templates come with Palm Desktop software. These 
templates are stored in the Template folder (which is in the same folder as the Palm 
Desktop software application).

If the layout of one (or more) of these templates is appropriate for your reporting 
needs, you can easily customize the templates with your company name and other 
information.

To customize a sample Expense Report template
1 Make a backup copy of the contents of the Template folder.

Illustration suggestion (Delete this suggestion when completed): Template
folder window

2 Double-click the name of the sample template you want to modify to open it in 
Microsoft Excel.

3 Make any changes that you want to the names (or other information) in the sample 
template.

IMPORTANT: Do not insert rows or columns in the sample template. Doing so changes the 
way your Expense data maps to the template and causes errors. If you want to move the cells 
to a different location or add or delete rows or columns, you have to make changes to the 
Maptable.xls file.

NOTE: You can insert your own company logo without changing the Maptable.xls file. If 
you change the file name, however, you need to make a corresponding change in the 
Maptable.xls file. You can also rename cells without changing the Maptable.xls file, provided 
that the Expense type corresponds to your Acer s10 data.

4 From the File menu, choose Save As.

5 Click the Save as type drop-down list and choose Template (*.xlt).

6 Navigate to the Template folder (in the Palm Desktop software directory).

NOTE:
If you do not need to change the Maptable.xls file, save the template file with its original file 
name (e.g., Sample2.xlt).
If you do need to change the Maptable.xls file, give your modified template a unique name. 
Be sure to use the .xlt file suffix, which defines the file as a Microsoft Excel template.

7 Click Save to save your modified template and make it available for future use.

NOTE: If you need to modify the Maptable.xls file, you must do this before you can use the 
modified template with your Expense data. To modify the Maptable.xls file for your new 
template, see "Programming the mapping table" on page 310. Read all of the sections of this 
appendix before making changes to the Maptable.xls file.
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Determining the layout of the Expense Report
This section describes the layout considerations for the Expense Report and explains 
the terms used for creating the report.

Labels
There are two kinds of labels that you need to define for your report: 

• day/date 
• expense 

Each kind of label can be either be: 

• Fixed. The label always appears as a header at the beginning of a row or 
column, or 

• Variable. If a label is not Fixed, it is variable.
For example, a list table of expenses could have variable labels in the rows for day/
date, and variable labels in the columns for expense type. In this case, neither day/
date or expense type information would be “fixed” (as a header). Instead, the date 
and expense type information would be filled into the cells of the spreadsheet as 
appropriate.

Examples of both Fixed and Variable labels appear inthe sample expense templates.

Sections
A Section is an area of the report that has common formatting. It is common for an 
Expense report to have more than one Section. For example, a sample Expense Report 
named Sample3.xlt contains several Sections.

Illustration suggestion (Delete this suggestion when completed): Sample3.xlt

template

Because your Expense data maps to row and column areas of your final report, 
different Sections require different definitions for the data mapping. To create 
additional Sections with different mapping, you create corresponding additional lines 
to the mapping table file named Maptable.xls. This procedure is explained later in this 
appendix.

If a section contains cells for prepaid (company paid) expenses, you need to create an 
additional line in the mapping table for “prepaid.” This will count as an additional 
section in the mapping table. The only data that differs in the prepaid section (from 
the non-prepaid section) is the row/column numbers for the expense type.

Analyzing your custom Expense Report
If you already have a custom Excel expense report, you can use it with a modified 
mapping table. However, before you can create a Maptable.xls file that corresponds 
to your custom Expense Report, you must first analyze the characteristics of your 
report.
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Perform the following before you begin a custom mapping table:
• Print a copy of your custom expense report. Activate the Row and Column 

Headings option in the Sheet settings of the Page Setup command. This 
enables you to quickly determine the size of the Section(s), as well as the 
numbers for the start rows and columns.

• On the printed copy, identify the data Sections. A Section is an area of data 
with common row and column formatting. A highlighter marking pen can 
make it easy to see the Sections as you work with programming the mapping 
table. Your custom Expense Report can contain any number of Sections, and 
the same data can be repeated in any Section.

• On the printed copy, identify the type of Labels that apply to each Section. 
Each Section can have only one kind of Fixed or Variable label for rows. 
Likewise, each Section can have only one kind of Fixed or Variable Label for 
columns.

• Place a copy of your custom Expense Report in the Template folder (in the 
Palm Desktop software directory). Change the filename so it has the file 
extension .xlt (which defines it as a Microsoft Excel template). Make a note of 
the exact filename so it can be defined in the mapping table file.

Programming the mapping table
Once you have analyzed the components of your custom Expense Report, you can 
program the mapping table to fill the report with data from your Acer s10 .

To program a new custom mapping table:
1 Open a copy of the Maptable.xls file in Microsoft Excel.

NOTE: This file is located in the same folder as the Palm Desktop software application. Make 
a backup copy of this file before you make your modifications.

2 Mapping a new template. Scroll to where you find the name of the original 
template that you chose for your modifications. The name of the template will appear 
in column B of the Maptable.xls file, next to the cell highlighted in green that reads 
“Template Name:”. If you did not modify an existing template, move to any table in 
the Maptable.xls file.

3 Select all the rows associated with template name. To select the rows, click and drag 
on the row numbers (left side), so they appear highlighted.

Illustration suggestion (Delete this suggestion when completed): Excel
template highlighted

4 From the Edit menu, choose Copy.

5 Scroll down to a blank area of the Maptable.xls file (below the rows used for 
Sample4.xlt), and click on a row number to select a blank row.

6 From the Edit menu, choose Paste. A copy of the rows you selected in step 3 is pasted 
into the Maptable.xls file.

7 Name the table. In the cell immediately to the right of the cell entitled Template 
Name, enter the exact filename of your Expense Report template.
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8 Define the number of Sections. Each row in a table defines how your Acer s10 data 
will be placed in a Section of your custom Expense Report. Note that the prepaid 
portion of a section has its own row and counts as a separate section for map table 
purposes, even though it is not a separate section in your template.

You may add or delete rows as necessary so that the total number of rows 
corresponds to the number of Sections in your custom Expense Report. To clear all of 
the existing settings in a row, click to select the row and press Ctrl+Delete. Name each 
row to correspond to a Section of your custom Expense Report.

Illustration suggestion (Delete this suggestion when completed): Excel
template with four sections

9 Determine the Label settings. The orientation of the data fields (Row, Column) 
appears in the yellow section of the table.

Illustration suggestion (Delete this suggestion when completed): Excel
template with Label settings

Determine whether the Rows will contain expense or date information, and place an 
“x” in the appropriate cell. When you do this, you also define whether the label is 
Fixed or Variable. You can place only one “x” in the Row section (columns 2-5).

Determine whether the Columns will contain expense or date information, and place 
an “x” in the appropriate cell. When you do this, you also define whether the label is 
Fixed or Variable. You can place only one “x” in the Column section (columns 6-9).

10 Define the dimensions of the Section. The dimensions of the Section appear in 
the green columns (10-13).

Illustration suggestion (Delete this suggestion when completed): Excel
template Section dimension

11 Define the Dates and Intervals. The dates and intervals between dates appears in 
the light blue columns (14-17).

# of Rows Represents the total number of rows in the Section, excluding 
any header or total rows. In other words, this includes only the 
number of rows in the section where your Acer s10 data will be 
placed.

# of Columns Represents the total number of columns in the Section, 
excluding any header or total rows. In other words, this includes 
only the number of columns in the section where your Acer s10 
data will be placed.

Start Row Refers to the number of the first row of the Section that will be 
filled with data from your Acer s10 .

Start Column Refers to the number of the first column of the Section that will 
be filled with data from your Acer s10.
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Illustration suggestion (Delete this suggestion when completed): Dates and 
Intervals

In the Date cell, enter the row or column number where all the date information will 
be placed.

In the Dates cell, enter the number of blank columns (or rows) separating the date 
fields. If there are no blank columns (or rows) between date entries, leave this number 
set to zero.

In the Start Day cell, enter the day of the week that starts the expense reporting 
period. Enter a three-character abbreviation for the day (e.g., Sun, Mon, Tue).

In the Day cell, enter the row or column number where all the day information will be 
placed. If the dates are in a row, enter the row number. If the dates are in a column, 
enter the column number.

12 Determine whether the Section is in list format. This setting appears in the light 
purple columns (18-19).

Illustration suggestion (Delete this suggestion when completed): list for-
mat.

If the Section will present the data in a list format, enter the word “yes”. Otherwise, 
enter the word “no”. 

Illustration suggestion (Delete this suggestion when completed):

Only if your section is in list format: In the Expense Type cell, enter the number of 
the row or column where the expense description will be placed. Expense amounts 
can be entered in several different columns or rows if required by your template. 
Expense type labels must all appear in the same column.

13 Enter the row or column numbers for the expense types that appear in the 
Section. These settings appear in the aqua columns (20-48).

Illustration suggestion (Delete this suggestion when completed):

For these settings, simply enter the row or column number for the expense types that 
you want to appear in the Section. Note that you can use a row or column number 
more than once. An example of this would be meals that encompass breakfast, lunch, 
dinner, and snacks. In the previous example, all expense items would be populated 
into row/column 4 of the custom Expense Report.

14 Complete the table. All of the remaining columns (49-57) in the table are used to 
define the column or row number that corresponds to the description.

15 Mark a Section for prepaid expenses (yellow column). If a row in the map table 
is for prepaid (company paid) expenses, type a “yes” in the cell on that Section’s row. 
Type “no” in all the cells of this column that do not pertain to prepaid expenses.

16 Repeat steps 9 through 15 for each Section that you have defined for your custom 
Expense Report.

17 Map Expense Report Options dialog (magenta section). The Expense Report 
Options dialog has five fields where you can fill in data for the header on your 
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expense report. Use this section to specify the row and column on your template 
where this information will be mapped.

Because header data is not related to any particular Section, you have to fill in only 
one row. If the item does not appear on your template, leave these cells blank.

Using applications other than Microsoft Excel
You can use applications other than Microsoft Excel (such as Lotus 1-2-3 or Quattro 
Pro) to open and manipulate the Expense data on your computer. The data file is 
named “Expense.txt,” and is stored in the Expense folder, within the folder containing 
the Acer s10 user data.

Expense data in the Expense.txt file is in tab-delimited format.

Expense file details
The Expense.txt file contains four groups of data. It will be easier to see these four 
distinct groups of data if you open the file with a spreadsheet application.

Trips Shows the number of Expense application categories, and lists 
each one followed by an “end” statement.

Currency Shows how many currencies were used for the Expense data, 
and lists the countries that correspond to that currency.

Trip Shows the number of expenses by category, and lists the 
expenses for each category.

Expenses Shows the total number of expenses, and lists them 
chronologically.



Appendix — Creating a custom Expense Report
Expense file details

314   



 315
 

Index
A
Address Book

changing display 86
creating entries 83
menus 87
opening 47
overview 46
top-of-list entry 84

addresses
displaying entries 85
editing 85
entering 83
selecting 85
sorting 86

alarms
insistent 223
setting 73
sound effects 224
subtle 226

applications
categorizing 36
changing button assignment 38
creating a new category 36
customizing for HotSync 257
Expense 105
getting information on 65
installing add-on

removing 38
opening 17
setting preferences 38
switching 36

Applications Launcher
changing display 37
using 35

Attention Manager 223
AudioBox

opening 118
overview 118

auto shut-off, setting 278

B
backlight, turning off 278
Backup 181

Backup function 181
complete backup 182

deleting backup data 189
error log 189
error messages 185
menus 190
opening 123
overview 123

Restore function 185
complete restore 186
partial restore 188

basic applications 45
beamed information

receiving 251
sending 249

beaming
applications 250
business cards 249
records 250

blind carbon copy 236
business cards, beaming 249
buttons, assigning applications to 38

C
calculations

in memory 103
recent 103

Calculator
menus 104
opening 50
overview 50

calibrating screen 17, 276
CardInfo 220
characters

non-English 29
writing 23

City Clock
alarm setting 134

frequency 136
volume 136

local time display 129
time display for selected cities 129

adding new city 132
changing city display 129
deleting a city entry 133
editing city details 130

Clock
Big Clock mode 137
City Clock mode 128
menus 139
opening 118
overview 117
switching betwen modes 127
Timer mode 138
using 127

commands, choosing 18
communicating with mobile phone 293
computers

preparing for HotSync 261



316   

preparing for infrared communication 258
conduit 257

Install conduit 257
System conduit 257

conflicting events 77
cradle 8

D
data

entering 21
importing 33, 267

date
setting 275

Date Book
adding address information 72
changing view 75
menus 79
opening 45
overview 45
specific tasks 67
time slot display 79

Day view
compressing 81
event conflicts 77

Deleted folder 241
desktop software

installing 11
removing 40

device
locking 43

displaying tips 20
DNS numbers, setting 285
downloading email

using filters 244
with HotSync 243

E
eBook Converter

Add command 206
Convert All command 200, 209
converting reminders 209
installing 203
menus 210
New command 204
Open command 204
opening 196
Remove All command 199, 207
Remove command 199, 207
Save As command 205
Save command 205
selecting a file 198, 204

source file conversion list 209
toolbar 204
using 203

eBook Reader
Book Manager 161
bookmarks 167
hyperlinks 172
Jump To function 172
menus 176
Note Manager 174
opening 121
overview 121
Read Document mode 165
using 161

eDictionary
overview 124

Edit menu 54
email application

preferences 239
setting up 229
synchronizing with HotSync 243

email items
adding details 236
blind carbon copy 236
categorizing 242
confirming delivery 237
confirming read 237
creating 233
creating signature 237
deleting 241
drafting 239
editing unsent 238
filing 240
filtering 246
looking up addresses 235
priority 236
purging deleted 241
replying to 234
restoring deleted 241
sorting 242, 243
storing unsent 238
truncating 245

end time 79
entering data 21
events

continuous 71, 72
repeating 71, 72
rescheduling 70
scheduling 67
spotting conflicts 77
timed 67



 317
 

untimed 69, 70
expansion card

beaming applications 218, 219
expansion features

Memory Stick
copying an application 218
deleting an application 219
inserting 217
removing 218

Expense
menus 115
opening 51
overview 50

Expense application 105
adding attendees 109
changing display 110
using with Microsoft Excel 113

expense report
analyzing 309
customizing 307

mapping table 307
layout 307, 309
mapping table

programming 310
expense reports

creating 113
templates 114

expenses
autofilling type 109
changing currency display 110
creating items 105
customizing currency 111
date 106
printing reports 113
receipt details 106
saving entry 106
sorting 110
transferring to Microsoft Excel 112
type 105

F
FAQs 297

application problems 299
beaming problems 303
HotSync problems 300
operating problems 298
password problems 304
recharging problems 304
software installation problems 297
tapping and writing problems 299

File Link 267

Filed folder 240
filters

defining email strings 246
email 244

fonts, choosing 65
full-screen pen stroke 271

G
Graffiti

alphabet 24
navigating 29
non-English characters 29
ShortCuts 29
tips 31
using 23
writing 23

guide v

H
handheld

customizing 269
help v
HotSync

button preferences 270
conduits 263
controlling email 243
customizing applications 257
File Link 267
IR HotSync operations 258

simulated port 259
setting up 255
setting up Mail options 230
synchronizing email 231
user profile 253

HotSync operations
initializing 253
via modem 261
via network 264

I
importing data 33
insistent alarms 223
Intellisync Lite 14, 300
interface elements 7
IP addresses, setting 285

K
keyboard

computer 32
onscreen 31



318   

L
locking device 43
login script 287

M
Mail

menus 247
overview 51

Mail application
opening 52, 231
turning off 231

Mail list 232
Memo List 100
Memo Pad

menus 101
opening 49
overview 49, 121

memos
creating 99
reviewing 100
sorting 100

menus
choosing commands 18
using 7

Microsoft Excel
editing expense data 114
transferring expenses to 113

mobile phone, see Phone
modem

HotSync conduits 263
preparing for HotSync 262

Month view 77, 81

N
network

preferences 279
service templates 283

Network Log 290
non-ASCII characters in login scripts 289
notes, using 64

O
opening applications 17

P
Palm Desktop

opening 195
password

recovering 43
PC-end utilities 195

eBook Converter

overview 196
Palm Desktop software

overview 195
Voice Converter

overview 196
personalizing device 292
phone

communicating with 293
connection to device 272
preferences 294

phone numbers
displaying different type 85
using phone lookup 60

preferences
buttons 38
Digitizer 17, 276
email 239
general 278
HotSync buttons 270
network 279
setting date 275
ShortCuts 295
To Do List 95

priority
email items 236

purging records 56

R
receipt details 106
Recorder

adjust playback volume 156
deleting a file 154
main screen 149
menus 157
opening 120
overview 120
Recording function

via Hot button 150
via Recorder icon 149

renaming a file 153
using 149
viewing Details page 153

records
attaching notes 64
categorizing 56
creating 53
deleting 55
editing 53
finding 59
private 63
purging 56



 319
 

sorting 62
Reminder dialog screen 223
remote connections

login script 287
making 283
troubleshooting 290

removing
desktop software 40

Restore
Log button 189

S
screen, calibrating 17, 276
securing records 63
security

making records private 63
setting options viii
using a password when logging onto your ISP or 

dial-up service 280
Service Connection Progress messages 290
Service Launcher 124

opening 125
Quick Launcher function 192
using 191

ShortCuts
creating 295
editing 30
Graffiti 29

sorting
email 243
expenses 110
To Do List items 94

sounds
alarm sound effects 224
volume 278

start time 79
stylus

replacing 16
tapping versus clicking 16

supplementary applications 117
system requirements 1

T
tapping, using stylus 16
TCP/IP software

connecting via 283
technical support 305
telephone numbers, selecting 85
time

setting 275
time bars 77, 81
tips

displaying 20
To Do List

changing display 95
changing due dates 94
changing priorities 94
checking off items 92
creating items 91
menus 96
overview 48
private entries 94
recording completion date 96
setting priorities 91
sorting items 94

truncating email 245

V
Voice Converter

opening 196

W
Week view 75



320   


	About this Manual
	First things first
	Your guides
	Package contents
	Maintaining your Acer s10
	Proper care and usage of your Acer s10
	Resetting your Acer s10
	Battery considerations

	Assigning security options

	Contents
	1 Getting started
	System requirements
	Acer s10 tour
	Front panel
	Rear panel
	Elements of the Acer s10 interface
	Command interface

	Preparing to use your Acer s10
	Connecting the cradle
	Charging your Acer s10

	Palm Desktop software
	Installing Palm Desktop software
	Using your Acer s10 with another personal information manager
	Setting up your Acer s10

	Synchronizing data
	Performing the first HotSync operation

	Tapping versus clicking
	Calibrating your Acer s10 screen

	Opening applications
	Using menus and menu commands
	Using Graffiti to execute commands

	Displaying online tips
	Entering data

	2 Entering data in your Acer s10
	Entering data using Graffiti
	Writing Graffiti characters
	The Graffiti alphabet
	The Graffiti numbers
	The Graffiti punctuation marks
	The Graffiti symbols and extended characters
	The Graffiti accented characters
	The Graffiti non-English characters
	Graffiti navigation strokes
	Using Graffiti ShortCuts
	Graffiti tips

	Using the onscreen keyboard
	Using an external keyboard
	Importing data
	To import data:

	Beaming data

	3 Managing your applications
	Using the Applications Launcher
	To open an application
	Switching between applications
	Categorizing applications
	Changing the Applications Launcher display

	Setting preferences for applications
	Assigning applications to buttons

	Installing and removing applications
	To install add-on applications on your Acer s10
	To remove an add-on application

	Removing the Palm Desktop software
	Security
	Assigning and editing passwords
	Locking your Acer s10
	Recovering from a forgotten password
	Displaying private records


	4 Working with your basic applications
	Overview of basic applications
	Date Book
	Address Book
	To Do List
	Memo Pad
	Calculator
	Expense
	Mail
	Common applications tasks
	Creating records
	Editing records
	Selecting text
	Using the Edit menu

	Deleting records
	Purging records
	Categorizing records
	Finding records
	Finding Address Book records
	Using the Find option
	Using Phone Lookup
	Adding names to an Expense record

	Sorting records
	Making records private
	Attaching notes
	Choosing fonts
	Getting information on an application
	Application-specific tasks
	Using Date Book
	Scheduling events
	Adding Address Book information to an event
	Setting the alarm for an event
	Setting alarm options
	Changing the Date Book view
	Date Book menus

	Using Address Book
	Creating an Address Book entry
	Selecting different types of phone numbers and addresses
	Duplicating an entry
	Editing Address Book entries
	Changing the Address Book display
	Address Book menus

	Using To Do List
	Creating To Do List items
	Setting To Do List priorities
	Checking off a To Do List item
	Changing To Do List items details
	Sorting To Do items
	Displaying completed and due items
	To Do List menus

	Using Memo Pad
	Creating memos
	Reviewing memos
	Changing the order in which memos appear in the Memo list
	Memo Pad menus

	Using Calculator
	Using the Calculator buttons
	Displaying recent calculations
	Calculator menus

	Using Expense
	Creating an Expense item
	Changing the date of an Expense item
	Entering receipt details
	Adding attendees’ names to an Expense item
	Filling in the expense type automatically
	Changing the Expense List display
	Changing the currency and symbols display
	Customizing currency symbols
	Transferring your data to Microsoft Excel
	Using expense report templates
	Expense menus


	5 Working with your supplementary applications
	Overview of supplementary applications
	Clock
	AudioBox
	Recorder
	eBook Reader
	Backup
	Service Launcher
	Using Clock
	Clock modes
	City Clock mode
	Big Clock mode
	Timer mode
	Clock menu

	Using AudioBox
	Using AudioBox functions
	AudioBox playlist
	Alarm reminder
	AudioBox menu

	Using Recorder
	Recorder main screen
	Audio recording function
	Audio playback function
	Alarm reminder
	Recorder menus

	Using eBook Reader
	Working on the Book Manager screen
	Reading your eBook files
	Working in Read Document mode
	Working with bookmarks
	Using the Jump To function
	Working with hyperlinks
	Attaching a note to an eBook
	Working on Note Manager
	eBook Reader menus

	Using Backup
	Backup function
	Restore function
	Deleting a backup file from the Memory Stick
	Viewing backup error log
	Backup menu

	Using Service Launcher
	Using Service Launcher
	Using the Quick Launcher function


	6 Working with your PC-end utilities
	Overview of PC-end utilities
	Palm Desktop software
	Voice Converter
	eBook Converter
	Using Voice Converter
	Installing Voice Converter
	Voice Converter toolbar
	Voice Converter source file list
	Voice Converter menus

	Using eBook Converter
	Installing eBook Converter
	eBook Converter toolbar
	eBook Converter source file list
	eBook Converter menus


	7 Using expansion features
	Inserting and removing a Memory Stick
	Switching between your Acer s10 internal memory and a Memory Stick
	Copying applications to a Memory Stick
	Deleting applications from a Memory Stick
	Displaying information for Memory Stick applications
	Card Info
	Reviewing card information
	Renaming a card
	Formatting a card
	Card Info menu


	8 Using the Attention Manager
	Insistent alarms
	Using the Reminder command buttons
	Setting the alarm volume
	Setting alarm sound effects
	Using the Reminders list screen

	Subtle alarms
	Understanding the blinking alarm indicator


	9 Managing your desktop email
	Setting up the Mail application on your computer
	Setting up the Mail application and HotSync options
	Synchronizing Mail with your email application

	Viewing, creating, and replying to email
	Viewing email items
	Creating email items
	Looking up an address
	Adding details to email items
	Creating a signature for your email item

	Storing and editing email items
	Storing and editing unsent email items
	Setting mail preferences
	Drafting email
	Filing an email item

	Deleting email items
	Categorizing and sorting email items
	Managing your email application with HotSync
	Using filters to control downloading
	Defining filter strings
	Mail menus


	10 Beaming information
	Beaming a business card
	Beaming a record
	Beaming an application
	Receiving beamed information
	Turning off beaming

	11 Exchanging and updating data using HotSync operations
	Performing a HotSync operation
	Creating a user profile
	Performing the first HotSync operation

	Selecting HotSync setup options
	Customizing HotSync application settings
	IR HotSync operations
	Preparing your computer for infrared communication
	Configuring HotSync Manager for infrared communication
	Performing an IR HotSync operation
	Returning to using the cradle for HotSync operations

	Performing a HotSync operation via modem
	Preparing your computer
	Preparing your Acer s10
	Selecting conduits for a modem HotSync operation
	Performing a HotSync operation via a modem

	Performing a HotSync operation via a network
	Performing a HotSync operation via a network

	Using File Link

	12 Setting preferences for your Acer s10
	Selecting the Preferences screen
	Buttons preferences
	Connection preferences
	Connection Types
	Setting modem configurations
	Setting an Infrared to modem connection

	Date & Time preferences
	Digitizer preferences
	Formats preferences
	Setting default country
	Setting time, date, week start, and number display formats

	General preferences
	Setting the Auto-off interval time
	Setting your Acer s10 to stay on while in the cradle
	Setting the sounds and volumes
	Setting the LED settings
	Turning Beam Receive on and off

	Network preferences
	Connecting to your ISP or dial-in service
	Customizing service templates
	Entering DNS numbers and IP addresses
	Creating a login script
	Using non-ASCII characters in login scripts
	Plug-in applications
	Troubleshooting TCP/IP connections
	Network Preferences menus

	Owner preferences
	Phone preferences
	Communicating with your mobile phone
	Setting up related Network preferences
	Setting up related Connection Preferences
	Setting up Phone preferences

	ShortCuts preferences

	13 Frequently Asked Questions
	Software installation problems
	Operating problems
	Tapping and writing problems
	Application problems
	HotSync problems
	Beaming problems
	Recharging problems
	Password problems
	Technical support
	Finding version and memory information


	Appendix — Creating a custom Expense Report
	About mapping tables
	Customizing existing sample templates
	To customize a sample Expense Report template

	Determining the layout of the Expense Report
	Labels
	Sections

	Analyzing your custom Expense Report
	Programming the mapping table
	Using applications other than Microsoft Excel
	Expense file details

	Index

